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Audience

Preface

This manual describes how to use Oracle SOA Suite.
This preface contains the following topics:

= Audience

= Documentation Accessibility

= Related Documents

s Conventions

This manual is intended for anyone who is interested in developing applications with
Oracle SOA Suite.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.



Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact.html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Related Documents

For more information, see the following Oracle resources:

»  Oracle Fusion Middleware Administrator’s Guide for Oracle SOA Suite and Oracle BPM
Suite

Printed documentation is available for sale in the Oracle Store at
http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other
collateral, visit the Oracle Technology Network (OTN). You must register online before
using OTN; registration is free and can be done at

http://www.oracle.com/technology/membership/

To download Oracle BPEL Process Manager documentation, technical notes, or other
collateral, visit the Oracle BPEL Process Manager site at Oracle Technology Network
(OTN):

http://www.oracle.com/technology/bpel/

If you have a username and password for OTN, then you can go directly to the
documentation section of the OTN web site at

http://www.oracle.com/technology/documentation/

See the Business Process Execution Language for Web Services Specification, available at the
following URL:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us
/dnbizspec/html/bpell-1.asp

See the XML Path Language (XPath) Specification, available at the following URL:
http://www.w3.0rg/TR/1999/REC-xpath-19991116

See the Web Services Description Language (WSDL) 1.1 Specification, available at the
following URL:

http://www.w3.org/TR/wsdl

Oracle Fusion Middleware Infrastructure Management Java API Reference for Oracle SOA
Suite:

http://www.oracle.com/technology/products/soa/soasuite/collatera
1/apidocs/soasuite_11.1.1.0.0/overview-summary.html

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.



Convention Meaning

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Introduction to Oracle SOA Suite

This part provides an introduction to Oracle SOA Suite and developing SOA
composite applications.

This part contains the following chapters:

»  Chapter 1, "Introduction to Building Applications with Oracle SOA Suite"

= Chapter 2, "Developing SOA Composite Applications with Oracle SOA Suite"
»  Chapter 3, "Introduction to the SOA Sample Application”
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Introduction to Building Applications with
Oracle SOA Suite

This chapter describes the architecture and key functionality of Oracle SOA Suite.
This chapter includes the following sections:

s Section 1.1, "Introduction to Service-Oriented Architecture"

s Section 1.2, "Introduction to Services"

m  Section 1.3, "Introduction to Oracle SOA Suite"

= Section 1.4, "Standards Used by Oracle SOA Suite to Enable SOA"

= Section 1.5, "Service Component Architecture within SOA Composite
Applications"

= Section 1.6, "Runtime Behavior of a SOA Composite Application"
= Section 1.7, "Approaches for Designing SOA Composite Applications"”
= Section 1.8, "Learning Oracle SOA Suite"

1.1 Introduction to Service-Oriented Architecture

Changing markets, increasing competitive pressures, and evolving customer needs are
placing greater pressure on IT to deliver greater flexibility and speed. Today, every
organization is faced with predicting change in a global business environment, to
rapidly respond to competitors, and to best exploit organizational assets for growth. In
response to these challenges, leading companies are adopting service-oriented
architecture (SOA) to deliver on these requirements by overcoming the complexity of
their application and IT environments.

SOA provides an enterprise architecture that supports building connected enterprise
applications to provide solutions to business problems. SOA facilitates the
development of enterprise applications as modular business web services that can be
easily integrated and reused, creating a truly flexible, adaptable IT infrastructure.

1.2 Introduction to Services

SOA separates business functions into distinct units, or services. A SOA application
reuses services to automate a business process.

A standard interface and message structure define services. The most widely used
mechanism are web services standards. These standards include the Web Service
Description Language (WSDL) file for service interface definition and XML Schema
Documents (XSD) for message structure definition. These XML standards are easily
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exchanged using standard protocols. Because standards for web services use a
standard document structure, they enable existing systems to interoperate regardless
of the choice of operating system and computer language used for service
implementation.

When designing a SOA approach, you create a service portfolio plan to identify
common functionality to use as a service within the business process. By creating and
maintaining a plan, you ensure that existing services and applications are reused or
repurposed whenever possible. This plan also reduces the time spent in creating
needed functionality for the application.

1.3 Introduction to Oracle SOA Suite

Oracle SOA Suite provides a complete set of service infrastructure components for
designing, deploying, and managing composite applications. Oracle SOA Suite
enables services to be created, managed, and orchestrated into composite applications
and business processes. Composites enable you to easily assemble multiple technology
components into one SOA composite application. Oracle SOA Suite plugs into
heterogeneous IT infrastructures and enables enterprises to incrementally adopt SOA.

The components of Oracle SOA Suite benefit from common capabilities, including a
single deployment, management, and tooling model, end-to-end security, and unified
metadata management. Oracle SOA Suite is unique in that it provides the following
set of integrated capabilities:

s Messaging

= Service discovery

s Orchestration

= Web services management and security
= Business rules

»  Events framework

= Business activity monitoring

1.4 Standards Used by Oracle SOA Suite to Enable SOA

Oracle SOA Suite puts a strong emphasis on standards and interoperability. Among
the standards it leverages are:

= Service Component Architecture (SCA) assembly model

Provides the service details and their interdependencies to form composite
applications. SCA enables you to represent business logic as reusable service
components that can be easily integrated into any SCA-compliant application. The
resulting application is known as a SOA composite application. The specification
for the SCA standard is maintained by the Organization for the Advancement of
Structured Information Standards (OASIS) through the Open Composite Services
Architecture (CSA) Member Section:

http://www.oasis-opencsa.org
= Service Data Objects (SDO)

Specifies a standard data method and can modify business data regardless of how
it is physically accessed. Knowledge is not required about how to access a
particular back-end data source to use SDO in a SOA composite application.
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Consequently, you can use static or dynamic programming styles and obtain
connected and disconnected access.

Business Process Execution Language (BPEL)

Provides enterprises with an industry standard for business-process orchestration
and execution. Using BPEL, you design a business process that integrates a series
of discrete services into an end-to-end process flow. This integration reduces
process cost and complexity.

XSL Transformations (XSLT)

Processes XML documents and transforms document data from one XML schema
to another.

Java Connector Architecture (JCA)

Provides a Java technology solution to the problem of connectivity between the
many application servers in Enterprise Information Systems (EIS).

Java Messaging Service (JMS)

Provides a messaging standard that allows application components based on the
Java 2 Platform, Enterprise Edition (Java EE) to access business logic distributed
among heterogeneous systems.

Web Services Description Language (WSDL) file

Provides the entry points into a SOA composite application. The WSDL file
provides a standard contract language and is central for understanding the
capabilities of a service.

Simple Object Access Protocol (SOAP)

Provides the default network protocol for message delivery.

1.5 Service Component Architecture within SOA Composite Applications

Oracle SOA Suite uses the SCA standard as a way to assemble service components
into a SOA composite application. SCA provides a programming model for the
following:

Creating service components written with a wide range of technologies, including
programming languages such as Java, BPEL, C++, and declarative languages such
as XSLT. The use of specific programming languages and technologies (including
web services) is not required with SCA.

Assembling the service components into a SOA composite application. In the SCA
environment, service components are the building blocks of applications.

SCA provides a model for assembling distributed groups of service components into
an application, enabling you to describe the details of a service and how services and
service components interact. Composites are used to group service components and
wires are used to connect service components. SCA helps to remove middleware
concerns from the programming code by applying infrastructure declaratively to
composites, including security and transactions.

The key benefits of SCA include the following;:

Loose coupling

Service components integrate with other service components without needing to
know how other service components are implemented.
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s Flexibility
Service components can easily be replaced by other service components.
= Services invocation
Services can be invoked either synchronously or asynchronously.
= Productivity
Service components are easily integrated to form a SOA composite application.
= Easy Maintenance and Debugging

Service components can be easily maintained and debugged when an issue is
encountered.

A SOA composite is an assembly of services, service components, and references
designed and deployed in a single application. Wiring between the services, service
components, and references enable message communication. The details for a
composite are stored in the composite.xml file.

Figure 1-1 provides an example of a composite that includes an inbound service
binding component, a BPEL process service component (named Account), a business
rules service component (named AccountRule), and two outbound reference binding
components.

Figure 1-1 Simple SOA Composite Architecture

Composite
Service
Component
Wire
. Composite BigBank
Wire
- Reference
Service Component
Account
Service binding.ws
WebApp > ) 3>
binding.ws binding.rmi
BPEL
Service Component
AccountRule Service
Component
— Business
Rules

1.5.1 Service Components

Service components are the building blocks that you use to construct a SOA composite
application.

The following service components are available. There is a corresponding service
engine of the same name for each service component. All service engines can interact
in a single composite.

= BPEL processes provide process orchestration and storage of synchronous or
asynchronous process. You design a business process that integrates a series of
business activities and services into an end-to-end process flow.
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Business rules enable you to design a business decision based on rules.

Human tasks provide workflow modeling that describes the tasks for users or
groups to perform as part of an end-to-end business process flow.

Mediators route events (messages) between different components

Spring enables you to integrate Java interfaces into SOA composite applications

1.5.2 Binding Components

Binding components establish a connection between a SOA composite and the external
world. There are two types of binding components:

Services provide the outside world with an entry point to the SOA composite
application. The WSDL file of the service advertises its capabilities to external
applications. These capabilities are used for contacting the SOA composite
application components. The binding connectivity of the service describes the
protocols that can communicate with the service, for example, SOAP/HTTP or a
JCA adapter.

References enable messages to be sent from the SOA composite application to
external services in the outside world.

Table 1-1 lists and describes the binding components provided by Oracle SOA Suite.

Table 1-1 Binding Components Provided by Oracle SOA Suite

Binding Components Description

Web Service (SOAP over Use for connecting to standards-based services using SOAP
HTTP) over HTTP.

JCA Adapters Use for integrating services and references with technologies

(for example, databases, file systems, FTP servers, messaging:
JMS, IBM WebSphere MQ, and so on) and applications (Oracle
E-Business Suite, PeopleSoft, and so on). This includes AQ
Adapter, Database Adapter, File Adapter, FTP Adapter, JMS
Adapter, MQ Adapter, and Socket Adapter.

B2B binding component Use for browsing B2B metadata in the MDS repository and
selecting document definitions.

ADE-BC Service Use for connecting Oracle Application Development
Framework (ADF) applications using SDO with the SOA
platform.

Oracle Applications Use for integrating Oracle Application Adapter with Oracle
Applications.

BAM Adapter Use for integrating Java EE applications with Oracle BAM

Server to send data and also used as a reference binding
component in a SOA composite application.

EJB Service Use for integrating SDO parameters or Java interfaces with

Enterprise JavaBeans.

Direct Binding Service Use to invoke a SOA composite application and exchange

messages over a remote method invocation (RMI) in the
inbound direction and to invoke an Oracle Service Bus (OSB)
flow or another SOA composite application in the outbound
direction.

HTTP Binding Use to integrate SOA composite applications with HTTP

binding.
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1.5.3 Wires

Wires enable you to graphically connect the following components in a single SOA
composite application for message communication:

m  Services to service components
= Service components to other service components

= Service components to references

1.6 Runtime Behavior of a SOA Composite Application

Figure 1-2 shows the operability of a SOA composite application using SCA
technology. In this example, an external application (NET payment calculator)
initiates contact with the SOA composite application.

For more information about descriptions of the tasks that services, references, service
components, and wires perform in an application, see Section 1.5, "Service Component
Architecture within SOA Composite Applications."

Figure 1-2 Runtime Behavior of SOA Composite Application

Service Archive: Composite (deployment unit)

Loan APR Manager EBS
Process Rule Review Customer
Task View
m N
BPEL . . .
Process Business Oracle Human — Service Engines
Manager Rules Mediator Task (Containers that host the
- component business logic)

from binding component
and determines the
intended component
target)

HTTP JCA
ADF BC Binding Components
SOAP Adapters (Connect SOA applications
to the outside world)

W —@—EED:D— — Service Infrastructure
(Picks up SOAP message

NET T Sends a SOAP message
Pa.yment to the SOA application
Calculator

The .NET payment calculator is an external application that sends a SOAP message to
the SOA application to initiate contact. The Service Infrastructure picks up the SOAP
message from the binding component and determines the intended component target.
The BPEL service engine receives the message from the Service Infrastructure for
processing by the BPEL Loan Process application and posts the message back to the
Service Infrastructure after completing the processing.

Table 1-2 describes the operability of the SOA composite application shown in
Figure 1-1.
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Table 1-2 Introduction to a SOA Composite Application Using SCA Technologies
Part Description Example of Use in Figure 1-1 See Section
Binding Establishes the connectivity =~ The SOAP binding component service: Section 1.5.1,
Components between a SOA composite Advertises its capabilities in the WSDL Service .
and the external world. There file Components
are two types: :
e . = Receives the SOAP message from the
= Service binding .
. .NET application.
components provide an
entry point to the SOA = Sends the message through the policy
composite application. infrastructure for security checking.
= Reference binding = Translates the message to a normalized
components enable message (an internal representation of the
messages to be sent from service’s WSDL contract in XML format).
the SOA composite Posts the message to the Service
application to external
. Infrastructure.
services.
An example of a binding component reference
in Figure 1-2 is the Loan Process application.
Service Provides internal message The Service Infrastructure: Section 1.6.1,
Infrastructure — transport = Receives the message from the SOAP Service "
Infrastructure

binding component service.

= Posts the message for processing to the
BPEL process service engine first and the
human task service engine second.

Service Engines

Host the business logic or

The BPEL service engine:

Section 1.6.2,

(containers processing rules of the . . "Service Engines"
. . . = Receives the message from the Service
hosting service  service components. Each .
. . Infrastructure for processing by the BPEL
components) service component has its s e
. . Loan Process application.
own service engine.
= Posts the message to the Service
Infrastructure after completing the
processing.
UDDI and MDS The MDS (Metadata Service) The SOAP service used in this composite Oracle Fusion
repository stores descriptions application is stored in the MDS and can also ~ Middleware
of available services. The be published to UDDI. Getting Started
UDDI advertises these with Oracle SOA
services, and enables Suite
discovery and dynamic
binding at runtime.
SOA Archive: The deployment unit that The SOA archive (SAR) of the composite Section 1.6.3,
Composite describes the composite application is deployed to the Service "Deployed
application. Infrastructure. Service
(deployment c
: Archives
unit)

1.6.1 Service Infrastructure

The Service Infrastructure provides the following internal message routing
infrastructure capabilities for connecting components and enabling data flow:

= Receives messages from the service providers or external partners through SOAP

services or adapters

= Sends the message to the appropriate service engine

= Receives the message back from the service engine and sends it to any additional
service engines in the composite or to a reference binding component based on the

wiring

Introduction to Building Applications with Oracle SOA Suite 1-7



Approaches for Designing SOA Composite Applications

1.6.2 Service Engines

Service engines are containers that host the business logic or processing rules of these
service components. Service engines process the message information received from
the Service Infrastructure.

There is a corresponding service engine of the same name for each service component.
All service engines can interact in a single composite.

For more information, see Oracle Fusion Middleware Administrator’s Guide for Oracle
SOA Suite and Oracle BPM Suite.

1.6.3 Deployed Service Archives

The SAR is a SOA archive deployment unit. A SAR file is a special JAR file that
requires a prefix of sca_. (for example, sca_OrderBookingComposite_
revl.0.jar). The SAR file is deployed to the Service Infrastructure. The SAR
packages service components, such as BPEL processes, business rules, human tasks,
and mediator routing services into a single application. The SAR file is analogous to
the BPEL suitcase archive of previous releases, but at the higher composite level and
with any additional service components that your application includes (for example,
human tasks, business rules, and mediator routing services).

For more information, see Chapter 41, "Deploying SOA Composite Applications."

1.7 Approaches for Designing SOA Composite Applications

When creating a SOA composite application, you have a choice of approaches for
building it:

= Top-Down: You analyze your business processes and identify activities in support
of your process. When creating a composite, you define all the SOA components
through the SOA Composite Editor. You create all the services first, and then build
the BPEL process, referencing the created services.

= Bottom-Up: You analyze existing applications and assets to identify those that can
be used as services. As you create a BPEL process, you build the services on
as-needed basis. This approach works well when IT must react to a change.

1.8 Learning Oracle SOA Suite

In addition to this developer’s guide, Oracle also offers the following resources to help
you learn how you can best use Oracle SOA Suite in your applications:

»  Getting Started: Oracle Fusion Middleware Getting Started with Oracle SOA Suite
introduces you to Oracle SOA Suite, its components, and provides you with a
high-level understanding of what you can accomplish with the suite. Also, you
could refer to the Oracle SOA Suite section of the Oracle Fusion Middleware 11g
Release 1 documentation library for additional documentation.

s Cue Cards in Oracle JDeveloper: Oracle JDeveloper cue cards provide step-by-step
support for the application development process using Oracle SOA Suite. They are
designed to be used either with the included examples and a sample schema, or
with your own data. Cue cards also include topics that provide more detailed
background information, viewlets that demonstrate how to complete the steps in
the card. Cue cards provide a fast, easy way to become familiar with the basic
features of Oracle SOA Suite, and to work through a simple end-to-end task. In
Oracle JDeveloper, click Help, Cue Cards to access the cue cards.
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m http://www.oracle.com/technology/sample_code/products/soa: The
SOA OTN provides access to various use case samples for Oracle SOA Suite and
its components.
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2

Developing SOA Composite Applications
with Oracle SOA Suite

This chapter describes how to use Oracle JDeveloper to create a SOA composite
application. This overview is intended to guide you through the basic steps of
composite creation, along with describing key issues to be aware of when designing a
composite application.

This chapter includes the following sections:

= Section 2.1, "Creating a SOA Application"

= Section 2.2, "Adding Service Components"

= Section 2.3, "Adding Service Binding Components"

= Section 2.4, "Adding Reference Binding Components"

= Section 2.5, "Adding Wires"

= Section 2.6, "Adding Security"

= Section 2.7, "Deploying a SOA Composite Application”

= Section 2.8, "Managing and Testing a SOA Composite Application"

2.1 Creating a SOA Application

The first steps in building a new application are to assign it a name and to specify the
directory where to save source files. By creating an application using application
templates provided by JDeveloper, you automatically get the organization of the
workspace into projects, along with many of the configuration files required by the
type of application you are creating.

2.1.1 How to Create a SOA Application and Project

You first create an application for the SOA project.

Note: In order to create and deploy SOA composite applications and
projects, you must install the Oracle SOA Suite extension. For
instructions on installing this extension for Oracle JDeveloper, see the
Oracle Fusion Middleware Installation Guide for Oracle [ Developer.

To create an application:
1. Start Oracle JDeveloper Studio Edition Version 11.1.1.3.0.

Developing SOA Composite Applications with Oracle SOA Suite 2-1



Creating a SOA Application

2. If Oracle JDeveloper is running for the first time, specify the location for the Java
JDK.

3. Create a new SOA composite application, as described in Table 2-1.

Table 2-1 SOA Composite Application Creation

If Oracle JDeveloper... Then...
Has no applications In the Application Navigator in the upper left, click New
Application.

For example, you are
opening Oracle JDeveloper
for the first time.

Has existing applications From the File main menu or the Application menu:
1. Select New > Applications.

The New Gallery opens, where you can select different
application components to create.

2. In the Categories tree, under the General node, select
Applications. In the Items pane, select SOA Application
and click OK.

The Create SOA Application wizard starts.

4. Inthe Name your application page, you can optionally change the name and
location for your web project. If this is your first application, from Application
Template, select SOA Application. Accept the defaults for the package prefix, and
click Next.

Notes:
= Do not create an application name with spaces.

= Do not create applications and projects in directory paths that
have spaces (for example, ¢ : \Program Files).

= Ona UNIX operating system, it is highly recommended to enable
Unicode support by setting the LANG and LC_A11 environment
variables to a locale with the UTE-8 character set. This action
enables the operating system to process any character in Unicode.
SOA technologies are based on Unicode. If the operating system is
configured to use non-UTF-8 encoding, SOA components may
function in an unexpected way. For example, a non-ASCII file
name can make the file inaccessible and cause an error. Oracle
does not support problems caused by operating system
constraints.

In a design-time environment, if you are using Oracle JDeveloper,
select Tools > Preferences > Environment > Encoding > UTF-8 to
enable Unicode support. This setting is also applicable for runtime
environments.

5. In the Name your project page, you can optionally change the name and location
for your SOA project. By default, Oracle JDeveloper adds the SOA project
technology, the composite.xml that generates, and the necessary libraries to
your model project. Click Next.
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Note: Composite and component names cannot exceed 500
characters.

A project deployed to the same infrastructure must have a unique name across
SOA composite applications. The uniqueness of a composite is determined by its
project name. For example, do not perform the actions described in Table 2-2.
During deployment, the second deployed project (composite) overwrites the first
deployed project (composite).

Table 2-2 Restrictions on Naming a SOA Project

Create an Application Named... With a SOA Project Named...
Applicationl Projectl
Application2 Projectl

The Project SOA Settings page of the Create SOA Application wizard appears.
6. In the Configure SOA Settings page, click Empty Composite, and click Finish.

7. Select Save All from the File main menu.

2.1.2 What Happens When You Create a SOA Application and Project

When you create a SOA application, Oracle JDeveloper creates a project that contains
all the source files related to your application. Oracle JDeveloper automatically adds
the following libraries needed for your SOA project:

s SOA Design time
s SOA Runtime

s BPEL Runtime

=  Mediator Runtime
= MDS Runtime

Once the project is created for you, you can rename it. You can then use JDeveloper to
create additional projects needed for your application.

Figure 2-1 shows the SOA Composite Editor for the OrderBookingComposite,
project contained within the WebLogicFusionOrderDemo application of the Fusion
Order Demo.
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Figure 2-1 New Workspace for a SOA Composite Application
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Table 2-3 describes the SOA Composite Editor.
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Table 2-3 SOA Composite Editor

Element Description
Application Navigator Displays the key files for the specific service components included
in the SOA project:

= A composite.xml file that is automatically created when
you create a SOA project. This file describes the entire
composite assembly of services, service components,
references, and wires.

»  The business rules service component file (rules_
name.decs). Additional business rules files display under the
Oracle > rules subfolder (rules_name.rules).

= The mediator service component file (mediator_
namemplan).

»  The BPEL process service component files (process_
name.bpel and process_name.wsdl).

s The human task service component files (task_name.task).
= The spring service component file (spring.xml).

s The componentType file that describes the services and
references for each service component. This file ensures that
the wiring you create between components works.

» Additional subfolders for class files, XSDs (schemas), and
XSLs (transformations).

You can drag and drop components and service adapters from the
Component Palette window to the Designer window. When you
drop a service component into the Designer window;, it starts a
property editor for configuring that service component. For
example, when you drop a Mediator component into the Designer
window, this also opens the Mediator editor window that enables
you to configure the Medjiator.

To edit the configuration of an existing component in the Designer
window, double-click the component to re-open the editor.

Designer You drag service components, services, and references into the
composite in the designer. When you drag and drop a service
component into the Designer window, a corresponding property
editor is invoked for performing configuration tasks related to that
service component. For example, when you drag and drop the
Mediator component into Designer, then the Mediator Editor
window is displayed that enables you to configure the Mediator
component.

For all subsequent editing sessions, you double-click these service
components to invoke their editors.

Left Swimlane (Exposed  The left swimlane is for services, such as a web services or JCA

Services) adapters, providing an entry point to the SOA composite
application.

Right Swimlane (External The right swimlane is for references that send messages to external

References) services in the outside world, such as web services and JCA
adapters.
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Table 2-3 (Cont.) SOA Composite Editor

Element Description

Component Palette The component palette provides the various resources that you can
use in a SOA composite. It contains the following service
components and adapters:

= Service components

Displays the BPEL Process, business rule, human task,
mediator service, and spring components that can be dragged
and dropped into the designer.

= Service adapters

Displays the JCA adapter (AQ, file, FTP, database, JMS, MQ,
Oracle Applications, and socket), Oracle BAM binding
component, B2B binding component, EJB binding component,
ADF-BC binding component, direct binding component,
HTTP binding component, and web service binding
component that can be dragged into the left or right
swimlanes.

If the Component Palette does not display, select Component
Palette from the View main menu.

Resource Palette The Resource Palette provides a single dialog from which you can
browse both local and remote resources. For example, you can
access the following resources:

= Shared local application metadata such as schemas, WSDLs,
event definitions, business rules, and so on.

= WSIL browser functionality that uses remote resources that
can be accessed through an HTTP connection, file URL or
Application Server connection.

= Remote resources that are registered in a UDDI (Universal
Description, Discover and Integration) registry.

If the Resource Palette does not display, then select Resource
Palette from the View main menu.

You select these resources for the SOA composite application
through the SOA Resource Browser dialog. This dialog is accessible
through a variety of methods. For example, when you select the
WSDL file to use with a service binding component or a mediator
service component or select the schema file to use in a BPEL
process, the SOA Resource Browser dialog appears. Click Resource
Palette at the top of this dialog to access available resources.

Log Window The Log window displays messages about application compilation,
validation, and deployment.

Property Inspector The Property Inspector displays properties for the selected service
component, service, or reference.

If the Property Inspector does not display, select Property Inspector
from the View main menu.

Application View The Application View shows the artifacts for the SOA composite
application.

The composite.xml file displays as a tab in the designer and a file in the Application
Navigator. This file is automatically created when you create a new SOA project. This
file describes the entire composite assembly of services, service components, and
references. There is one composite.xml file for each SOA project.

When you work with the composite.xml file, you use mostly the designer, the
Structure window, and the Property Inspector, as shown in Figure 2-1. The designer
enables you to view many of your files in a WYSIWYG environment, or you can view
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a file in an overview editor where you can declaratively make changes, or you can
view the source code for the file. The Structure window shows the structure of the
currently selected file. You can select objects in this window, and then edit the
properties for the selection in the Property Inspector. As you add artifacts to the SOA
composite application, you can view them in the Application Overview.

Figure 2-2 shows the Application Overview for the WebLogicFusionOrderDemo
application after it is initially created with an empty composite.

Figure 2-2 Application Overview for a New SOA Composite Application
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2.2 Adding Service Components

Once you create your application, often the next step is to add service components that
implement the business logic or processing rules of your application. You can use the
Component Palette from the SOA Composite Editor to drag and drop service
components to the composite.

2.2.1 How to Add a Service Component

To add a service component:
1. From the Component Palette, select SOA.

2. From the Service Components list, drag a component into the designer.

Figure 2—4 shows a BPEL process being added to the designer.

Figure 2-3 Adding BPEL Process to Composite
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A specific dialog for the selected service components displays. Table 2—4 describes
the available editors.
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Table 2-4 Starting Service Component Editors

Dragging This Service
Component... Invokes The...

BPEL Process Create BPEL Process dialog to create a BPEL process that
integrates a series of business activities and services into an

end-to-end process flow.

Business Rule Create Business Rules dialog to create a business decision based
on rules.
Human Task Create Human Task dialog to create a workflow that describes the

tasks for users or groups to perform as part of an end-to-end

business process flow.

Mediator Create Mediator dialog to define services that perform message
and event routing, filtering, and transformations.

Spring Context Create Spring dialog to create a spring context file for integrating
Java interfaces into SOA composite applications.

3. Configure the settings for a service component. For help with a service component

dialog, click Help or press F1. Click Finish.

Figure 2—4 shows the BPEL Process dialog with data entered to create the
OrderProcessor BPEL process for the WebLogicFusionOrderDemo
application of the Fusion Order Demo. The process is selected to be asynchronous.
The Expose as a SOAP Service option directs Oracle JDeveloper to create this
service component automatically connected to an inbound web service.

Figure 2-4 Create BPEL Process Dialog

® Create BPEL Process

BPEL Process

A BPEL process is a service orchestration, used ko describejexecute a business process (or large grained
service), which is implemented as a stateful service,

3

@
Y
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- @
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Expose as a SOAR service
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| &

Qutput; |{http:,l',l'www.globalcompany.example.com,l'ns,l'OrderBookingSer\rice}-processResponse | Q

| Help | | oK | Cancel

4. C(lick OK.

The service component displays in the designer. Figure 2-5 shows the
OrderProcessor BPEL process added to the composite.xml file. A SOAP
service binding component called orderprocessor_client_ep in the left
swimlane provides the outside world with an entry point into the SOA composite
application. If the Expose as a SOAP Service option was not selected in the Create
BPEL Process dialog, the orderprocessor_client_ep service would not
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display. Section 2.3.1, "How to Add a Service Binding Component,” describes how
you later add a service.

Figure 2-5 BPEL Process in Composite
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You can more fully define the content of the service component now or at a later
time. For this top-down example, the content is defined now.

5. Select Save All from the File main menu.

2.2.2 What You May Need to Know About Adding and Deleting a Service Component

Note the following details about adding service components:

»  Create a service component from either the SOA Composite Editor or the designer
of another component. For example, you can create a human task component from
the SOA Composite Editor or the Oracle BPEL Designer.

= Use the Resource Palette to browse for service components defined in the SOA
Composite Editor, and those deployed.

Note the following details about deleting service components:

= You can delete a service component by right-clicking it and selecting Delete from
the context menu.

= When a service component is deleted, all references pointing to it are invalidated
and all wires are removed. The service component is also removed from the
Application Navigator.

= A service component created from within another service component can be
deleted. For example, a human task created within the BPEL process service
component of Oracle JDeveloper can be deleted from the SOA Composite Editor.
In addition, the partner link to the task can be deleted. Deleting the partner link
removes the reference interface from its . componentType file and removes the
wire to the task.
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2.2.3 How to Edit a Service Component

You modify a service component to define specific details about the service
component.

To edit a service component:

1. Double-click the service component in the designer to display the appropriate
editor or designer, as described in Table 2-5.

Table 2-5 Starting SOA Service Component Wizards and Dialogs

Double-Clicking This

Service Component... Displays The...

BPEL Process Oracle BPEL Designer for further designing.
Business Rule Business Rules Designer for further designing.
Human Task Human Task Editor for further designing.
Mediator Oracle Medjiator Editor for further designing.
Spring Context Spring Editor for further designing.

To return to the SOA Composite Editor from within any service component, click
Go to Composite Editor on the tool bar. You can also double-click composite.xml
in the Application Navigator or single-click composite.xml above the designer.

For help with a service component editor, click Help or press F1. Click Finish.

2. Modify the settings for a service component. For help with a service component
editor or designer, click Help or press F1. Click Finish.

3. In the Application Navigator, double-click composite.xml or single-click
composite.xml above the designer.

This action returns you to the SOA Composite Editor.

4. Select Save All from the File main menu.

2.3 Adding Service Binding Components

You add a service binding component to act as the entry point to the SOA composite
application from the outside world.

2.3.1 How to Add a Service Binding Component

Notes:

»  This section describes how to manually create a service binding
component. You can also automatically create a service binding
component by selecting Expose as a SOAP Service when you
create a service component. This selection creates an inbound web
service binding component that is automatically connected to
your BPEL process, human task service, or Oracle Mediator
component.

= You cannot invoke a representational state transfer (REST) service
from the SOA Composite Editor.
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You can use the Component Palette from the SOA Composite Editor to drag and drop
service binding components to the composite.

To add a service binding component:
1. From the Component Palette, select SOA.

2. From the Service Adapters list, drag a service to the left swimlane to define the

service interface.

Figure 2—-6 shows a web service being added to the designer.

Figure 2-6 Adding Web Service to Composite
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A specific dialog for the selected service displays. Table 2—6 describes the available

editors.

Table 2-6 Service Editors

Dragging This Service...

Invokes The...

Web service

Create Web Service dialog to create a web invocation service.

Adapters

Adapter Configuration Wizard to guide you through integration of
the service with database tables, database queues, file systems, FTP
servers, Java Message Services (JMS), IBM WebSphere MQ, BAM
servers, sockets, or Oracle E-Business Suite applications.

ADE-BC Service

Create ADF-BC Service dialog to create a service data object (SDO)
invocation service.

B2B B2B Wizard to guide you through selection of a document
definition.

EJB Service Create EJB Service to create an Enterprise JavaBeans service for
using SDO parameters or Java interfaces with Enterprise JavaBeans.

HTTP Binding Create HTTP Binding Wizard to create HTTP binding. This wizard

enables you to invoke SOA composite applications through HTTP
POST and GET operations.
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Table 2-6 (Cont.) Service Editors

Dragging This Service... Invokes The...

Direct Binding Create Direct Binding Service Dialog to invoke a SOA composite
application and exchange messages over a remote method
invocation (RMI) in the inbound direction.

3. Configure the settings for the service. For help with a service editor, click Help or
press F1. Click Finish.

Figure 2-7 shows the Web Service dialog with data entered to create the
orderprocessor_client_ep service for the OrderProcessor BPEL process.

Figure 2-7 Create Web Service Dialog
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4. Click OK.

The service binding component displays in the left swimlane. Figure 2-8 shows
the orderprocessor_client_ep service binding component added to the
composite.xml file.

Figure 2-8 Web Service in Composite
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5. Select Save All from the File main menu.
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2.3.2 How to Add a WSDL for a Web Service

To add a WSDL for a web service:
1. In the Component Palette, select SOA.

2. From the Service Adapters list, drag a Web Service to the left swimlane.
This invokes the Create Web Service dialog shown in Figure 2-7.

3. Enter the details shown in Table 2-7:

Table 2-7 Create Web Service Dialog Fields and Values

Field Value
Name Enter a name for the service.
Type Select the type (message direction) for the web service. Since you

dragged the web service to the left swimlane, the Service type is
the correct selection, and displays by default:

s Service (default)

Creates a web service to provide an entry point to the SOA
composite application

= Reference

Creates a web service to provide access to an external
service in the outside world

Since this example describes how to create an entry point to the
SOA composite application, Service is selected.

4. Select the WSDL file for the service. There are three methods for selection:

a. To the right of the WSDL URL field, click the first icon and select an existing
WSDL file from the local file system (for this example, OrderProcessor.wsdl is
selected). Note that File System in the list at the top of the dialog is
automatically selected. Figure 2-9 provides details.

Figure 2-9 WSDL File Selection
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Figure 2-10 Use of Existing WSDL files from Other Applications

b. To the right of the WSDL URL field, click the first icon and select Resource
Palette from the list at the top of the dialog, as shown in Figure 2-10. This
action enables you to use existing WSDL files from other applications.
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c. To the right of the WSDL URL field, click the second icon to automatically
generate a WSDL file from a schema. Figure 2-11 shows the Create WSDL

dialog.

Figure 2-11 Automatic Generation of WSDL File
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Click OK to return to the Create Web Service dialog.

6. Note the additional details described in Table 2-8:

Table 2-8 Create Web Service Dialog Fields and Values

Field Value

Port Type Displays the port type.
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Table 2-8 (Cont.) Create Web Service Dialog Fields and Values
Field Value

Callback Port Type Disabled, since this WSDL file is for a synchronous service. This
field is enabled for asynchronous services.

7. Click OK.

8. From the File main menu, select Save All.

Notes:

= Do not manually update the WSDL location in the WSDL file in
Source View. This action is not supported. Only updates made in
Design View are supported.

s WSDL namespaces must be unique. Do not just copy and rename
a WSDL. Ensure that you also change the namespaces.

2.3.3 How to View Schemas

You can view all schemas used by the interface's WSDL file and, if you want, choose a
new message schema for a selected message part in the Update Interface dialog.

To access this dialog:
1. Click the small arrow handle that appears on the specific binding component or

service component.

Figure 2-12 Selection of Inbound Interface Handle
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The Update Interface dialog displays all schemas currently used by the WSDL file.

2. If you want to select a new message schema, click Help or press F1 for
instructions.

2.3.4 How to Edit a Service Binding Component

After initially creating a service, you can edit its contents at a later time. Double-click
the component icon to display its appropriate editor or wizard. Table 2-9 provides an
overview.

Table 2-9 Starting Service Wizards and Dialogs

Double-Click This Service... To...

Web service Display the Update Service dialog.
Adapters Reenter the Adapter Configuration Wizard.
ADF-BC Service Display the Update Service dialog.

B2B Reenter the B2B wizard.
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Table 2-9 (Cont.) Starting Service Wizards and Dialogs

Double-Click This Service... To...

EJB Service Display the Update Service dialog.
HTTP Binding Reenter the HTTP Binding Wizard.
Direct Binding Reenter the Update Service dialog.

2.3.5 What You May Need to Know About Adding and Deleting Services

Note the following detail about adding services:

= When a new service is added for a service component, the service component is
notified so that it can make appropriate metadata changes. For example, when a
new service is added to a BPEL service component, the BPEL service component is
notified to create a partner link that can be connected to a receive or an
on-message activity.

Note the following detail about deleting services:

= When a service provided by a service component is deleted, all references to that
service component are invalidated and the wires removed.

2.4 Adding Reference Binding Components

You add reference binding components that enable the SOA composite application to
send messages to external services in the outside world.

2.41 How to Add a Reference Binding Component

You can use the Component Palette from the SOA Composite Editor to drag and drop
reference binding components to the composite.

To add a reference binding component:
1. From the Component Palette, select SOA.

2. From the Service Adapters list, drag a service to the right swimlane.

Figure 2-13 shows a web service being added to the designer.
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Figure 2-13 Adding Web Service to Composite
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A specific dialog or wizard for the selected reference displays. Table 2-10 describes
the available editors.

Table 2-10 Reference Editors

Dragging This Service... Invokes The...
Web Service Create Web Service dialog to create a web invocation service.
Adapters Adapter Configuration Wizard to guide you through integration

of the service with database tables, database queues, file
systems, FTP servers, Java Message Services (JMS), IBM
WebSphere MQ, BAM servers, sockets, or Oracle E-Business
Suite applications.

ADF-BC Service Create ADF-BC Service dialog to create a service data object
(SDO) invocation service.

B2B B2B Wizard to guide you through selection of a document
definition.

EJB Service Create EJB Service dialog to create an Enterprise JavaBeans
service for using SDO parameters with Enterprise JavaBeans.

HTTP Binding Create HTTP Binding Wizard to create HTTP binding. This

wizard enables you to invoke SOA composite applications
through HTTP POST and GET operations, and invoke HTTP
endpoints through HTTP POST and GET operations.

Direct Binding Create Direct Binding Service Dialog to invoke an Oracle Service
Bus (OSB) flow or another SOA composite application.

3. Configure the settings for the reference binding component. For help with a
reference editor, click Help or press F1. Click Finish.

Figure 2-14 shows the Web Service dialog with data entered to create a reference
called StoreFrontService.
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Figure 2-14 Create Web Service Dialog
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4. Click OK.

The reference binding component displays in the right swimlane. Figure 2-8
shows the StoreFrontService reference added to the composite.xml file.

Figure 2-15 Web Service in Composite
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5. Select Save All from the File main menu.

2.4.2 What You May Need to Know About Adding and Deleting References

Note the following detail about adding references:

= The only way to add a new reference in the SOA Composite Editor is by wiring
the service component to the necessary target service component. When a new
reference is added, the service component is notified so it can make appropriate

changes to its metadata. For example, when a reference is added to a BPEL service

component, the BPEL service component is notified to add a partner link that can
then be used in an invoke activity.

Note the following details about deleting references:

= When a reference for a service component is deleted, the associated wire is also
deleted and the service component is notified so it can update its metadata. For
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example, when a reference is deleted from a BPEL service component, the service
component is notified to delete the partner link in its BPEL metadata.

= Deleting a reference connected to a wire clears the reference and the wire.

2.4.3 What You May Need to Know About WSDL References

A WSDL file is added to the SOA composite application whenever you create a new
component that has a WSDL (for example, a service binding component, service
component (for example, Oracle Mediator, BPEL process, and so on), or reference
binding component. When you delete a component, any WSDL imports used by that
component are removed only if not used by another component. The WSDL import is
always removed when the last component that uses it is deleted.

When a service or reference binding component is updated to use a new WSDL, it is
handled as if the interface was deleted and a new one was added. Therefore, the old
WSDL import is only removed if it is not used by another component.

If a service or reference binding component is updated to use the same WSDL
(porttype gname), but from a new location, the WSDL import and any other WSDL
reference (for example, the BPEL process WSDL that imports an external reference
WSDL) are automatically updated to reference the new location.

Simply changing the WSDL location on the source view of the composite.xml file’s
import is not sufficient. Other WSDL references in the metadata are required by the
user interface (see the ui :wsdlLocation attribute on composite and componentType
services and references). There can also be other WSDL references required by runtime
(for example, a WSDL that imports another WSDL, such as the BPEL process WSDL).

Always modify the WSDL location though the dialogs of the SOA Composite Editor in
which a WSDL location is specified (for example, a web service, BPEL partner link,
and so on). Changing the URL’s host address is the exact case in which the SOA
Composite Editor automatically updates all WSDL references.

2.4.4 What You May Need to Know About Invoking the Default Revision of a Composite

A WSDL URL that does not contain a revision number is processed by the default
composite application. This action enables you to always call the default revision of
the called service without having to make other changes in the calling composite.

Select the default WSDL to use in the Resource Palette in Oracle JDeveloper.

1. In the Create Web Service dialog, click the icon to the right of the WSDL URL field
to invoke the SOA Resource Browser dialog.

2. Select Resource Palette from the list at the top.

3. Expand the nodes under the Application Server connection or WSIL connection
to list all deployed composites and revisions. The default revision is identified by
the word Default in the title. For example, OrderBookingComposite [Default].

4. Select the appropriate default endpoint and click OK.

2.5 Adding Wires

You wire (connect) the web service and service component. Note the following:

= Since a web service is an inbound service, a reference handle displays on the right
side. Web services that are outbound references do not have a reference handle on
the right side.
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= You can drag a defined interface to an undefined interface in either direction
(reference to service or service to reference). The undefined interface then inherits
the defined interface. There are several exceptions to this rule:

- A component has the right to reject a new interface. For example, a mediator
can only have one inbound service. Therefore, it rejects attempts to create a
second service.

- You cannot drag an outbound service (external reference) to a business rule,
because business rules do not support references. When dragging a wire, the
user interface highlights the interfaces that are valid targets.

= You cannot wire services and composites that have different interfaces. For
example, you cannot connect a web service configured with a synchronous WSDL
file to an asynchronous BPEL process. Figure 2-16 provides details.

Figure 2-16 Limitations on Wiring Services and Composites with Different Interfaces
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The service and reference must match, meaning the interface and the callback
must be the same. If you have two services that have different interfaces, you can
place a mediator between the two services and perform a transformation between
the interfaces.

2.5.1 How to Wire a Service and a Service Component

You can wire a service binding component to a service component from the SOA
Composite Editor.

To wire a service and a service component:
1. From a service reference handle, drag a wire to the service component interface, as

shown in Figure 2-17.

Figure 2-17 Wire Connection
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2. If the service component is a BPEL process, double-click the BPEL process and
note that the service displays as a partner link in the left swimlane, as shown in
Figure 2-18.

2-20 Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite



Adding Wires

Figure 2-18 Display of the Service as a Partner Link in the BPEL Process
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3. Select Save All from the File main menu.

2.5.2 How to Wire a Service Component and a Reference

You can wire a service component to a reference binding component from the SOA
Composite Editor.

To wire a service component and a reference:

1. In the Application Navigator, double-click composite.xml or single-click
composite.xml above the designer.

2. From the service component, drag a wire to the reference, as shown in Figure 2-19.

Figure 2-19 Wiring of a Service Component and Reference
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3. If the service component is a BPEL process, double-click the BPEL process and

note that the reference displays as a partner link in the right swimlane, as shown
in Figure 2-20.
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Figure 2-20 Display of the Reference as a Partner Link in the BPEL Process
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4. Select Save All from the File main menu.
5. In the Application Navigator, select the composite.xml file.
6. Click the Source tab to review what you have created.

The orderprocessor_client_ep service binding component shown in
Example 2-1 provides the entry point to the composite.

Example 2-1 Service

<service name="orderprocessor_client_ep"
ui:wsdlLocation="oramds: /apps/FusionOrderDemoShared

/services/orderbooking/OrderBookingProcessor.wsdl">

<interface.wsdl interface= "http://www.globalcompany.example.com/ns
/OrderBookingService#wsdl.interface (OrderProcessor) "

<binding.adf serviceName="OrderProcessorService" registryName=""/>

<callback>

<binding.ws port="http://www.globalcompany.example.com/ns

/OrderBookingService#wsdl.endpoint (orderprocessor_clientep/OrderProcessorCallback_
pt)"/>

</callback>

</service>

The OrderProcessor BPEL process service component is shown in Example 2-2:

Example 2-2 Service Component

<component name="OrderProcessor">
<implementation.bpel src="OrderProcessor.bpel"/>
</component>

A reference binding component named StoreFrontService is shown in
Example 2-3. The reference provides access to the external service in the outside
world.

Example 2-3 Reference

<reference name="StoreFrontService"
ui:wsdlLocation="oramds: /apps/FusionOrderDemoShared
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/services/oracle/fodemo/storefront/store/service/common/serviceinterface/StoreFron
tService.wsdl">
<interface.wsdl
interface="www.globalcompany.example.com#wsdl.interface(StoreFrontService)"/>
<binding.ws
port="www.globalcompany.example.com#wsdl.endpoint (StoreFrontService/StoreFrontServ
iceSoapHttpPort) "

location="oramds:/apps/FusionOrderDemoShared/services/oracle/fodemo/storefront/sto
re/service/common/serviceinterface/StoreFrontService.wsdl" />
</reference>

In Example 2—4, the communication (or wiring) between service components is
described:

The source orderprocessor_client_ep service binding component is
wired to the target OrderProcessor BPEL process service component.
Wiring enables web service message communication with this specific BPEL
process.

The source OrderProcessor BPEL process is wired to the target
StoreFrontService reference binding component. This is the reference to
the external service in the outside world.

Example 2-4 Wires

<wire>
<source.uri>orderprocessor_client_ep</source.uri>
<target.uri>OrderProcessor/orderprocessor_client_ep</target.uri>
</wire>

<wire>
<source.uri>OrderProcessor/StoreFrontService</source.uri>
<target.uri>StoreFrontService</target.uri>

</wire>

2.5.3 What You May Need to Know About Adding and Deleting Wires

Note the following details about adding wires:

= A service component can be wired to another service component if its reference
matches the service of the target service component. Note that the match implies
the same interface and callback interface.

= Adding the following wiring between two mediator service components causes an
infinite loop:

Create a business event.
Create a mediator service component and subscribe to the event.
Create a second mediator service component to publish the same event.

Wire the first mediator to the second mediator component service.

If you remove the wire between the two mediators, then for every message, the
second mediator can publish the event and the first mediator can subscribe to it.

Note the following details about deleting wires:

s When a wire is deleted, the component's outbound reference is automatically
deleted and the component is notified so that it can clean up (delete the partner
link, clear routing rules, and so on). However, the component's interface is never
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deleted. All Oracle SOA Suite services are defined by their WSDL interface. When
a component's interface is defined, there is no automatic deletion of the service
interface in the SOA Composite Editor.

If you want to change the service WSDL interface, there are several workarounds:

— In most cases, you just want to change the schema instead of the inbound
service definition. In the SOA Composite Editor, click any interface icon that
uses the WSDL. For example, you can click the web service interface icon or
the Oracle Mediator service icon. This invokes the Update Interface dialog,
which enables you to change the schema for any WSDL message.

- If you are using an Oracle Mediator service component, the Refresh
operations from WSDL icon of the Oracle Mediator Editor enables you to
refresh (after adding new operations) or replace the Oracle Mediator WSDL.
However, you are warned if the current operations are to be deleted. If you
change the WSDL to the new inbound service WSDL using this icon, the wire
typically breaks because the interface has changed. You can then wire Oracle
Mediator to the new service.

- Inmany cases, a new service requires a completely new Oracle Mediator.
Delete the old Oracle Mediator, create a new one, and wire it to the new
service.

- If you are using a BPEL process service component, select a new WSDL
through the Edit Partner Link dialog.

See Section 2.3.3, "How to View Schemas" for details about the Update Interface
dialog.

2.6 Adding Security

As you create your SOA composite application, you can secure web services by
attaching policies to service binding components, service components, and reference
binding components. For more information about implementing policies, see
Chapter 40, "Enabling Security with Policies."

2.7 Deploying a SOA Composite Application

Deploying the SOA composite application involves creating a connection to an Oracle
WebLogic Server and deploying an archive of the SOA composite application to an
Oracle WebLogic Server Managed Server. For more information about deploying SOA
composite applications, see Chapter 41, "Deploying SOA Composite Applications."

2.7.1 How to Invoke Deployed Composites

You can invoke other deployed SOA composite applications from your SOA composite
application. The other applications must be deployed.

To invoke other composites:
1. Create a web service or partner link through one of the following methods.

a. Inthe SOA Composite Editor, drag a Web Service from the Component
Palette to the External References swimlane.

b. In Oracle BPEL Designer, drag a Partner Link from the Component Palette to
the right swimlane.

2. Access the SOA Resource Browser dialog based on the type of service you created.
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a. For the Create Web Service dialog, click the Find existing WSDLs icon.
b. For the Edit Partner Link dialog, click the SOA Resource Browser icon.
3. From the list at the top, select Resource Palette.

4. Expand the tree to display the application server connection to the Oracle
WebLogic Administration Server on which the SOA composite application is
deployed.

5. Expand the application server connection.

6. Expand the SOA folder. Figure 2-21 provides details.

Figure 2-21 Browse for a SOA Composite Application
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7. Select the composite service.

8. Click OK.

2.8 Managing and Testing a SOA Composite Application

As you build and deploy a SOA composite application, you manage and test it using a
combination of Oracle JDeveloper and Oracle Enterprise Manager Fusion Middleware
Control.

2.8.1 How to Manage Deployed Composites

You can manage deployed SOA composite applications from the Application Server
Navigator in Oracle JDeveloper. Management tasks consist of undeploying, activating,
retiring, turning on, and turning off SOA composite application revisions.

Note: These instructions assume you have created an application
server connection to an Oracle WebLogic Administration Server on
which the SOA Infrastructure is deployed. Creating a connection to an
Oracle WebLogic Administration Server enables you to browse for
managed Oracle WebLogic Servers or clustered Oracle WebLogic
Servers in the same domain. From the File main menu, select New >
Connections > Application Server Connection to create a connection.

1. From the View main menu, select Application Server Navigator.

2. Expand your connection name (for this example, named
MyAppServerConnection).

The SOA folder appears, as shown in Figure 2-22. The SOA folder displays all
deployed SOA composite application revisions and services. You can browse all
applications deployed on all Oracle WebLogic Administration Servers, managed
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Oracle WebLogic Servers, and clustered Oracle WebLogic Servers in the same
domain. Figure 2-22 provides details.

Figure 2-22 Application Server Navigator
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3. Expand the SOA folder.
4. Expand the partition in which the composite application is deployed.
Deployed SOA composite applications and services appear, as shown in

Figure 2-23.

Figure 2-23 Deployed SOA Composite Applications
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5. Right-click a deployed SOA composite application.

6. Select an option to perform. The options that display for selection are based upon
the current state of the application. Table 2-11 provides details.

Table 2-11 SOA Composite Application Options

Option Description

Stop Shuts down a running SOA composite application revision. Any request
(initiating or a callback) to the composite is rejected if the composite is shut
down.

Note: The behavior differs based on which binding component is used. For
example, if it is a web service request, it is rejected back to the caller. A JCA
adapter binding component may do something else in this case (for example, put
the request in a rejected table).

This option displays when the composite application has been started.
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Table 2-11

(Cont.) SOA Composite Application Options

Option

Description

Start

Restarts a composite application revision that was shut down. This action enables
new requests to be processed (and not be rejected). No recovery of messages
occurs.

This option displays when the composite application has been stopped.

Retire

Retires the selected composite revision. If the process life cycle is retired, you
cannot create a new instance. Existing instances are allowed to complete
normally.

An initiating request to the composite application is rejected back to the client.
The behavior of different binding components during rejection is the same as for
the shut down option.

A callback to an initiated composite application instance is delivered properly.

This option displays when the composite application is active.

Activate

Activates the retired composite application revision. Note the following behavior
with this option:

= All composite applications are automatically active when deployed.

= Other revisions of a newly deployed composite application remain active
(that is, they are not automatically retired). If you want, you must explicitly
retire them.

This option displays when the application is retired.

Undeploy

Undeploys the selected composite application revision. The consequences of this
action are as follows:

= You can no longer configure and monitor this revision of the composite
application.

= You can no longer process instances of this revision of the composite
application.

= You cannot view previously completed processes.

= The state of currently running instances is changed to stale and no new
messages sent to this composite are processed.

= If you undeploy the default revision of the composite application (for
example, 2.0), the next available revision of the composite application
becomes the default (for example, 1.0).

Set Default Sets the selected composite application revision to be the default.

Revision

7. If you want to deploy a prebuilt SOA composite application archive that includes a
deployment profile, right-click the SOA folder and select Deploy SOA Archive.
The archive consists of a JAR file of a single application or a SOA bundle ZIP file
containing multiple applications.

You are prompted to select the following:

»  The target SOA servers to which you want to deploy the SOA composite
application archive.

s The archive to deploy.

= The configuration plan to attach to the application. As you move projects from
one environment to another (for example, from testing to production), you
typically must modify several environment-specific values, such as JDBC
connection strings, hostnames of various servers, and so on. Configuration
plans enable you to modify these values using a single text (XML) file called a
configuration plan. The configuration plan is created in either Oracle
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JDeveloper or from the command line. During process deployment, the
configuration plan is used to search the SOA project for values that must be
replaced to adapt the project to the next target environment. This is an
optional selection.

= Whether you want to overwrite an existing composite of the same revision ID.
This action enables you to redeploy an application revision.

For more information, see the following documentation:

s Chapter 41, "Deploying SOA Composite Applications" for details about creating a
deployment profile and a configuration plan and deploying an existing SOA
archive

»  Oracle Fusion Middleware Administrator’s Guide for Oracle SOA Suite and Oracle BPM
Suite for details about managing deployed SOA composite applications from
Oracle Enterprise Manager Fusion Middleware Control Console

2.8.2 How to Test a Deployed Composite

After you deploy a SOA composite application, you can initiate a test instance of it
from the Test Web Service page in Fusion Middleware Control to verify the XML
payload data. For more information about initiating a test instance, see the Oracle
Fusion Middleware Administrator’s Guide for Oracle SOA Suite and Oracle BPM Suite.

In addition to creating a test instance, you can also simulate the interaction between a
SOA composite application and its web service partners before deployment in a
production environment. This helps to ensure that a process interacts with web service
partners as expected by the time it is ready for deployment to a production
environment. For more information about creating a unit test, see Chapter 42,
"Automating Testing of SOA Composite Applications."
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Introduction to the SOA Sample Application

This chapter introduces the SOA sample application that can be used with this guide.
The WebLogic Fusion Order Demo application of the Fusion Order Demo
demonstrates various capabilities of Oracle SOA Suite and is used as an example
throughout this guide.

This chapter includes the following sections:

s Section 3.1, "Introduction to the Fusion Order Demo"

= Section 3.2, "Setting Up the Fusion Order Demo Application"

»  Section 3.3, "Taking a Look at the WebLogic Fusion Order Demo Application"
= Section 3.4, "Understanding the OrderBookingComposite Flow"

= Section 3.5, "Deploying Fusion Order Demo"

= Section 3.6, "Running Fusion Order Demo"

= Section 3.7, "Viewing Data Sent to Oracle BAM Server"

= Section 3.8, "Undeploying the Composites for the WebLogic Fusion Order Demo
Application”

3.1 Introduction to the Fusion Order Demo

The WebLogic Fusion Order Demo application is part of a larger sample application
called Fusion Order Demo. In this larger sample application, Global Company sells
electronic devices through many channels, including a web-based client application.
Electronic devices are sold through a storefront-type web application. Customers can
visit the web site, register, and place orders for the products.

There are two parts to the Fusion Order Demo, the Store Front module and the
WebLogic Fusion Order Demo application.

3.1.1 Store Front Module

The Store Front module provides a rich user interface built with Oracle Application
Development Framework to show how to combine an easily built AJAX user interface
with a sophisticated SOA composite application. It is based on Oracle ADF business
components, ADF model data bindings, and ADF faces.

The Store Front module sells electronic devices through a storefront-type web
application.

The Store Front module contains the following projects:
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s StoreFrontService: This project provides access to the storefront data and
provides transaction support to update data for customers, orders, and products.

s StoreFrontUI: This project provides web pages that the customer uses to
browse the storefront, place orders, register on the site, view order information,
and update the user profile.

Figure 3-1 shows the Home page of the Store Front module user interface. It shows the
featured products that the site wishes to promote and gives access to the full catalog of
items. Products are presented as images along with the name of the product. Page
regions divide the product catalog area from other features that the site offers.

Figure 3—-1 StoreFrontUl Home Page
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From the home page, you can browse the web site as an anonymous user, then log in
as a registered customer to place an order.

The Fusion Order Demo application ships with predefined customer data. Because the
Fusion Order Demo application implements Oracle ADF Security to manage access to
Oracle ADF resources, only the authenticated user can view orders in their cart.

For more information about the Store Front module, see Oracle Fusion Middleware
Fusion Developer's Guide for Oracle Application Development Framework.

3.1.2 WebLogic Fusion Order Demo Application

The WebLogic Fusion Order Demo application processes orders placed in the Store
Front module. It uses the following Oracle SOA Suite components:

s Oracle Mediator
s Oracle BPEL Process

s Oracle Human Workflow (using a human task)
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= Oracle Business Rules

= Spring

s Oracle User Messaging Service

= Oracle Business Activity Monitoring
s Oracle Metadata Repository

Once an order has been placed by using the Store Front module, the WebLogic Fusion
Order Demo application processes the order. When processing an order, it uses various
internal and external applications, including a customer service application, a credit
validation system, and both an internal vendor and external vendor. For example, the
internal vendor (InternalWarehouseService) and external vendor
(ExternalPartnerSupplier), are sent information for every order. As part of the
order process, they each return a price for which they would supply the items in the
order. A condition in the process determines which supplier is assigned the order.

For information about SOA composite applications, see Chapter 1, "Introduction to
Building Applications with Oracle SOA Suite."

3.2 Setting Up the Fusion Order Demo Application

This section describes how to prepare the environment to run the WebLogic Fusion
Order Demo application.

3.2.1 Task 1: Install Oracle JDeveloper Studio

Install Oracle JDeveloper 11¢ Studio Edition to create the WebLogic Fusion Order
Demo application. You can download Oracle JDeveloper from:

http://www.oracle.com/technology/products/jdev/11/index.html
Ensure that you download and install 11g and that it is the Studio Edition, not the Java

Edition. You can verify these details in Oracle JDeveloper from the Help > About
menu option.

In order to create and deploy SOA composite applications and projects, you must
install the Oracle SOA Suite extension. For instructions on installing this extension for
Oracle JDeveloper, see the Oracle Fusion Middleware Installation Guide for Oracle
JDeveloper.

3.2.2 Task 2: Install the Fusion Order Demo Application

Throughout this tutorial, you must view or use content from Fusion Order Demo in
your Oracle JDeveloper environment. The Fusion Order Demo is contained within a
ZIP file.

To access the ZIP file:

1. Download the Fusion Order Demo application ZIP file (FusionOrderDemo_
R1PS2.zip). You can download the ZIP file from:

http://www.oracle.com/technology/products/jdev/samples/fod/index.ht
ml

2. Unzip the file to a temporary directory.

This tutorial refers to this directory as DEMO_DOWNLOAD_HOME.
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3.2.3 Task 3: Install Oracle SOA Suite

To successfully deploy and run the Fusion Order Demo applications, you must
complete an installation for Oracle SOA Suite. Specifically, the domain contains an
Administration Server and a Managed Server.

Installing Oracle SOA Suite requires the following

s Creating schemas for Oracle SOA Suite in an Oracle database

= Installing Oracle WebLogic Server

s Configuring a domain in Oracle WebLogic Server to support Oracle SOA Suite,
Oracle Enterprise Manager, and optionally, Oracle BAM. Oracle BAM is not
required for Fusion Order Demo, but if an Oracle BAM Server is configured,
Oracle BAM Adapters send data to the Oracle BAM Server.

After the domain is created, it contains an Administration Server to host Oracle
Enterprise Manager Fusion Middleware Control for performing administrative
tasks, a Managed Server to host deployed applications, and if you configured
Oracle BAM, a second Managed Server for the Oracle BAM Server.

For instructions on installing and configuring Oracle SOA Suite, see the Oracle Fusion
Middleware Installation Guide for Oracle SOA Suite.

After successfully completing the installation process, perform the following

additional configuration steps:

1. Enable the credentials that are included in the StoreFront module by adding a
setting to the configuration file for the domain:

Locate the configuration file set for the Oracle SOA Suite domain in the
following directory:

(UNIX) MW_HOME/user_projects/domains/domain name/bin/setDomainEnv.sh
(Windows) MW_HOME\user_projects\domains\domain_name\bin\setDomainEnv.cmd

Add the following option to the JAVA_PROPERTIES (UNIX) or the SET
JAVA_PROPERTIES (Windows) line:

-Djps.app.credential.overwrite.allowed=true

For more information about setting this property, see Oracle Fusion Middleware
Fusion Developer’s Guide for Oracle Application Development Framework.

If the Oracle WebLogic Server Administration Server is running, stop it:

On UNIX, as the root user, change directories to directory Mw_HOME/user_
projects/domains/domain_name/bin and enter the following command:

. /stopWebLogic.sh

On Windows, from the Windows Start menu, select All Programs > Oracle
WebLogic > User Projects > domain_name > Stop Admin Server.

Start the Administration Server:

On UNIX, from directory MW_HOME/user_projects/domains/domain_
name/bin, enter the following command:

. /startWebLogic.sh

On Windows, from the Windows Start menu, select All Programs > Oracle
WebLogic > User Projects > domain_name > Start Admin Server.
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When prompted on UNIX, enter your Oracle WebLogic Server user name and
password. The password is not visible as you type.

The Administration Server is started when the command window displays the
following messages:

<Server state changed to RUNNING>
<Server started in RUNNING mode>

Leave the command window open, although you may minimize it. The
Administration Server is now running and ready for use.

e. When the Administration Server is in RUNNING mode, start the Managed
Servers, if they are not running. In a command window, enter the following
command all on one line:

On UNIX, from directory Mw_HOME/user_projects/domains/domain_
name/bin, enter the following command:

. /startManagedwWebLogic.sh managed_server name admin url username password

On Windows, from directory Mw_HOME\user_
projects\domains\domain name\bin, enter the following command:

startManagedWebLogic.cmd managed_server_name admin_url username password
Substitute the following values in Table 3-1.

Table 3—-1 startManagedWebLogic Values

Value Description

managed_server The name of the Managed Server. For example:
soa_serverl

bam_serverl

admin_url The URL of the Managed Server. For example:
http://soahost:8001
http://soahost:9001

The port of the Managed Server for hosting SOA
applications is typically 8001. The port of the Managed
Server for Oracle BAM is typically 9001.

username The Oracle WebLogic Server administrator. For example:
weblogic
password The password of the Oracle WebLogic Server

administrator. For example:

welcomel

2. If you are deploying remotely from one computer that has Oracle JDeveloper to
another computer that has the Oracle SOA Suite installation with Oracle WebLogic
Server, modify the JAVA_HOME and PATH environment variables on the computer
with the Oracle SOA Suite installation.

Oracle JDeveloper requires changes to these variables for running the scripts that
deploy the composite services. You set the JAVA_HOME variable to include the
path to the Oracle WebLogic Server JDK, and set the PATH variable to include the
path to the Oracle WebLogic Server bin directory for ant.

On UNIX, use the export command. For example:
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export JAVA_HOME=SMW_HOME/jdk160_11
export PATH=$PATH:MW_HOME/modules/org.apache.ant_1.7.0/bin
On Windows, perform the following steps to modify the variables:

a. Open Control Panel from the Windows Start menu and double-click the
System icon.

b. In the System Properties dialog, select the Advanced tab and click
Environment Variables.

c. In the Environment Variables dialog, locate the JAVA_HOME system variable
and ensure that it is set to the location of the Oracle WebLogic Server JDK.

If there is no JAVA_HOME variable defined, click New and in the New System
Variable dialog, enter a variable name of JAVA_HOME and a variable value
pointing to the Oracle WebLogic Server JDK, such as
C:\weblogic\jdkl160_11. Click OK to set the new system variable.

d. Double-click the Path system variable and ensure that it includes the path to
the Oracle WebLogic Server ant \bin directory. If it does not, add the path to
the end of the variable value. For example:

;C:\weblogic\modules\org.apache.ant_1.7.0\bin

Click OK to set the new system variable.

e. Click OK twice more to dismiss the Environment Variables and the System
Properties dialogs.

3.3 Taking a Look at the WebLogic Fusion Order Demo Application

After you have set up the WebLogic Fusion Order Demo application, spend time
viewing the WebLogic Fusion Order Demo artifacts in Oracle JDeveloper.

To open the WebLogic Fusion Order Demo in Oracle JDeveloper:
1. From the Oracle JDeveloper main menu, choose File > Open.

2. In the Open dialog, browse to DEMO_DOWNLOAD_HOME/CompositeServices
and select WebLogic Fusion Order Demo.jws. Click Open.

3. When prompted to migrate files to the 11.1.1.3.0 format, click Yes. When the
migration is complete, click OK.

Figure 3-2 shows the Application Navigator after you open the file for the
application workspace. It displays the project applications of the WebLogic Fusion
Order Demo.

Figure 3—2 Projects of WebLogic Fusion Order Demo Application
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3.3.1 Project Applications of the WebLogic Fusion Order Demo Application

Table 3-2 lists and describes the projects in the WebLogicFusionOrderDemo
application workspace.

Table 3-2 Projects in the WebLogic Fusion Order Demo Application

Application Description

B2BxX120rderGateway This project contains a composite for Oracle B2B. This
composite is not used in this guide.

bin This project contains a build script for deploying all the
SOA projects. It also contains templates for seeding JMS
connector information, demo topics, and demo users.

CreditCardAuthorization This project provides the service needed by
OrderBookingComposite project to verify the credit
card information of a customer.

ExternallegacyPartnerSupp This project provides an external system to provide price
lierEjb quotes.

OrderApprovalHumanTask This project provides a task form for approving orders
from the OrderBookingComposite project.

OrderBookingComposite This project processes an order submitted in the Store
Front module user interface. This project contains the main
process for the WebLogic Fusion Order Demo application.
It also uses the Oracle BAM adapter and Oracle BAM
sensors to send active data into Oracle BAM dashboard.
This composite is not used in this guide.

OrderSDOComposite This project simulates the StoreFrontService service
of the Store Front module for testing purposes.

PartnerSupplierComposite  This project contains a composite containing both a BPEL
process and spring context for obtaining a quote from a
partner warehouse. It is referenced as a service from the
composite for the OrderBookingComposite project. The
quote request is routed to either the BPEL process or the
spring component based on the amount.

3.3.2 The composite.xml File

To understand how a composite is designed, examine the main project,
OrderBookingComposite, in Oracle JDeveloper.

To view the composite.xml file:
1. In Application Navigator, expand OrderBookingComposite > SOA Content.

2. Select composite.xml.

The composite then appears in the SOA Composite Editor in Oracle JDeveloper, as
shown in Figure 3-3.
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Figure 3-3 SOA Composite Editor
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3.4 Understanding the OrderBookingComposite Flow

OrderBookingComposite is the main project of the WebLogic Fusion Order Demo
application, containing a composite application for processing orders from Global

Company. This composite demonstrates how services, both internal to an enterprise,
and external at other sites, can be integrated using the SOA architecture paradigm to

create one cohesive ordering system.

Published:
OnTaskAssigned

¥ B
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Dperations: 2

send| MM oti fication
sendFaxotifica

USPSShip ment

Dperations: )
Write

FulfilimentBatch
Dperations:
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At the center of OrderBookingComposite composite is the OrderProcessor BPEL
process. It orchestrates all the existing services in the enterprise for order fulfillment
with the right warehouse, based on the business rules in the process.

Figure 3-4 shows an overview of the OrderBookingComposite composite for the
WebLogic Fusion Order Demo application, followed by a step-by-step description of
the composite flow for how the application processes an order.
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Figure 3—-4 OrderBookingComposite Flow
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When a new customer registers in Global Company’s storefront user interface, the web
client sends the customer’s information to the internal customer service application
called storeFrontService. StoreFrontService then stores the customer
information in a database. The customer can then browse products, add them to their
online shopping cart, and place the order. User ngreenbe is the only user not
required to register before placing an order.
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When a registered customer uses Global Company’s storefront user interface, the user
interface invokes the StoreFrontService and provides authentication. A registered
user builds up their shopping cart, and places an order. When the order is submitted,
the following events take place:

After an order is placed, the following sequence occurs to complete the order:

1. Oracle ADF Business Component writes the order to a database with schema for
Fusion Order Demo, and raises a NewOrderSubmitted event using the Event
Delivery Network (EDN). The data associated with this event is the order ID.

2. Because the OrderPendingEvent mediator subscribes to the
NewOrderSubmitted event, the EDN layer notifies the OrderPendingEvent
mediator of the new order.

3. The OrderPendingEvent mediator receives the order and routes the input order
ID to the OrderProcessor BPEL process.

4. The OrderProcessor BPEL process receives the order ID from the database,
using a bind entity activity to bind to the exposed Oracle ADF Business
Component StoreFrontService service.

Some of the information about the order used later in the process is:
s Customer ID

» Items the customer purchased

»  Credit card used

= Shipping address chosen

5. The BPEL process initiates StoreFrontService, passing it the order ID, to
retrieve information about the customer.

6. The BPEL process then sends the purchase amount, credit card type, and credit
card number to CreditCardAuthorizationService, which verifies if the
customer's credit card is valid.

If credit card is not valid, the BPEL process cancels the order.

If credit card is valid, the BPEL process sends the order to the
RequiresApprovalRule business rule to determine if the order requires
approval by management.

7. The RequiresApprovalRule business rule evaluates if manual approval is
required. The business rule contains a rule that requires manual approval for
orders over $2,000.

8. For those orders requiring manual approval, the BPEL process invokes the
ApprovalHumanTask human task, which in turn performs the following:

= Routes a message to an assignee named jstein, who then approves or
disapproves the order.

s Publishes the OnTaskAssigned event. The
OrderApprovalTaskAssignedMediator mediator subscribes this event,
and if an Oracle BAM Server is configured, it uses an Oracle BAM Adapter to
send the assignee ID jstein (based on the ECID) of the order to the Oracle
BAM Server.

9. If the order is approved, the BPEL process sends the order information to the
following suppliers in parallel to obtain a bid:
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= Internal supplier by using the InternalWarehouseService BPEL process,
also located in OrderBookingComposite

= External supplier by using the PartnerSupplierMediator mediator,
which in turn routes to the ExternalPartnerSupplier BPEL process or
SpringPartnerSupplierMediator spring component, located in another
composite called PartnerSupplierComposite

10. The two suppliers respond with their bids, and the BPEL process send the bids to
the EvaluatePreferredSupplierRule business rule.

11. The EvaluatePreferredSupplierRule business rule chooses the supplier
with the lower of the two bids.

12. The BPEL process invokes the FulfillOrder mediator, which performs the
following four operations:

= Stores the order in a temporary queue and uploads it to the fulfillment system
in batch mode overnight

s Routes the order to USPS

s If an Oracle BAM Server is configured, it uses an Oracle BAM Adapter to send
data about the order (based on order ID) to the Oracle BAM Server.

s If an Oracle BAM Server is configured, it uses an Oracle BAM Adapter to send
data about the time for the order to process (based on the instance ID) to the
Oracle BAM Server.

13. Once the order is fulfilled, the BPEL process sets the order to complete.

14. The BPEL process invokes the NotificationService service, which sends the
customer an E-mail notification with the purchase order information.

15. When the order completes, the OrderPendingEvent mediator publishes the
OrderCompleted business for the OrderProcessor process.

While not depicted in Figure 3—4, the OrderBookingComposite composite provides
the following processing flow for approved orders:

1. The UpdateOrderStatus mediator performs the following:

s Publishes business event OrderUpdateEvent and sends the order ID to the
OrderProcessor BPEL process.

= If an Oracle BAM Server is configured, it uses an Oracle BAM Adapter to send
data about the order ID and order status to the Oracle BAM Server.

2. The OrderUpdateEventMediator mediator subscribes to business event
OrderUpdateEvent, sends the order ID to StoreFrontService, and waits for
the StoreFrontService to respond with updated details about the order.

To aid with the tracking of an order, the OrderBookingComposite composite
contains sensors to provide a method for implementing trackable fields on messages.
For example, the CreditCardAuthorization service has a composite sensor that
indicates if the credit card was authorized. In addition, the OrderProcessor BPEL
process also uses sensors for various activities. For example, the Scope_
AuthorizeCreditCard scope in the OrderProcessor BPEL process, which
verifies that the customer has acceptable credit using the
CreditCardAuthorizationService service, uses a sensor for tracking. When you
monitor instances of a composite through Oracle Enterprise Manager Fusion
Middleware Control Console, you can monitor the sensors for both the composite and
the BPEL process.
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In the remaining sections of this chapter, deploy and run Fusion Order Demo. As a
part of it running it, use Fusion Middleware Control Console to monitor orders
processed by the OrderBookingComposite composite. When you monitor an
order, you can also view the composite sensors and activity sensors.

3.5 Deploying Fusion Order Demo

This section describes how to deploy the Fusion Order Demo applications in the
partition.

3.5.1 Task 1: Create a Connection to an Oracle WebLogic Server

To create a connection to an Oracle WebLogic Server:
1. Start Oracle JDeveloper:

(UNIX) ORACLE_HOME/jdev/bin/jdev
(Windows) JDEV_ORACLE_HOME\jdeveloper\JDev\bin\jdev.exe

2. From the Application Menu, select New.

Figure 3-5 Application Menu
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3.

In the New Gallery dialog, in the Categories tree, select General, and then
Connections.

Select Application Server Connection and click OK.
The Create Application Server Connection Type page displays.

Enter a unique name for the connection in the Connection Name field and select
WebLogic 10.3 from the Connection Type list.
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Figure 3—6
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6. Click Next.

The Authentication page is displayed.

7. Enter weblogic for the User Name and the password for that administrator in
the Password field.

8. In the Configuration page, enter the details shown in Table 3-3.

Table 3-3 Configuration Page Fields and Values

Application Description

Weblogic Hostname Name of the DNS name or IP address of the

(Administration Server) Administration Server of the Oracle WebLogic Server

Port The address of the port on which the Administration
Server is listening for requests (7001 by default)

Weblogic Domain The domain name for Oracle WebLogic Server

9. Click Next.

The Test page displays.

10. Click Test Connection.

The following message should appear:

Testing
Testing
Testing
Testing
Testing
Testing
Testing
Testing

JSR-88 ... success.
JSR-88-LOCAL ... success.
JNDI ... success.
JSR-160 DomainRuntime ... success.
JSR-160 Runtime ... success.
JSR-160 Edit ... success.
HTTP ... success.
Server MBeans Model ... success.

8 of 8 tests successful.

If the test is unsuccessful, ensure that Oracle WebLogic Server is running, and
retry the test.
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11. Click Finish.

12. In the Resource Palette, under IDE Connections, expand Application Server to
see the application server connection that you created.

Figure 3—7 Resource Palette
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3.5.2 (Optional) Task 2: Create a Connection to the Oracle BAM Server

If you configured an Oracle BAM Server during installation, create a connection to it.

To create a connection to an Oracle BAM Server:
1. From the Application Menu, select New.

2. Inthe New Gallery dialog, in the Categories tree, select General, and then
Connections.

3. Select BAM Connection and click OK.

The BAM Connection Wizard displays.
Ensure that Application Resources is selected.
Provide a name for the connection.

Click Next.

N o a &

Enter weblogic for the User Name and the password for that administrator in
the Password field.

8. Enter the connection information about the Oracle BAM Server host described in
Table 3-4.

Table 3—-4 Oracle BAM Server Connection Information

Field Description

BAM Web Host Enter the name of the host on which the Oracle BAM Report
Server and web applications are installed. In most cases, the
Oracle BAM web applications host, Oracle BAM Server host,
and the Oracle WebLogic Server are the same.

BAM Server Host Enter the name of the host on which the Oracle BAM Server is
installed.

User Name Enter the Oracle BAM Server user name. For example:
weblogic

Password Enter the password of the user name.

HTTP Port Enter the port number or accept the default value of 9001. This is
the HTTP port for the Oracle BAM web applications host.

JNDI Port Enter the port number or accept the default value of 9001. The
JNDI port is for the Oracle BAM report cache, which is part of
the Oracle BAM Server.
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Table 3—-4 (Cont.) Oracle BAM Server Connection Information

Field Description
Use HTTPS Select this checkbox to use secure HTTP (HTTPS) to connect to
the Oracle BAM Server during design time. Otherwise, HTTP is
used.
9. Click Next.
The Test page displays.
10. Click Test Connection.
The following message should appear:
Testing HTTP connection ... success.
Testing Data Object browsing ... success.
Testing JNDI connection ... success.
3 of 3 tests successful.
11. Click Finish.

3.5.3 Task 3: Install the Schema for the Fusion Order Demo Application

To install the schema for the sample application:

1.
2.

Start Oracle JDeveloper 11g and from the main menu choose File > Open.

In the Open dialog, browse to DEMO_DOWNLOAD_HOME/Infrastructure and
select Infrastructure.jws. Click Open.

When prompted to migrate files to the 11.1.1.3.0 format, click Yes. When the
migration is complete, click OK.

In the Application Navigator, expand MasterBuildScript and then Resources, and
double-click build.properties.

In the editor, modify the following properties shown in Table 3-5 for your
environment.

Table 3-5 Properties Required to Install the Fusion Order Demo Application

Field Description

jdeveloper .home The root directory where you have Oracle JDeveloper 11g

installed. For example:

C:/JDeveloper/11

jdbc.urlBase The base JDBC URL for your database in the format

jdbc:oracle:thin:@<yourhostname>. For example:

jdbc:oracle:thin:@localhost

jdbc.port The port for your database. For example:
1521

jdbc.sid The SID of your database. For example:
ORCL or XE

db.adminUser The administrative user for your database. For example:
system
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Table 3-5 (Cont.) Properties Required to Install the Fusion Order Demo Application

Field Description

db.demoUser. tablespace The tablespace name for the Fusion Order Demo users. For
example:
USERS

6. From the JDeveloper main menu, choose File > Save All.

7. Inthe Application Navigator, under the Resources node, right-click build.xml and
choose Run Ant Target > buildAll

8. When prompted, enter the administrative-user password for your database.

The buildAll command then creates the FOD user and populates the tables in the
FOD schema. In the Apache Ant - Log, a series of SQL scripts display, followed by:

buildall:
BUILD SUCCESSFUL
Total time: nn minutes nn seconds

For more information on the demo schema and scripts, see the README . txt file in
the MasterBuildScript project.

3.5.4 Task 4: Set Configuration Property for the Store Front Module

You can deploy the Store Front module as a simple web application or as part of a SOA
environment. There is a property defined in the service portion of the Store Front
module that is used within one of its pages to determine whether the Submit Order
button fires an event that launches a BPEL process. When using the Store Front
module within a SOA environment, you must change the default value for this
property.

1. Choose File > Open.

2. In the Open dialog, browse to DEMO_DOWNLOAD_HOME/StoreFrontModule and
select StoreFrontModule.jws. Click Open.

3. When prompted to migrate files to the 11.1.1.3.0 format, click Yes. When the
migration is complete, click OK.

Figure 3-8 shows the Application Navigator after you open the file for the
application workspace.

Figure 3-8 Application Navigator with StoreFrontModule
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4. Inthe Application Navigator, expand StoreFrontService > Application Sources >
oracle.fodemo.storefront > store > service.
5. Right-click StoreServiceAM and select Configurations.

6. Inthe Manage Configurations dialog, select StoreServicceAMLocalWeb in the
Names list, and then click Edit.
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Figure 3-9 StoreServiceAMLocalWeb
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7. In the Edit Business Components Configuration dialog, select the Properties tab
and the fod.application.issoaenabled property. This property specifies whether
the application is being deployed to a SOA environment.

8.

click OK.

Figure 3—10 fod.application.issoenabled
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9. Click OK.
10. In the Manage Configurations dialog, click OK.

3.5.5 Task 5: Deploy the Store Front Module

To deploy the Store Front module, you first deploy services and then to deploy the
application itself.

During deployment, Oracle JDeveloper creates the . jar and .war files and then
assembles the . ear file, as specified in the deployment profiles. After the file is
assembled, Oracle JDeveloper deploys the . ear file and unpacks it in a directory on
the application server. The directory that is used is dependent on the target
environment.

To deploy the Store Front module:

1. Deploy the services used by the Store Front module to send orders to the
OrderBookingComposite composite.

a. From the Application menu, choose Deploy > StoreFrontModule_
SDOServices.

Figure 3—11 StoreFrontService_SDOServices
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b. In the Deployment Action page of the Deploy StoreFrontService_SDOServices
dialog, select Deploy to Application Server, and then click Next.

c. In the Select Server page, select MyAppServerConnection.You created this
connection in Section 3.5.1, "Task 1: Create a Connection to an Oracle
WebLogic Server."

d. Deselect option Deploy to all server instances in the domain, and then click
Next.

e. In the Server Instances page, select the Managed Server for the Oracle
WebLogic Server, such as soa_server, and click OK.

f. Inthe Summary page, click Finish.

g. View the messages that display in the Deployment log window at the bottom
of Oracle JDeveloper to ensure deployment was successful.
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Deploy the Store Front module. From the Application menu, select Deploy >
StoreFrontModule > to > MyAppServerConnection.

a. From the Application menu, choose Deploy > StoreFrontModule.

b. In the Deployment Action page of the Deploy StoreFrontModule dialog, select
Deploy to Application Server, and then click Next.

c. In the Select Server page, select MyAppServerConnection.

d. Deselect option Deploy to all server instances in the domain, and then click
Next.

e. In the Server Instances page, select the Managed Server for the Oracle
WebLogic Server, such as soa_server, and click Next.

f. Inthe Summary page, click Finish.

g. View the messages that display in the Deployment log window at the bottom
of Oracle JDeveloper to ensure deployment was successful.

3.5.6 Task 6: Deploy the WebLogic Fusion Order Demo Application

In this task, you deploy the WebLogic Fusion Order Demo application to an Oracle
SOA Suite installation, containing an Oracle WebLogic Server domain with an
Administration Server and a Managed Server.

To deploy the WebLogic Fusion Order Demo application:

1.
2.

In the Application Navigator, select WebLogicFusionOrderDemo.

If you configured an Oracle BAM server during installation, perform the following
steps:

a. From the Application Navigator, expand OrderBookingComposite, then SOA
Content, and then bin. Double-click sca-build.properties.

Figure 3—12 Navigating to sca-build.properties
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b. In the editor, modify the following properties shown in Table 3-6 for the

Oracle BAM environment.
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Table 3-6 Properties Required for Oracle BAM

Field

Description

enable.bam.sensors

true

Set to true to enable sensors for Oracle BAM.

seed.bam.do

true

Set to true to seed data objects, alerts, and reports for Oracle
BAM.

After deployment is done, set this value back to false. If this
parameter is set true after initial deployment and you
redeploy at a later time, then the data objects, alerts, and
reports reseed. Therefore, after initial deployment, set this
parameter to false.

bam.

server.host

The DNS name or IP address of the Managed Server for
Oracle BAM. For example:

soahost

bam.

server.port

The port of the Managed Server for Oracle BAM. For example:
9001

bam.

server.username

The Oracle WebLogic Server administrator. For example:

weblogic

bam.

server.password

The password of the Oracle WebLogic Server administrator.
For example:

welcomel

3.

C.

From the JDeveloper main menu, choose File > Save All. Keep the

sca-build.properties tab open, so you can modify the seed.bam.do
parameter to false after deployment.

In the editor, perform the following steps for the WebLogicFusionOrderDemo
application:

From the Application Navigator, expand bin, and then Resources.

Double-click build.properties.

Figure 3—13 Navigating to build.properties
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b. In the editor, modify the following properties shown in Table 3-7 for the
WebLogicFusionOrderDemo application.

Table 3-7 Properties Required for the WebLogic Fusion Order Demo Application

Field

Description

oracle.home

The root directory where you have Oracle JDeveloper 11g
installed. For example:

C:\\Oracle\\Middleware\\jdeveloper\\

soa.only.deployment

false

You set this property to true if you are using the
OrdersSDOComposite composite to place orders. This guide
assumes you are using the Store Front Module to place orders.
Therefore, you must modify this property to false.

admin.server.host

The DNS name or IP address of the Administration Server for
Oracle SOA Suite for hosting applications. For example:

soahost

admin.server.port

The port of the Administration Server. For example:
8001

managed.server

The DNS name or IP address of the Managed Server for
Oracle SOA Suite for hosting applications. For example:

soahost

managed.server.port

The port of the Managed Server for Oracle SOA Suite for
hosting applications. For example:

8001

server.user

The Oracle WebLogic Server administrator. For example:

weblogic

server.password

The password of the Oracle WebLogic Server administrator.
For example:

welcomel

server.targets

The name of the Managed Server. For example:

soa_server

soa.server.oracle.home

The location of where to store the deployment plans for the
adapters. For example:

C:\\AS11gR1S0OA

foreign.mds. type

The location of the Oracle Metadata Repository.

Leave the value to db and supply values for the
mds.db.userid, mds.db.password, and mds.db.url
parameters to specify the location of the MDS Repository.

Set the value to Leave the default value to jdev. You do not
have to specify the values for the following parameters:

soa.partition.name

The partition in which to deploy the composites. For example:

soaFusionOrderDemo

4. From the JDeveloper main menu, choose File > Save All.

5. Inthe Application Navigator, under the Resources node, right-click build.xml and
choose Run Ant Target and select the following ant targets in the specified
sequential order shown in Table 3-8.
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Table 3-8 ant Targets to Deploy the WebLogic Fusion Order Demo Application

Target Description

1. validateFodConfigSettings This script validates the server settings, checks if the
servers are up, and also validates the MDS settings. If this
script returns without error, proceed with target
server-setup-seed-deploy-test.

2. server-setup-seed-deploy-test  This script calls the following targets:

s compile-deploy-all compiles, builds, and deploys
all the SOA composites to the Managed Server.

s seedFodJmsResources populates the JMS resources
for the Fulfillment mediator.

s seedDemoUsers This script adds jstein as the user
to approve orders for over $2,000. When you run the
demo, you place an order for $2,000 and log in to the
Oracle BPM Worklist as jstein and approve the
order.

In the Apache Ant - Log, you should see the following message when the target
successfully completes:

BUILD SUCCESSFUL
Total time: nn minutes nn seconds

If you set up Oracle BAM after you run target
server-setup-seed-deploy-test, you can still configure Oracle BAM for
Fusion Order Demo by running one of these targets:

s Re-run target server-setup-seed-deploy-test.

s From the Application Navigator, right-click build_sca_composite.xml,
(OrderBookingComposite > SOA Content) choose Run Ant Target, and then
select seedBAMServerObjects.

6. Go back to the sca-build.properties tab and modify the seed.bam. do parameter
to false.

7. From the JDeveloper main menu, choose File > Save AlL

3.6 Running Fusion Order Demo

You begin the ordering process in the storefront user interface, where you submit an
orders.

When an order is submitted, the Application Development Framework Business
Component writes the order to database and raises an NewOrder Submi t ted business
event using the Events Delivery Network (EDN). The OrderPendingEvent mediator
subscribes this event, and initiates the main BPEL process, OrderProcessor, to
process the order.

After you submit an orders, you use Fusion Middleware Control for the Oracle SOA
Suite installation to monitor how the OrderProcessor BPEL process orchestrated
the orders. If you submit an order for more than $2,000, you can monitor how it
requires human approval.

The instructions for placing orders and monitoring them in detail with Fusion
Middleware Control are available from Oracle Technology Network:

http://download.oracle.com/otn_hosted_doc/jdeveloper/doc/1l1l/runningfod_
notes.pdf
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3.7 Viewing Data Sent to Oracle BAM Server

If you configured an Oracle BAM server and a Managed Server for it, you can use the
Oracle BAM Architect to view data sent to the server. For more information about
using Oracle BAM applications, including Oracle BAM Architect, see Oracle Fusion
Middleware User’s Guide for Oracle Business Activity Monitoring.

3.8 Undeploying the Composites for the WebLogic Fusion Order Demo
Application
To undeploy the WebLogic Fusion Order Demo composite applications:
1. Access the Undeploy SOA Composite wizard in Fusion Middleware Control
through the options described in Table 3-9.

Table 3-9 Options to Access Undeploy SOA Composite Wizard

From the SOA
From the SOA From the SOA Folder in  Infrastructure Home From the SOA Composite
Infrastructure Menu... the Navigator... Page... Menu...
1. Select SOA 1. Right-click soa-infra. 1. Click the Deployed Select SOA Deployment >
lecali:o;irgwnt > 2 Select SOA Composites tab. Undeploy.
ploy: Deployment > 2, In the Composite
The Select Undeploy. table, select both
SOH;I; ;)ssne page The Select Composite g:;:l;;]?iookmgCOmp °
2 I:It)he S O A page appears. PartnerSupplierComp
) Composite 3. Inthe SOA osite.
Deployments gomposue . 3. Above the Composite
. eployments section, .
section, select lect table, click Undeploy.
OrderBookingCo s¢ d Ki
mposite and Qr er]zloo ingCompo
PartnerSupplierCo ;lte an S lierC
moosite to artnerSupplierComp
uereploy them osite to undeploy, and
and click Next. click Next.

The Confirmation page appears.

2. Click Undeploy. Note that you are warned if you are about to undeploy the last
remaining revision of a deployed composite application.

Processing messages display.

3. When undeployment has completed, click Close.
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Using the BPEL Process Service
Component

This part describes the BPEL process service component.

This part contains the following chapters:

Chapter 4, "Getting Started with Oracle BPEL Process Manager"

Chapter 5, "Introduction to Interaction Patterns in a BPEL Process"
Chapter 6, "Manipulating XML Data in a BPEL Process"

Chapter 7, "Invoking a Synchronous Web Service from a BPEL Process"
Chapter 8, "Invoking an Asynchronous Web Service from a BPEL Process”
Chapter 9, "Using Parallel Flow in a BPEL Process"

Chapter 10, "Using Conditional Branching in a BPEL Process"

Chapter 11, "Using Fault Handling in a BPEL Process"

Chapter 12, "Transaction and Fault Propagation Semantics in BPEL Processes"
Chapter 13, "Incorporating Java and Java EE Code in a BPEL Process"
Chapter 14, "Using Events and Timeouts in BPEL Processes"

Chapter 15, "Coordinating Master and Detail Processes"

Chapter 16, "Customizing SOA Composite Applications"

Chapter 17, "Using the Notification Service"

Chapter 18, "Using Oracle BPEL Process Manager Sensors"






4

Getting Started with Oracle BPEL Process
Manager

This chapter describes how to get started with Oracle BPEL Process Manager. Key
BPEL design features such as activities, partner links, and adapters are also described.

This chapter includes the following sections:

m  Section 4.1, "Introduction to the BPEL Process Service Component"
s Section 4.2, "Introduction to Activities"

s Section 4.3, "Introduction to Partner Links"

»  Section 4.4, "Creating a Partner Link"

= Section 4.5, "Introduction to Technology Adapters"

s Section 4.6, "Introduction to BPEL Process Monitors"

= Section 4.7, "Migrating Custom SOA Composite Applications in Oracle
JDeveloper"

4.1 Introduction to the BPEL Process Service Component

This section provides an introduction to the BPEL process service component in the
design environment.

4.1.1 How to Add a BPEL Process Service Component
You add BPEL process service components in the SOA Composite Editor.

To add a BPEL process service component:
1. Follow the instructions in Table 4-1 to start Oracle JDeveloper.

Table 4-1 Starting Oracle JDeveloper
To Start... On Windows... On UNIX...

Oracle JDeveloper  Click JDev_Oracle_ $SORACLE_HOME/jdev/bin/jdev
Home\ jdeveloper\JdDev\bin\jdev.
exe or create a shortcut

2. Add a BPEL process service component through one of the following methods:

As a service component in an existing SOA composite application:
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a.

From the Component Palette, drag a BPEL Process service component into the
SOA Composite Editor.

In a new application:

a.

g.
h.

From the Application Navigator, select File > New > Applications > SOA
Application.

This starts the Create SOA Application wizard.

In the Application Name dialog, enter an application name in the Application
Name field.

In the Directory field, enter a directory path in which to create the SOA
composite application and project.

Click Next.

In the Project Name dialog, enter a name in the Project Name field.
Click Next.

In the Project SOA Settings dialog, select Composite With BPEL Process.
Click Finish.

Each method causes the Create BPEL Process dialog shown in Figure 4-1 to
appear.

3. Provide the required details (including BPEL process name). Click Help for details
about the types of BPEL processes you can create.

Figure 4-1 Create BPEL Process Dialog

é- Create BPEL Process gl

BPEL Process

A BPEL process is a service orchestration, used ko describefexecute a business process {or large grained ﬁva
service), which is implemented as a skateful service,

Marne!
Mamespace: |http:,l',l'www.globalcompanv.example.cc-m,l'ns,l'OrderBoc-HngService |
Template:

Service Mame: |0rderpr0cessor_client |

| Help | | Ok | Cancel |

|OrderPrc-cessor |

|ﬁ Asynchronous BPEL Process v| @

Expose as a SOAF service

Input: |{http:,l',l'www.globalcompanv.example.com,l'ns,l'OrderBookingService}-process | Ck

Output: |{http:,l',l'www.globalcompany.example.com,l'ns,l'OrderBookingService}-processResponse | Q

Always use completely unique names when creating BPEL processes. Do not
Create:

A process name that begins with a number (for example, 1SayHello)
A process name that includes a dash (for example, Say-Hello)

Two processes with the same name, but with different capitalization (for
example, SayHello and sayhello)
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= A process name that exceeds 500 characters.

= A non-ASCII process name. The BPEL process name is used in directory and
file names of the SOA project, which can cause problems.

4. Click OK.
Oracle BPEL Designer displays the sections shown in Figure 4-2.

Figure 4-2 Oracle BPEL Designer Sections
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Each section of this view enables you to perform specific design and deployment
tasks. Table 4-2 identifies the sections listed in Figure 4-2.
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Table 4-2 Oracle JDeveloper Sections

Element Description

Application Navigator Displays the process files of a SOA project. Key files include the
following:

= composite.xml

Describes the entire SOA composite application. For more
information about this file, see Section 2.1.2, "What Happens
When You Create a SOA Application and Project."

= .bpel

Depending upon the process type you selected, initially
contains a minimal set of activities (if you selected to create an
asynchronous process, then receive and invoke activities
appear). You add syntax to this file when you drag activities,
create variables, create partner links, and so on.

= .componentType

Describes the services and references for the BPEL process
service component.

[ ] wsdl

The Web Services Description Language (WSDL) client
interface, which defines the input and output messages for
this BPEL process flow, the supported client interface and
operations, and other features. This functionality enables the
BPEL process flow to be called as a service.

= monitor.config

Defines runtime and deployment properties needed to connect
with Oracle BAM Server to create the Oracle BAM data objects
and dashboards.

Designer Provides a visual view of the BPEL process service component that
you design. This view displays when you perform one of the
following actions:

= Double-click the .bpel file name in the Application Navigator.

= Click the Design tab at the bottom of the window with the
.bpel file selected.

= Double-click the BPEL process component in the SOA
Composite Editor.

As you design the BPEL process service component by dragging
activities, creating partner links, and so on, the Design window
changes.

Component Palette Displays the available activities to add to the BPEL process service
component. Activities are the building blocks. The BPEL Activities
selection of the Component Palette displays a set of activities that
you drag into the designer of the BPEL process service component.
The Component Palette displays only those pages relevant to the
state of the designer. BPEL Activities or BPEL Services are nearly
always visible. However, if you are designing a transformation in a
transform activity, the Component Palette only displays selections
relevant to that activity, such as String Functions, Mathematical
Functions, and Node-set Functions.
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Table 4-2 (Cont.) Oracle JDeveloper Sections

Element

Description

Structure window

Provides a structural view of the data in the BPEL process service
component currently selected in the designer. You can perform a
variety of tasks from this section, including;:

= Importing schemas
= Defining message types

= Managing (creating, editing, and deleting) elements such as
variables, aliases, correlation sets, and partner links.

»  Editing activities in the BPEL process flow sequence that
displays in the designer

Log window

Displays messages about the status of validation and compilation.
To ensure that a BPEL process service component validates
correctly, you must ensure that the following information is correct:

»  The BPEL process service component must have an input
variable.

= A partner link must be selected.
m A partner role must be selected.
= The operation must not be empty.

= The input variable type must match the partner link operation
type.

If deployment is unsuccessful, messages appear that describe the

type and location of the error.

Source window

View the syntax inside the BPEL process service component files.
As you drag activities and partner links, and perform other tasks,
the syntax in these source files is immediately updated to reflect
these changes.

History window

Displays the revision history of a file and read-only and editable
versions of a file side-by-side.

Property Inspector

Displays details about an activity. Single-click an activity in the
Design window to display details.

Note: To learn more about these sections, you can also place the
cursor in the appropriate section and press F1 to display online Help.

4.2 Introduction to Activities

Activities are the building blocks of a BPEL process service component. Oracle BPEL
Designer includes a set of activities that you drag into a BPEL process service
component. You then double-click an activity to define its attributes (property values).
Activities enable you to perform specific tasks within a BPEL process service
component. For example, here are several key activities:

= An assign activity enables you to manipulate data, such as copying the contents of
one variable to another. Figure 4-3 shows an assign activity.

Figure 4-3 Assign Activity

[t
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= Aninvoke activity enables you to invoke a service (identified by its partner link)
and specify an operation for this service to perform. Figure 4-4 shows an invoke
activity.

Figure 4-4 Invoke Activity

= A receive activity waits for an asynchronous callback response message from a
service. Figure 4-5 shows a receive activity.

Figure 4-5 Receive Activity

8

Figure 4-6 shows an example of a property window (for this example, an invoke
activity). In this example, you invoke a partner link named StoreFrontService and
define its attributes.

Figure 4-6 Invoke Activity Example
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The invoke activity enables you to specify an operation you want to invoke for the
service (identified by its partner link). The operation can be one-way or
request-response on a port provided by the service. You can also automatically create
variables in an invoke activity. An invoke activity invokes a synchronous service or
initiates an asynchronous web service.

The invoke activity opens a port in the process to send and receive data. It uses this
port to submit required data and receive a response. For synchronous callbacks, only
one port is needed for both the send and the receive functions.
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For more information about activities, see Appendix A, "BPEL Process Activities and
Services."

4.3 Introduction to Partner Links

A partner link enables you to define the external services with which the BPEL process
service component is to interact. You can define partner links as services or references
(for example, through a JCA adapter) in the SOA Composite Editor or within a BPEL
process service component in Oracle BPEL Designer. Figure 4-7 shows the partner link
icon (in this example, named CreditCard AuthorizationService).

Figure 4-7 PartnerLink Icon

|

CreditCardfothari,

A partner link type characterizes the conversational relationship between two services
by defining the roles played by each service in the conversation and specifying the
port type provided by each service to receive messages within the conversation.

Figure 4-8 shows an example of the attributes of a partner link for a service.

Figure 4-8 Partner Link Dialog
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Table 4-3 describes the fields of this dialog.

Table 4-3 Create Partner Link Dialog Fields

Field Description

Name A unique and recognizable name you provide for the partner link.
Process Displays the BPEL process service component name.

WSDL URL The name and location of the WSDL file that you select for the partner

link. Click the SOA Service Explorer icon (second icon from the left
above the WSDL URL field) to access a window for selecting the
WSDL file to use.

Partner Link Type The partner link defined in the WSDL file.
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Table 4-3 (Cont.) Create Partner Link Dialog Fields

Field Description
Partner Role The role performed by the partner link.
My Role The role performed by the BPEL process service component. In this

case, the BPEL process service component does not have a role because
it is a synchronous process.

Note: The Partner Link Type, Partner Role, and My Role fields in
the Create Partner Link dialog are defined and required by the BPEL
standard.

Best Practice: As a best practice, always create and wire Oracle
mediator and BPEL process service components in the SOA
Composite Editor, instead of in Oracle BPEL Designer.

If you add an Oracle mediator or BPEL process partner link to your
BPEL process in Oracle BPEL Designer and connect either partner link
to your BPEL process through an invoke activity, the wiring is not
automatically reflected above in the SOA Composite Editor. You must
explicitly wire the Oracle mediator or BPEL process service
component to your BPEL process again in the SOA Composite Editor.

Note that this is not an issue with human task or business rule partner
links in Oracle BPEL Designer; both are also automatically wired in
the SOA Composite Editor.

4.4 Creating a Partner Link

The method by which you create partner links within the BPEL process in Oracle BPEL
Designer impacts how the partner link displays above in the SOA Composite Editor.
This section describes this impact. The WSDL file can be on the local operating system
or hosted remotely (in which case you need a URL for the WSDL).

Likewise, creating and wiring a service or reference binding component to a BPEL
process service component in the SOA Composite Editor causes a partner link to
display in Oracle BPEL Designer.

4.4.1 How to Create a Partner Link

To create a partner link:
1. In the SOA Composite Editor, double-click the BPEL process service component.

Oracle BPEL Designer is displayed.
2. In the Component Palette, expand BPEL Services.

3. Drag a Partner Link into the appropriate Partner Links swimlane, as shown in
Figure 4-9.
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Figure 4-9 Partner Link Creation in Oracle BPEL Designer
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The Create Partner Link dialog appears.
4. Complete the fields for this dialog, as described in Table 4-3.

The following sections describe the impact of partner link creation on the SOA

Composite Editor.

4.4.1.1 Partner Links for an Outbound Adapter
Table 44 describes the impact on the SOA Composite Editor.

Table 4-4 Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in

Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A partner link for an outbound adapter

= Areference handle for the BPEL service component

= A reference representing the outbound adapter in the
composite

= A wire connecting the BPEL service component to the
adapter reference

Figure 4-10 shows how this method of creation appears in the SOA Composite Editor.

Figure 4-10 SOA Composite Editor Impact
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4.4.1.2 Partner Links for an Inbound Adapter
Table 4-5 describes the impact on the SOA Composite Editor.
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Table 4-5

Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in
Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A partner link for an inbound adapter

= A service for the BPEL service component

= A service representing the inbound adapter in the
composite

= A wire connecting the inbound adapter service to the
BPEL service component

Figure 4-11 shows how this method of creation appears in the SOA Composite Editor.

Figure 4-11 SOA Composite Editor Impact
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4.4.1.3 Partner Links from an Abstract WSDL to Call a Service
Table 4-6 describes the impact on the SOA Composite Editor.

Table 4-6

Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in
Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A partner link from an abstract WSDL to call a
service

A reference handle with an interface and callback interface
defined for the BPEL service component

4.4.1.4 Partner Links from an Abstract WSDL to Implement a Service
Table 4-7 describes the impact on the SOA Composite Editor.

Table 4-7

Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in
Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A partner link is created from an abstract WSDL to
implement a service

A service with an interface and callback interface for the
BPEL service component is created.

Note: If an external Simple Object Access Protocol (SOAP)
reference with the specified interface and callback interface
exists in the SOA Composite Editor, you can either create a
new external SOAP reference and wire to it or wire to the
existing external SOAP reference.

Figure 4-12 shows how this method of creation appears in the SOA Composite Editor.

Figure 4-12 SOA Composite Editor Impact
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4.4.1.5 Partner Links and Human Tasks or Business Rules
Table 4-8 describes the impact on the SOA Composite Editor.
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Table 4-8

Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in
Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A human task or business rule is created

A human task or business rule in the composite
A reference for the BPEL service component

A wire connecting the BPEL service component to the
new human task or business rule

Figure 4-13 shows how this method of creation appears in the SOA Composite Editor.

Figure 4-13 SOA Composite Editor Impact
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4.4.1.6 Partner Links from an Existing Human Task, Business Rule, or Oracle

Mediator

Table 4-9 describes the impact on the SOA Composite Editor.

Table 4-9

Impact of Partner Link Creation on the SOA Composite Editor

Creating the Following for a BPEL Process in
Oracle BPEL Designer...

Displays the Following in the SOA Composite Editor...

A partner link by dragging an existing human task,
business rule, or mediator service component from
the Resource Palette to the BPEL process

A reference for the BPEL service component

A wire connecting the BPEL service component to the
existing human task, business rule, or mediator

Figure 4-14 shows how this method of creation appears in the SOA Composite Editor.

Figure 4-14 SOA Composite Editor Impact
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4.5 Introduction to Technology Adapters

The Partner Link dialog shown in Figure 4-8 also enables you to take advantage of
another key feature that Oracle BPEL Process Manager and Oracle JDeveloper provide.
Click the Define Service icon shown in Figure 4-15 to access the Adapter

Configuration wizard.

Figure 4-15 Defining an Adapter
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Q@ @

WaDL URL:

B 1/ 0eveloper fmywarkjRulesRUs/ Crediafing gervice

Getting Started with Oracle BPEL Process Manager

4-11



Introduction to Technology Adapters

Adapters enable you to integrate the BPEL process service component (and, therefore,
the SOA composite application as a whole) with access to file systems, FIP servers,
database tables, database queues, sockets, Java Message Services (JMS), MQ, and
Oracle E-Business Suite. This wizard enables you to configure the types of adapters
shown in Figure 4-16 for use with the BPEL process service component:

Figure 4-16 Adapter Types

-3 Configure Service or Adapter. ﬁ

& aDF-BC Service

4 BAM Adapter

{ﬁ Database Adapker
% Direct Binding

{% EJE Service

4§ FTP Adapter

{E File Adapter
[l HTTE Rinding

| Help | | a4 || Cancel

The following adapter types are available:
= Advanced Queuing (AQ)

For interaction with a queue. AQ provides a flexible mechanism for bidirectional,
asynchronous communication between participating applications.

s Oracle Business Activity Monitoring (BAM)
For publishing data to data objects in an Oracle BAM Server.
= Database

For interaction with Oracle and non-Oracle databases through JDBC and Oracle
Business Intelligence (which is a special data source type).

s FIP and File

For file exchange (read and write) on local file systems and remote file systems
(through use of the file transfer protocol (FIP)).

Note: When calling the file adapter, Oracle BPEL Process Manager
may process the same file twice when run against Oracle Real
Application Clusters planned outages. This is because a file adapter is
a non-XA compliant adapter. Therefore, when it participates in a
global transaction, it may not follow the XA interface specification of
processing each file only once.

= Java Messaging Service (JMS)

For interaction with JMS. The JMS architecture uses a one client interface to many
messaging servers architecture.

s Message Queue (MQ)
For message exchange with WebSphere MQ queuing systems.
= Oracle Applications

For interaction with Oracle Application’s set of integrated business applications.

4-12 Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite



Introduction to BPEL Process Monitors

s Oracle B2B

s For browsing B2B metadata in the metadata service (MDS) repository and
selecting document definitions.

s Sockets

For modeling standard or nonstandard protocols for communication over TCP/IP
sockets.

When you select an adapter type, the Service Name window shown in Figure 4-17
prompts you to enter a name. For this example, File Adapter was selected in

Figure 4-16. When the wizard completes, a WSDL file by this service name appears in
the Application Navigator for the BPEL process service component (for this example,
named ReadFile.wsdl). The service name must be unique within the project. This file
includes the adapter configuration settings you specify with this wizard. Other
configuration files (such as header files and files specific to the adapter) are also
created and display in the Application Navigator.

Figure 4-17 Adapter Service Name

-3 Adapter, Configuration Wizard - Step Z of 4

Service Name

Enter a Service Mame,

Service Type: File Adapter

Service Name: |ReadFiIe|

Help | < Back | Next = Cancel |

The Adapter Configuration wizard windows that appear after the Service Name
window are based on the adapter type you selected.

You can also add adapters to your SOA composite application as services or references
in the SOA Composite Editor.

For more information about technology adapters, see Oracle Fusion Middleware User’s
Guide for Technology Adapters.

4.6 Introduction to BPEL Process Monitors

You can configure BPEL process monitors in Oracle BPEL Designer by selecting
Monitor at the top of Oracle BPEL Designer. Figure 4-18 provides details. BPEL
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process monitors can send data to Oracle BAM for analysis and graphical display
through the Oracle BAM adapter.

Figure 4-18 BPEL Process Monitors
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= O Change to Monikor view

For more information, see Section 50.3, "Using Oracle BAM Monitor Express With
BPEL Processes."

4.7 Migrating Custom SOA Composite Applications in Oracle JDeveloper

When you open Oracle JDeveloper for the first time, you are prompted to migrate
existing applications. If you click Yes to migrate custom SOA composite applications
to the current release, you must change the metadata namespace and store ID. Not
performing these actions causes migration compilation to fail.

4.7.1 How to Migrate a Custom SOA Composite Application

1. Open the ads-config.xml file.

2. Update the metadata-namespaces and metadata-store-usage information
shown in Example 4-1.

Example 4-1 Metadata Namespace and Store ID

<metadata-namespaces>
<namespace metadata-store-usage="soa-shared-usage" path="/soa/shared"/>
</metadata-namespaces>
<metadata-store-usages>
<metadata-store-usage id="soa-shared-usage">
<metadata-store
class-name="oracle.mds.persistence.stores.file.FileMetadataStore">
<property value="${oracle.home}/integration"
name="metadata-path"/>
<property value="seed" name="partition-name"/>
</metadata-store>
</metadata-store-usage>
</metadata-store-usages>
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Introduction to Interaction Patterns in a
BPEL Process

This chapter describes common interaction patterns between a BPEL process service
component and an external service, and shows the best use practices for each.

This chapter includes the following sections:

m  Section 5.1, "Introduction to One-Way Messages"

m  Section 5.2, "Introduction to Synchronous Interactions"

= Section 5.3, "Introduction to Asynchronous Interactions"

= Section 5.4, "Introduction to Asynchronous Interactions with a Timeout"

= Section 5.5, "Introduction to Asynchronous Interactions with a Notification Timer"
= Section 5.6, "Introduction to One Request, Multiple Responses"

= Section 5.7, "Introduction to One Request, One of Two Possible Responses”

= Section 5.8, "Introduction to One Request, a Mandatory Response, and an Optional
Response"

= Section 5.9, "Introduction to Partial Processing"

= Section 5.10, "Introduction to Multiple Application Interactions"

5.1 Introduction to One-Way Messages

In a one-way message, or fire and forget, the client sends a message to the service (d1
in Figure 5-1), and the service is not required to reply. The client sending the message
does not wait for a response, but continues executing immediately. Example 5-1 shows
the portType and operation part of the BPEL process WSDL file for this
environment.

Example 5-1 One-Way WSDL File

<wsdl :portType name="BPELProcessl">
<wsdl:operation name="process">
<wsdl:input message="client:BPELProcesslRequestMessage" />
</wsdl:operation>
</wsdl:portType>

Figure 5-1 provides an overview.
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Figure 5-1 One-Way Message

Client BPEL Process Service BPEL Process
WSDL

PartnerLink
<invoke> — <receive>

BPEL Process Service Component as the Client

As the client, the BPEL process service component needs a valid partner link and an
invoke activity with the target service and the message. As with all partner activities,
the Web Services Description Language (WSDL) file defines the interaction.

BPEL Process Service Component as the Service

To accept a message from the client, the BPEL process service component needs a
receive activity.

5.2 Introduction to Synchronous Interactions

In a synchronous interaction, a client sends a request to a service (d1 in Figure 5-2),
and receives an immediate reply (d2 in Figure 5-2). A BPEL process service
component can be at either end of this interaction, and must be coded based on its role
as either the client or the service. For example, a user requests a subscription to an
online newspaper and immediately receives email confirmation that their request has
been accepted. Example 5-2 shows the portType and operation part of the BPEL
process WSDL file for this environment.

Example 5-2 Synchronous WSDL File

<wsdl:portType name="BPELProcessl">
<wsdl:operation name="process">
<wsdl:input message="client:BPELProcesslRequestMessage" />
<wsdl:output message="client:BPELProcesslResponseMessage"/>
</wsdl:operation>
</wsdl:portType>

Figure 5-2 provides an overview.
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Figure 5-2 Synchronous Interaction
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of a synchronous
transaction, it needs an invoke activity. The port on the client side both sends the
request and receives the reply. As with all partner activities, the WSDL file defines the
interaction.

BPEL Process Service Component as the Service

When the BPEL process service component is on the service side of a synchronous
transaction, it needs a receive activity to accept the incoming request, and a reply
activity to return either the requested information or an error message (a fault; f1 in
Figure 5-2) defined in the WSDL.

For more information about synchronous interactions, see Chapter 7, "Invoking a
Synchronous Web Service from a BPEL Process."

5.3 Introduction to Asynchronous Interactions

In an asynchronous interaction, a client sends a request to a service and waits until the
service replies. Example 5-3 shows the portType and operation part of the BPEL
process WSDL file for this environment.

Example 5-3 Asynchronous WSDL File

<wsdl:portType name="BPELProcessl">
<wsdl:operation name="process">
<wsdl:input message="client:BPELProcesslRequestMessage"/>
</wsdl:operation>
</wsdl:portType>

<wsdl:portType name="BPELProcesslCallback">
<wsdl:operation name="processResponse">
<wsdl:input message="client:BPELProcesslResponseMessage" />
</wsdl:operation>
</wsdl:portType>
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Figure 5-3 provides an overview.

Figure 5-3 Asynchronous Interaction

Client BPEL Process Service BPEL Process
WSDL
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<receive>

BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of an asynchronous
transaction, it needs an invoke activity to send the request and a receive activity to
receive the reply. As with all partner activities, the WSDL file defines the interaction.

BPEL Process Service Component as the Service

As with a synchronous transaction, when the BPEL process service component is on
the service side of an asynchronous transaction, it needs a receive activity to accept the
incoming request and an invoke activity to return either the requested information or a
fault. Note the difference between this and responding from a synchronous BPEL
process: a synchronous BPEL process uses a reply activity to respond to the client and
an asynchronous service uses an invoke activity.

For more information about asynchronous interactions, see Chapter 8, "Invoking an
Asynchronous Web Service from a BPEL Process."

5.4 Introduction to Asynchronous Interactions with a Timeout

In an asynchronous interaction with a timeout (which you perform in BPEL with a
pick activity), a client sends a request to a service and waits until it receives a reply, or
until a certain time limit is reached, whichever comes first. For example, a client
requests a loan offer. If the client does not receive a loan offer reply within a specified
amount of time, the request is canceled. Figure 54 provides an overview.
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Figure 5-4 Asynchronous Interaction with Timeout
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of an asynchronous
transaction with a timeout, it needs an invoke activity to send the request and a pick
activity with two branches: an onMessage branch and an onAlarm branch. If the reply
comes after the time limit has expired, the message goes to the dead letter queue. As
with all partner activities, the WSDL file defines the interaction.

For more information about asynchronous interactions with a timeout, see
Section 14.2, "Creating a Pick Activity to Select Between Continuing a Process or
Waiting."

BPEL Process Service Component as the Service

The behavior of the BPEL process service component as a service matches the behavior
with the asynchronous interaction with the BPEL process service component as the
service.

5.5 Introduction to Asynchronous Interactions with a Notification Timer

In an asynchronous interaction with a notification time, a client sends a request to a
service and waits for a reply, although a notification is sent after a timer expires. The
client continues to wait for the reply from the service even after the timer has expired.
Figure 5-5 provides an overview.
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Figure 5-5 Asynchronous Interaction with a Notification Time
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of this transaction, it
needs a scope activity containing an invoke activity to send the request, and a receive
activity to accept the reply. The onAlarm handler of the scope activity has a time limit
and instructions on what to do when the timer expires. For example, wait 30 minutes,
then send a warning indicating that the process is taking longer than expected. As
with all partner activities, the WSDL file defines the interaction.

BPEL Process Service Component as the Service

The behavior for the BPEL process service component as the service matches the
behavior with the asynchronous interaction with the BPEL process service component
as the service.

5.6 Introduction to One Request, Multiple Responses

In this interaction type, the client sends a single request to a service and receives
multiple responses in return. For example, the request can be to order a product
online, and the first response can be the estimated delivery time, the second response a
payment confirmation, and the third response a notification that the product has
shipped. In this example, the number and types of responses are expected. Figure 5-6
provides an overview.
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Figure 5-6 One Request, Multiple Responses
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of this transaction, it
needs an invoke activity to send the request, and a sequence activity with three receive
activities, one for each reply. As with all partner activities, the WSDL file defines the
interaction.

BPEL Process Service Component as the Service

The BPEL service needs a receive activity to accept the message from the client, and a
sequence attribute with three invoke activities, one for each reply.

5.7 Introduction to One Request, One of Two Possible Responses

In an interaction using one request and one of two possible responses, the client sends
a single request to a service and receives one of two possible responses. For example,
the request can be to order a product online, and the first response can be either an
in-stock message, or an out-of-stock message. Figure 5-7 provides an overview.
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Figure 5-7 One Request, One of Two Possible Responses
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of this transaction, it
needs the following:

= Aninvoke activity to send the request

= A pick activity with two branches: one onMessage for the in-stock response and
instructions on what to do if an in-stock message is received

= A second onMessage for the out-of-stock response and instructions on what to do
if an out-of-stock message is received

As with all partner activities, the WSDL file defines the interaction.

For more information about interactions using one request and one of two possible
responses, see Section 14.2, "Creating a Pick Activity to Select Between Continuing a
Process or Waiting."

BPEL Process Service Component as the Service

The BPEL service needs a receive activity to accept the message from the client, and a
switch activity with two branches, one with an invoke activity sending the in-stock
message if the item is available, and a second branch with an invoke activity sending
the out-of-stock message if the item is not available.

5.8 Introduction to One Request, a Mandatory Response, and an Optional

Response

In this type of interaction, the client sends a single request to a service and receives one
or two responses. Here, the request is to order a product online. If the product is
delayed, the service sends a message letting the customer know. In any case, the
service always sends a notification when the item ships. Figure 5-8 provides an
overview.
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Figure 5-8 One Request, a Mandatory Response, and an Optional Response
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BPEL Process Service Component as the Client

When the BPEL process service component is on the client side of this transaction, it
needs a scope activity containing the invoke activity to send the request, and a receive
activity to accept the mandatory reply. The onMessage handler of the scope activity is
set to accept the optional message and instructions on what to do if the optional
message is received (for example, notify you that the product has been delayed). The
client BPEL process service component waits to receive the mandatory reply. If the
mandatory reply is received first, the BPEL process service component continues
without waiting for the optional reply. As with all partner activities, the WSDL file
defines the interaction.

BPEL Process Service Component as the Service

The BPEL service needs a scope activity containing the receive activity and an invoke
activity to send the mandatory shipping message, and the scope’s onAlarm handler to
send the optional delayed message if a timer expires (for example, send the delayed
message if the item is not shipped in 24 hours).

5.9 Introduction to Partial Processing

In partial processing, the client sends a request to a service and receives an immediate
response, but processing continues on the service side. For example, the client sends a
request to purchase a vacation package, and the service sends an immediate reply

confirming the purchase, then continues on to book the hotel, the flight, the rental car,
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and so on. This pattern can also include multiple shot callbacks, followed by
longer-term processing. Figure 5-9 provides an overview.

Figure 5-9 Partial Processing
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BPEL Process Service Component as the Client

In this case, the BPEL client is simple; it needs an invoke activity for each request and a
receive activity for each reply for asynchronous transactions, or just an invoke activity
for each synchronous transaction. Once those transactions are complete, the remaining
work is handled by the service. As with all partner activities, the WSDL file defines the
interaction.

BPEL Process Service Component as the Service

The BPEL service needs a receive activity for each request from the client, and an
invoke activity for each response. Once the responses are finished, the BPEL process
service component as the service can continue with its processing, using the
information gathered in the interaction to perform the necessary tasks without any
further input from the client.

5.10 Introduction to Multiple Application Interactions

In some cases, there are more than two applications involved in a transaction, for
example, a buyer, seller, and shipper. In this case, the buyer sends a request to the
seller, the seller sends a request to the shipper, and the shipper sends a notification to
the buyer. This A-to-B-to-C-to-A transaction pattern can handle many transactions at
the same time. Therefore, a mechanism is required for keeping track of which message
goes where. Figure 5-10 provides an overview.

As with all partner activities, the WSDL file defines the interaction.
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Figure 5-10 Multiple Party Interactions
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This kind of coordination can be managed using WS-Addressing or correlation sets.
For more information about both, see Chapter 8, "Invoking an Asynchronous Web
Service from a BPEL Process."
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Manipulating XML Data in a BPEL Process

This chapter describes how to manipulate XML data in a BPEL process service
component. This chapter provides a variety of examples. Topics include how to work
with variables, sequences, and arrays, how to use XPath expressions, and how to
perform tasks such as mathematical calculations. The explanations are largely by
example, and provide an introduction to the supported specifications.

This chapter includes the following sections:

»  Section 6.1, "Introduction to Manipulating XML Data in BPEL Processes"

= Section 6.2, "Delegating XML Data Operations to Data Provider Services"

= Section 6.3, "Using Standalone SDO-based Variables"

= Section 6.4, "Initializing a Variable with Expression Constants or Literal XML"
= Section 6.5, "Copying Between Variables"

»  Section 6.6, "Accessing Fields Within Element-Based and Message Type-Based
Variables"

= Section 6.7, "Assigning Numeric Values"

= Section 6.8, "Using Mathematical Calculations with XPath Standards"
= Section 6.9, "Assigning String Literals"

= Section 6.10, "Concatenating Strings"

= Section 6.11, "Assigning Boolean Values"

= Section 6.12, "Assigning a Date or Time"

= Section 6.13, "Manipulating Attributes"

= Section 6.14, "Manipulating XML Data with bpelx Extensions"

= Section 6.15, "Validating XML Data with bpelx:validate"

= Section 6.16, "Manipulating XML Data Sequences That Resemble Arrays"
»  Section 6.17, "Converting from a String to an XML Element"

= Section 6.18, "Understanding the Differences Between Document-Style and
RPC-Style WSDL Files"

= Section 6.19, "Manipulating SOAP Headers in BPEL"
= Section 6.20, "Using MIME/DIME SOAP Attachments"
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Note: Most of the examples in this chapter assume that the WSDL
file defining the associated message types is document-literal style
rather than the RPC style. There is a difference in how XPath query
strings are formed for RPC-style WSDL definitions. If you are working
with a type defined in an RPC WSDL file, see Section 6.18,
"Understanding the Differences Between Document-Style and
RPC-Style WSDL Files."

6.1 Introduction to Manipulating XML Data in BPEL Processes

This section provides an introduction to using XML data in BPEL processes.

6.1.1 XML Data in BPEL

In a BPEL process service component, most pieces of data are in XML format. This
includes the messages passed to and from the BPEL process service component, the
messages exchanged with external services, and local variables used by the process.
You define the types for these messages and variables with the XML schema, usually
in the Web Services Description Language (WSDL) file for the flow, the WSDL files for
the services it invokes, or the XSD file referenced by those WSDL files. Therefore, most
variables in BPEL are XML data, and any BPEL process service component uses much
of its code to manipulate these XML variables. This typically includes performing data
transformation between representations required for different services, and local
manipulation of data (for example, to combine the results from several service
invocations).

BPEL also supports service data object (SDO) variables, which are not in an XML
format, but rather in a memory structure format.

6.1.2 Data Manipulation and XPath Standards

The starting point for data manipulation in BPEL is the assign activity, which builds on
the XPath standard. XPath queries, expressions, and functions play a large part in this
type of manipulation. In addition, more advanced methods are available that involve
using XQuery, XSLT, or Java, usually to do more complex data transformation or
manipulation.

This section provides a general overview of how to manipulate XML data in BPEL. It
summarizes the key building blocks used in various combinations and provides
examples. The remaining sections in this chapter discuss and illustrate how to apply
these building blocks to perform specific tasks.

You use the assign activity to copy data from one XML variable to another, or to
calculate the value of an expression and store it in a variable. A copy element within
the activity specifies the source and target of the assignment (what to copy from and
to), which must be of compatible types. Example 6-1 shows the formal syntax, as
described in the Business Process Execution Language for Web Services Specification:

Example 6-1 Assign Activity

<assign standard-attributes>
standard-elements
<copy>
from-spec
to-spec
</copy>
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</assign>

This syntax is described in detail in that specification. The £rom-spec and to-spec
typically specify a variable or variable part, as shown in Example 6-2:

Example 6—2 from-spec and to-spec Attributes
<assign>
<copy>
<from variable="cl" part="address"/>
<to variable="c3"/>
</copy>
</assign>

When you use Oracle JDeveloper, you supply assign activity details in a Copy
Operation dialog that includes a From section and a To section. This reflects the
preceding BPEL source code syntax.

XPath standards play a key role in the assign activity. Brief examples are shown here
as an introduction; examples with more context and explanation are provided in the
sections that follow.

»  XPath queries

An XPath query selects a field within a source or target variable part. The from or
to clause can include a query attribute whose value is an XPath query string.
Example 6-3 provides an example:

Example 6-3 query Attribute

<from variable="input" part="payload"
query="/p:CreditFlowRequest/p:ssn"/>

The value of the query attribute must be a location path that selects exactly one
node. You can find further details about the query attribute and XPath standards
syntax in the Business Process Execution Language for Web Services Specification
(section 14.3) and the XML Path Language (XPath) Specification, respectively.

= XPath expressions

You use an XPath expression (specified in an expression attribute in the £rom
clause) to indicate a value to be stored in a variable. For example:

<from expression="100"/>

The expression can be any general expression (that is, an XPath expression that
evaluates to any XPath value type). Similarly, the value of an expression attribute
must return exactly one node or one object only when it is used in the £rom clause

within a copy operation. For more information about XPath expressions, see
section 9.1.4 of the XML Path Language (XPath) Specification.

Within XPath expressions, you can call the following types of functions:
s Core XPath functions

XPath supports a large number of built-in functions, including functions for string
manipulation (such as concat), numeric functions (like sum), and others.

<from expression="concat ('string one', 'string two')"/>

For a complete list of the functions built into XPath standards, see section 4 of the
XML Path Language (XPath) Specification.

Manipulating XML Data in a BPEL Process 6-3



Delegating XML Data Operations to Data Provider Services

s BPEL XPath extension functions

BPEL adds several extension functions to the core XPath core functions, enabling
XPath expressions to access information from a process. The extensions are
defined in the standard BPEL namespace
http://schemas.xmlsoap.org/ws/2003/03/business-process/ and
indicated by the prefix bpws:

<from expression= "bpws:getVariableData('input', 'payload',6 '/p:value') + 1"/>

For more information, see sections 9.1 and 14.1 of the Business Process Execution
Language for Web Services Specification.

s Oracle BPEL XPath extension functions

Oracle provides some additional XPath functions that use the capabilities built
into BPEL and XPath standards for adding new functions.

These functions are defined in the namespace
http://schemas.oracle.com/xpath/extension and indicated by the
prefix ora:.

s Custom functions

Oracle BPEL Process Manager functions are defined in the
bpel-xpath-functions-config.xml and placed inside the orabpel.jar
file. For more information, see Section B.7, "Creating User-Defined XPath
Extension Functions" and Oracle Fusion Middleware Administrator’s Guide for Oracle
SOA Suite and Oracle BPM Suite.

Sophisticated data manipulation can be difficult to perform with the BPEL assign
activity and the core XPath functions. However, you can perform complex data
manipulation and transformation by using XSLT, Java, or a bpelx operation under an
assign activity (See Section 6.14, "Manipulating XML Data with bpelx Extensions"), or
as a web service. For XSLT, Oracle BPEL Process Manager includes XPath functions
that execute these transformations.

For more information about XPath and XQuery transformation code examples, see
Chapter 38, "Creating Transformations with the XSLT Mapper."

Note: Passing large schemas through an assign activity can cause
Oracle JDeveloper to freeze up and run low on memory if you
right-click the payload in the From or To section of the Copy
Operation dialog and select Expand All. As a workaround, manually
expand the payload elements.

6.2 Delegating XML Data Operations to Data Provider Services

You can specify BPEL data operations to be performed by an underlying data provider
service through use of the entity variable. The data provider service performs the data
operations in a data store behind the scenes and without use of other data store-related
features provided by Oracle SOA Suite (for example, the database adapter). This action
enhances Oracle SOA Suite runtime performance and incorporates native features of
the underlying data provider service during compilation and runtime.

For this release, the entity variable can be used with an Oracle Application
Development Framework (ADF) Business Component data provider service using
SDO-based data.
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In previous releases, variables and messages exchanged within a BPEL business
process were disconnected payload (a snapshot of data returned by a web service)
placed into an XML structure. In some cases, the user required this type of fit. In other
cases, this fit presented challenges.

The entity variable addresses the following challenges of previous releases:
= Extensive data conversion

If the underlying data was not in XML form, data conversion (for example,
translating delimited text to XML) was required. If the underlying size of the data
was large, the processing potentially impacted performance.

= Stale snapshot data

Variables (including WSDL messages) in BPEL processes were disconnected
payload. In some cases, this was required. In other cases, you wanted a variable to
represent the most recent data being modified by other applications outside Oracle
BPEL Process Manager. This meant the disconnected data model provided a stale
data set that did not fit all needs. The snapshot also duplicated data, which
impacted performance when the data size was large.

s Loss of native data behavior

Some data conversion implementation required data structure enforcement or
business data logic beyond the XML schema. For example, the start date needed to
be smaller than the end date. When the variable was a disconnected payload,
validation occurred only during related web service invocation. Optionally
performing the extra business data logic after certain operations, but before web
service invocation, was sometimes preferred.

To address these challenges with this release, you create an entity variable during
variable declaration. An entity variable acts as a data handle to access and plug in
different data provider service technologies behind the scenes. During compilation
and runtime, Oracle BPEL Process Manager delegates data operations to the
underlying data provider service.

Table 6-1 provides an example of how data conversion was performed in previous
releases (using the database adapter as an example) and in release 11g with the entity
variable.

Table 6—1 Data Manipulation Capabilities in Previous and Current Releases

10.1.x Releases 11g Release When Using the Entity Variable

Data operations such as explicitly loading and Data operations such as loading and saving
saving data were performed by the database = data are performed automatically by the data
adapter in Oracle BPEL Process Manager. All  provider service (the Oracle ADF Business
data (for example, of a purchase order) was Component application), without asking you
saved in the database dehydration store. to code any service invocation.

Oracle BPEL Process Manager stores a key (for
example, purchase order ID (POID)) that
points to this data. Oracle BPEL Process
Manager fetches the key when access to data
is requested (the bind entity activity does this).
You must explicitly request the data to be
bound using the key. Any data changes are
persisted by the data provider service in a
database that can be different from the
dehydration store database. This prevents data
duplication.
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Table 6-1 (Cont.) Data Manipulation Capabilities in Previous and Current Releases

10.1.x Releases 11g Release When Using the Entity Variable
Data in variables was in document object Data in variables is in SDO form, which
model (DOM) form provides for a simpler conversion process than

DOM, especially when the data provider
service understands SDO forms.

Note: Only BPEL process service components currently allow the
use of SDO-formed variables. If your composite application has an
Oracle Mediator service component wired with an SDO-based Java
binding component reference, the data form of the variable defaults to
DOM. In addition, the features described for 10.1.x releases in

Table 6-1 are still supported in release 11g.

The WebLogic Fusion Order Demo application describes use of the entity variable.

6.2.1 How to Create an Entity Variable

This section describes how to create an entity variable and a binding key in Oracle
JDeveloper.

In previous releases of Oracle BPEL Process Manager, all variable data was in DOM
form. With release 11g, variable data in SDO form is also supported. DOM and SDO
variables in BPEL process service components are implicitly converted to the required
forms. For example, an Oracle BPEL process service component using DOM-based
variables can automatically convert these variables as required to SDO-based variables
in an assign activity, and vice versa. Both form types are defined in the XSD schema
file. No user intervention is required.

Entity variables also support SDO-formed data. However, unlike the DOM and SDO
variables, the entity variable with SDO-based data enables you to bind a unique key
value to data (for example, a purchase order). Only the key is stored in the
dehydration store; the data requiring conversion is stored with the service of the
Oracle ADF Business Component application. The key points to the data stored in the
service. When the data is required, it is fetched from the data provider service and
placed into memory. The process occurs in two places: the bind entity activity and the
dehydration store. For example, when Oracle BPEL Process Manager rehydrates, it
stores only the key for the entity variable; when it wakes up, it does an implicit bind to
get the current data.

6.2.1.1 Understanding How SDO Works in the Inbound Direction

The SDO binding component service provides the outside world with an entry point
to the composite application, as shown in Figure 6-1.
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Figure 6—1 Inbound Direction

SOA Composite Application

BPEL
Process Service
Component

ADF BC Application SDO
Using > Binding
SDO-Formed Component
Data Service

You use the SOA Composite Editor and Oracle BPEL Designer to perform the
following tasks:

= Define an SDO binding component service and a BPEL process service component
in the composite application.

= Connect (wire) the SDO service and BPEL process service component.
= Define the details of the BPEL process service component.

For more information about using the SOA Composite Editor, see Chapter 2,
"Developing SOA Composite Applications with Oracle SOA Suite."

6.2.1.2 Understanding How SDO Works in the Outbound Direction

The SDO binding component reference enables messages to be sent from the
composite application to Oracle ADF Business Component application external
partners in the outside world, as shown in Figure 6-2.

Figure 6—2 Outbound Direction

SOA Composite Application

BPEL
Process Service
Component
(using entity
variable)

= SDO Binding = | ADF BC Application
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| Reference SDO-Formed
L

! > Data
Pass key to
fetch data

When the Oracle ADF Business Component application is the external partner link to
the outside world, there is no SDO binding component reference in the SOA
Composite Editor that you drag into the composite application to create outbound
communication. Instead, communication between the composite application and the
Oracle ADF Business Component application occurs as follows:

s The Oracle ADF Business Component application is deployed and automatically
registered as an SDO service in the Service Infrastructure
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= Oracle JDeveloper is used to browse for and discover this application as an
ADE-BC service and create a partner link connection.

s The composite.xml file is automatically updated with reference details (the
binding.adf property) when the Oracle ADF Business Component application
service is discovered.

6.2.1.3 Creating an Entity Variable and Choosing a Partner Link

You now create an entity variable and select a partner link for the Oracle ADF Business
Component application. The following example describes how the OrderProcessor
BPEL process service component receives an ID for an order by using a bind entity
activity to point to order data in an Oracle ADF Business Component data provider
service in the WebLogic Fusion Order Demo application.

To create an entity variable and choose a partner link:

1. Go to the Structure window of the BPEL process service component in Oracle
JDeveloper.

2. Right-click the Variables folder and select Expand All Child Nodes.

3. In the second Variables folder, right-click and select Create Variable.
The Create Variable dialog appears.

4. In the Name field, enter a name.

5. Click the Entity Variable checkbox and select the Search icon to the right of the
Partner Link field.

The Partner Link Chooser dialog appears with a list of available services,
including the SDO service called ADF-BC Service.

6. Browse for and select the service for the Oracle ADF Business Component
application.

7. Click OK to close the Partner Link Chooser and Create Variable dialogs.
The Create Variable dialog looks as shown in Figure 6-3.

Figure 6-3 Create Variable Dialog

General |

Mame: |g0rder1nf0\n'ariable |
Tvpe
() Simple Type %
() Message Type %
(%) Element |{,|'0rac|e,l'Fodemo,l'storeFront,l'store,l'queries,l'com| Q

Entity Yariable

’7 |St0reFr0ntService | q

[]5D0 Capable

Help Apply | | [o]'8 | | Cancel
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6.2.1.4 Creating a Binding Key

You now create a key to point to the order data in the Oracle ADF Business
Component data provider service.

To create a binding key:
1. Drag a Bind Entity activity into your BPEL process service component.

The Bind Entity dialog appears.

2. In the Name field, enter a name.

3. To the right of the Entity Variable field, click the Search icon.
The Variable Chooser dialog appears.

4. Select the entity variable created in Section 6.2.1.3, "Creating an Entity Variable
and Choosing a Partner Link" and click OK.

5. Inthe Unique Keys section, click the Add icon.

The Specify Key dialog appears. You use this dialog to create a key for retrieving
the order ID from the Oracle ADF Business Component data provider service.

6. Enter the details described in Table 6-2 to define the binding key:

Table 6-2 Specify Key Dialog Fields and Values

Field Value

Key Local Part Enter the local part of the key.

Key Namespace URI Enter the namespace URI for the key.

Key Value Enter the key value expression. This expression must match the
type of a key. The following examples show expression value
keys for a POID key:

. SinputMsg.payload/tns:poid

s bpws:getVariableData (’inputmsg’, 'payload’, 'tns:
poid’)

The POID key for an entity variable typically comes from

another message. If the type of POID key is an integer and the

expression result is a string of ABC, the string-to-integer fails and
the bind entity activity also fails at runtime.

Figure 64 shows the Specify Key dialog after completion.

Figure 6—4 Specify Key Dialog
& Specify Key ﬁ|

Key OName
Key Local Part: |OrderId | x)

Key Mamespace URI: |,l'oracle,l'F0demo,l'storeFront,l’store,l’queries,l'common,l' |

Key Yalue: |bpws:getVariabIeData('input\-‘ariable','payload',',l'client:process,l’client:orderld') | e

| Help | | Ok || Cancel |

7. Click OK to close the Specify Key dialog.
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A name-pair value appears in the Unique Keys table, as shown in Figure 6-5.
Design is now complete.

Figure 6-5 Bind Entity Dialog

Bind Entity R

| General rSkip Condition

Mame: |find0rderById |
Entity Yariable: |g0rder1nf0\u'ariable | %
Unique Keys: EF / %

Key QMNarme YWalue Expressian

{foracleffodema)stor,.. bpws:getYariableDatalinputvariable', pavioad’,f..

| Help | | Apply || [a]4 || Cancel |

8. Click OK to close the Bind Entity dialog.

After the Bind Entity activity is executed at runtime, the entity variable is ready to
be used.

For more information about using SDOs, see Oracle Fusion Middleware Fusion
Developer’s Guide for Oracle Application Development Framework. This guide describes
how to expose application modules as web services and publish rows of view data
objects as SDOs. The application module is the ADF framework component that
encapsulates business logic as a set of related business functions.

6.3 Using Standalone SDO-based Variables

Standalone SDO-based variables are similar to ordinary BPEL XML-DOM-based
variables. The major difference is that the underlying data form is SDO-based, instead
of DOM-based. Therefore, SDO-based variables can use some SDO features such as
Java API access, an easier-to-use update API, and the change summary. However, SDO
usage is also subject to some restrictions that do not exist with XML-DOM-based
variables. The most noticeable restriction is that SDO only supports a small subset of
XPath expressions.

6.3.1 How to Declare SDO-based Variables

The syntax for declaring an SDO-based variable is similar to that for declaring BPEL
variables. Example 6—4 provides details.

Example 6-4 SDO-based Variable Declaration

<variable name="deptVar_s" element="hrtypes:dept" />
<variable name="deptVar_v" element="hrtypes:dept" bpelx:sdoCapable="false" />

If you want to override the automatic detection, use the
bpelx:sdoCapable="true|false" switch. For example, variable deptvar_v
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described in Example 6—4 is a regular DOM-based variable. Example 6—4 provides an
example of the schema.

Example 6-5 XSD Sample

<xsd:element name="dept" type="Dept"/>
<xsd:complexType name="Dept"
sdoJava:instanceClass="sdo.sample.service. types.Dept">
<xsd:annotation>
<xsd:appinfo source="Key"
xmlns="http://xmlns.oracle.com/bcdj/service/metadata/">
<key>
<attribute>Deptno</attribute>
</key>
<fetchMode>minimal</fetchMode>
</xsd:appinfo>
</xsd:annotation>
<xsd:sequence>
<xsd:element name="Deptno" type="xsd:integer" minOccurs="0"/>
<xsd:element name="Dname" type="xsd:string" minOccurs="0"
nillable="true"/>
<xsd:element name="Loc" type="xsd:string" minOccurs="0" nillable="true"/>
<xsd:element name="Emp" type="Emp" minOccurs="0" maxOccurs="unbounded"
nillable="true"/>
</xsd:sequence>
</xsd:complexType>

6.3.2 How to Convert from XML to SDO

Oracle BPEL Process Manager supports dual data forms: DOM and SDO. You can
interchange the usage of DOM-based and SDO-based variables within the same
business process, even within the same expression. The Oracle BPEL Process Manager
data framework automatically converts back and forth between DOM and SDO forms.

By using the entity variable XPath rewrite capabilities, Oracle BPEL Process Manager
enables some XPath features (for example, variable reference and function calls) that
the basic SDO specification does not support. However, there are other limitations on
the XPath used with SDO-based variables (for example, there is no support for and,
or, and not).

Example 6-6 provides a simple example of converting from XML to SDO.

Example 6-6 XML-to-SDO Conversion

<assign>
<copy>
<from>
<ns0:dept xmlns:nsO0="http://sdo.sample.service/types/"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<ns0:Deptno>10</ns0:Deptno>
<ns0:Dname>ACCOUNTING</ns0 :Dname>
<ns0:Loc>NEW YORK</ns0:Loc>
<ns0:Emp>
<ns0:Empno>7782</ns0 : Empno>
<ns0:Ename>CLARK</ns0 : Ename>
<ns0:Job>MANAGER< /ns0:Job>
<ns0:Mgr>7839</ns0:Mgr>
<ns0:Hiredate>1981-06-09</ns0:Hiredate>
<ns0:5al1>2450</ns0:Sal>
<ns0:Deptno>10</ns0:Deptno>
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</ns0:Emp>
<ns0: Emp>
<ns0:Empno>7839</ns0: Empno>
<ns0:Ename>KING</ns0: Ename>
<ns0:Job>PRESIDENT</ns0:Job>
<ns0:Hiredate>1981-11-17</ns0:Hiredate>
<ns0:5al>5000</ns0:Sal>
<ns0:Deptno>10</ns0:Deptno>
</ns0:Emp>
<ns0:Emp>
<ns0:Empno>7934</ns0 : Empno>
<ns0:Ename>MILLER</ns0: Ename>
<ns0:Job>CLERK</ns0:Job>
<ns0:Mgr>7782</ns0:Mgr>
<ns0:Hiredate>1982-01-23</ns0:Hiredate>
<ns0:5al1>1300</ns0:Sal>
<ns0:Deptno>10</ns0:Deptno>
</ns0:Emp>
</ns0:dept>
</from>
<to variable="deptVar_s" />
</copy>
</assign>

Example 6-7 provides an example of copying from an XPath expression of an SDO
variable to a DOM variable.

Example 6-7 Copy from an XPath Expression of an SDO Variable to a DOM Variable

<assign>
<!-- copy from an XPath expression of an SDO variable to DOM variable -->
<copy>
<from expression="$deptVar_s/hrtypes:Emp[2]" />
<to variable="empVar_v" />
</copy>
<!-- copy from an XPath expression of an DOM variable to SDO variable -->
<copy>
<from expression="$deptVar_v/hrtypes:Emp[2]" />
<to variable="empVar_s" />
</copy>
<!-- insert a DOM based data into an SDO variable -->

<bpelx:insertAfter>
<bpelx:from variable="empVar_v" />
<bpelx:to variable="deptVar_s" query="hrtypes:Emp" />
</bpelx:insertAfter>
<!-- insert a SDO based data into an SDO variable at particular location,
no XML conversion is needed -->
<bpelx:insertBefore>
<bpelx:from expression="$deptVar_s/hrtypes:Emp[hrtypes:Sal = 1300]" />
<bpelx:to variable="deptVar_s" query="hrtypes:Emp[6]" />
</bpelx:insertBefore>
</assign>

Example 6-8 provides an example of removing a portion of SDO data.

Example 6-8 SDO Data Removal

<assign>
<bpelx:remove>
<bpelx:target variable="deptVar_s" query="hrtypes:Emp[2]" />
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</bpelx:remove>
</assign>

Note: The bpelx:append operation is not supported for
SDO-based variables for the following reasons:

»  The <copy> operation on an SDO-based variable has smart
update capabilities (for example, you do not have to perform a
<bpelx:append> before the <copy> operation).

s The SDO data object is metadata driven and does not generally
support adding a new property arbitrarily.

6.4 Initializing a Variable with Expression Constants or Literal XML

It is often useful to assign literal XML to a variable in BPEL, for example, to initialize a
variable before copying dynamic data into a specific field within the XML data content
for the variable. This is also useful for testing purposes when you want to hard code
XML data values into the process.

6.4.1 How To Assign a Literal XML Element

Example 6-9 assigns a literal result element to the payload part of the output
variable:

Example 6-9 Literal Element Assignment

<assign>
<!-- copy from literal xml to the variable -->
<copy>
<from>
<result xmlns="http://samples.otn.com">
<name/>
<symbol/>
<price>12.3</price>
<quantity>0</quantity>
<approved/>
<message/>
</result>
</from>
<to variable="output" part="payload"/>
</copy>
</assign>

6.5 Copying Between Variables

When you copy between variables, you copy directly from one variable (or part) to
another variable of a compatible type, without needing to specify a particular field
within either variable. In other words, you do not need to specify an XPath query.

6.5.1 How to Copy Between Variables

Example 6-10 shows two assignments being performed, first copying between two
variables of the same type and then copying a variable part to another variable with
the same type as that part.

Manipulating XML Data in a BPEL Process 6-13



Accessing Fields Within Element-Based and Message Type-Based Variables

Example 6-10 Copying Between Variables

<assign>
<copy>
<from variable="cl"/>
<to variable="c2"/>
</copy>
<copy>
<from variable="cl" part = "address"/>
<to variable="c3"/>
</copy>
</assign>

The BPEL file defines the variables shown in Example 6-11:

Example 6-11 Variable Definition

<variable name="cl" messageType="x:person"/>
<variable name="c2" messageType="x:person"/>
<variable name="c3" element="y:address"/>

The WSDL file defines the person message type shown in Example 6-12:

Example 6-12 Message Type Definition

<message name="person" xmlns:x="http://tempuri.org/bpws/example">
<part name="full-name" type="xsd:string"/>
<part name="address" element="x:address"/>

</message>

For more information about this code example, see Section 9.3.2 of the Business Process
Execution Language for Web Services Specification.

6.6 Accessing Fields Within Element-Based and Message Type-Based

Variables

Given the types of definitions present in most WSDL and XSD files, you must go down
to the level of copying from or to a field within part of a variable based on the element
and message type. This in turn uses XML schema complex types. To perform this
action, you specify an XPath query in the from or to clause of the assign activity.

6.6.1 How to Access Fields Within Element-Based and Message Type-Based Variables

In Example 6-13, the ssn field is copied from the CreditFlow process’s input
message into the ssn field of the credit rating service’s input message.

Example 6-13 Field Copying Levels

<assign>
<copy>
<from variable="input" part="payload"
query="/tns:CreditFlowRequest/tns:ssn"/>
<to variable="crInput" part="payload" query="/tns:ssn"/>
</copy>
</assign>

Example 6-14 shows how the BPEL file defines message type-based variables involved
in this assignment:
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Example 6—14 BPEL File Definition - Message Type-Based Variables

<variable name="input" messageType="tns:CreditFlowRequestMessage" />
<variable name="crInput"
messageType="services:CreditRatingServiceRequestMessage" />

The crInput variable is used as an input message to a credit rating service. Its
message type, CreditFlowRequestMessage, is defined in the
CreditFlowService.wsdl file, as shown in Example 6-15:

Example 6-15 CreditFlowRequestMessage Definition

<message name="CreditFlowRequestMessage">
<part name="payload" element="tns:CreditFlowRequest"/>
</message>

CreditFlowRequest is defined with a field named ssn. The message type
CreditRatingServiceRequestMessage is defined in the
CreditRatingService.wsdl file, as shown in Example 6-16:

Example 6-16 CreditRatingServiceRequestlMessage Definition

<message name="CreditRatingServiceRequestMessage">
<part name="payload" element="tns:ssn"/>
</message>

A BPEL process can also use element-based variables. In Example 6-17, the autoloan
field is copied from the loan application process’s input message into the customer
field of a web service’s input message.

Example 6-17 Field Copying Levels

<assign>
<copy>
<from variable="input" part="payload"
query="/tns:invalidLoanApplication/autoloan:
application/autoloan:customer" />
<to variable="customer"/>
</copy>
</assign>

Example 6-18 shows how the BPEL file defines element-based variables involved in an
assignment:

Example 6-18 BPEL File Definition - Element-Based Variables

<variable name="customer" element="tns:customerProfile"/>

6.7 Assigning Numeric Values

You can assign numeric values in XPath expressions.

6.7.1 How to Assign Numeric Values

Example 6-19 shows how to assign an XPath expression with the integer value of 100.
Example 6-19 XPath Expression Assignment

<assign>
<!-- copy from integer expression to the variable -->
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<copy>
<from expression="100"/>
<to variable="output" part="payload" query="/p:result/p:quantity"/>
</copy>
</assign>

6.8 Using Mathematical Calculations with XPath Standards

You can use simple mathematical expressions like the one in Section 6.8.1, "How To
Use Mathematical Calculations with XPath Standards," which increment a numeric
value.

6.8.1 How To Use Mathematical Calculations with XPath Standards

In Example 6-20, the BPEL XPath function getVariableData retrieves the value
being incremented. The arguments to getVariableData are equivalent to the
variable, part, and query attributes of the £rom clause (including the last two
arguments, which are optional).

Example 6-20 XPath Function getVariableData Retrieval of a Value

<assign>
<copy>
<from expression="bpws:getVariableData('input', 'payload',
'/p:value') + 1"/>
<to variable="output" part="payload" query="/p:result"/>
</copy>
</assign>

You can also use $variable syntax, as shown in Example 6-21:

Example 6-21 $variable Syntax Use

<assign>
<copy>
<from expression="S$input.payload + 1"/>
<to variable="output" part="payload" query="/p:result"/>
</copy>
</assign>

6.9 Assigning String Literals

You can assign string literals to a variable in BPEL.

6.9.1 How to Assign String Literals

The code in Example 6-22 copies an expression evaluating from the string literal ' GE"
to the symbol field within the indicated variable part. (Note the use of the double and
single quotes.)

Example 6-22 Expression Copy

<assign>
<!-- copy from string expression to the variable -->
<copy>
<from expression="'GE'"/>
<to variable="output" part="payload" query="/p:result/p:symbol"/>
</copy>
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</assign>

6.10 Concatenating Strings

Rather than copying the value of one string variable (or variable part or field) to
another, you can first perform string manipulation, such as concatenating several
strings.

6.10.1 How to Concatenate Strings

The concatenation is accomplished with the core XPath function named concat;in
addition, the variable value involved in the concatenation is retrieved with the BPEL
XPath function getVariableData. In Example 6-23, getVariableData fetches the
value of the name field from the input variable’s payload part. The string literal
'Hello ' is then concatenated to the beginning of this value.

Example 6-23 XPath Function getVariableData Fetch of Data

<assign>
<!-- copy from XPath expression to the variable -->
<copy>
<from expression="concat ('Hello ',
bpws:getVariableData('input', 'payload', '/p:name'))"/>
<to variable="output" part="payload" query="/p:result/p:message"/>
</copy>
</assign>

Other string manipulation functions available in XPath are listed in section 4.2 of the
XML Path Language (XPath) Specification.

6.11 Assigning Boolean Values

You can assign boolean values with the XPath boolean function.

6.11.1 How to Assign Boolean Values

Example 6-24 provides an example of assigning boolean values. The XPath expression
in the £rom clause is a call to XPath’s boolean function true, and the specified
approved field is set to true. The function false is also available.

Example 6-24 Boolean Value Assignment

<assign>
<!-- copy from boolean expression function to the variable -->
<copy>
<from expression="true()"/>
<to variable="output" part="payload" query="/result/approved"/>
</copy>
</assign>

The XPath specification recommends that you use the "true () " and "false() "
functions as a method for returning boolean constant values.

If you instead use "boolean (true) " or "boolean (false) ", the true or false
inside the boolean function is interpreted as a relative element step, and not as any
true or false constant. It attempts to select a child node named true under the
current XPath context node. In most cases, the true node does not exist. Therefore, an
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empty result node set is returned and the boolean () function in XPath 1.0 converts
an empty node set into a false result. This result can be potentially confusing.

6.12 Assigning a Date or Time

You can assign the current value of a date or time field by using the Oracle BPEL
XPath function getCurrentDate, getCurrentTime, or getCurrentDateTime,
respectively. In addition, if you have a date-time value in the standard XSD format,
you can convert it to characters more suitable for output by calling the Oracle BPEL
XPath function formatDate.

For related information, see section 9.1.2 of the Business Process Execution Language for
Web Services Specification.

6.12.1 How to Assign a Date or Time

Example 6-25 shows an example that uses the function getCurrentDate.

Example 6-25 Date or Time Assignment

<!-- execute the XPath extension function getCurrentDate() -->
<assign>
<copy>

<from expression="xpath20:getCurrentDate()"/>
<to variable="output" part="payload"
query="/invoice/invoiceDate" />
</copy>
</assign>

In Example 6-26, the formatDate function converts the date-time value provided in

XSD format to the string 'Jun 10, 2005' (and assigns it to the string field
formattedDate).

Example 6-26 formatDate Function

<!-- execute the XPath extension function formatDate() -->
<assign>
<copy>

<from expression="ora:formatDate('2005-06-10T15:56:00",
‘MMM dd, yyyy')"/>
<to variable="output" part="payload"
query="/invoice/formattedDate" />
</copy>
</assign>

6.13 Manipulating Attributes

You can copy to or from something defined as an XML attribute. An at sign (@) in
XPath query syntax refers to an attribute instead of a child element.

6.13.1 How to Manipulate Attributes

The code in Example 6-27 fetches and copies the custId attribute from this XML
data:

Example 6-27 custld Attribute Fetch and Copy Operations

<invalidLoanApplication xmlns="http://samples.otn.com">
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<application xmlns = "http://samples.otn.com/XPath/autoloan">
<customer custId = "111" >
<name>
Mike Olive
</name>

</customer>

</application>
</invalidLoanApplication>

The code in Example 6-28 selects the custId attribute of the customer field and
assigns it to the variable custId:

Example 6-28 custld Attribute Select and Assign Operations

<assign>
<!-- get the custId attribute and assign to variable custId -->
<copy>
<from variable="input" part="payload"
query="/tns:invalidLoanApplication/autoloan:application
/autoloan:customer/@custId"/>
<to variable="custId"/>
</copy>
</assign>

The namespace prefixes in this example are not integral to the example.

The WSDL file defines a customer to have a type in which custIdis defined as an
attribute, as shown in Example 6-29:

Example 6-29 custld Attribute Definition

<complexType name="CustomerProfileType">
<sequence>
<element name="name" type="string"/>

</sequence>

<attribute name="custId" type="string"/>
</complexType>

6.14 Manipulating XML Data with bpelx Extensions

You can perform various operations on XML data in assign activities. The bpelx
extension types described in this section provide this functionality.

6.14.1 How to Use bpelx:append

Note: The bpelx:append extension is not supported with SDO
variables and causes an error.

The bpelx:append extension in an assign activity enables a BPEL process service
component to append the contents of one variable, expression, or XML fragment to
another variable’s contents. Example 6-30 provides an example.

Manipulating XML Data in a BPEL Process 6-19



Manipulating XML Data with bpelx Extensions

Example 6-30 bpelx:append Extension

<bpel:assign>
<bpelx:append>
<bpelx:from ... />
<bpelx:to ... />
</bpelx:append>
</bpel:assign>

The from-spec query within bpelx:append yields zero or more nodes. The node
list is appended as child nodes to the target node specified by the to-spec query.

The to-spec query must yield one single L-Value element node. Otherwise, a
bpel:selectionFailure faultis generated. The to-spec query cannot refer to a
partner link.

Example 6-31 consolidates multiple bills of material into one single bill of material
(BOM) by appending multiple b: parts for one BOM to b:parts of the consolidated
BOM.

Example 6-31 Consolidation of Multiple Bills of Material

<bpel:assign>
<bpelx:append>
<from variable="billOfMaterialVar"
query="/b:bom/b:parts/b:part" />
<to variable="consolidatedBillOfMaterialVar"
query="/b:bom/b:parts" />
</bpelx:append>
</bpel:assign>

6.14.2 How to Use bpelx:insertBefore

Note: The bpelx:insertBefore extension works with SDO
variables, but the target must be the variable attribute into which the
copied data must go.

The bpelx:insertBefore extension in an assign activity enables a BPEL process
service component to insert the contents of one variable, expression, or XML fragment
before another variable’s contents. Example 6-32 provides an example.

Example 6-32 bpelx:insertBefore Extension
<bpel:assign>
<bpelx:insertBefore>
<bpelx:from ... />
<bpelx:to ... />
</bpelx:insertBefore>
</bpel:assign>

The from-spec query within bpelx:insertBefore yields zero or more nodes. The
node list is appended as child nodes to the target node specified by the to-spec
query.

The to-spec query of the insertBefore operation points to one or more single
L-Value nodes. If multiple nodes are returned, the first node is used as the reference
node. The reference node must be an element node. The parent of the reference node
must also be an element node. Otherwise, a bpel : selectionFailure faultis
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generated. The node list generated by the from-spec query selection is inserted
before the reference node. The to-spec query cannot refer to a partner link.

Example 6-33 shows the syntax before the execution of <insertBefore>. The value
of addrVar is:

Example 6-33 Presyntax Execution

<a:usAddress>
<a:state>CA</a:state>
<a:zipcode>94065</a:zipcode>
</a:usAddress>

Example 6-34 shows the syntax after the execution:

Example 6-34 Postsyntax Execution

<bpel:assign>
<bpelx:insertBefore>
<bpelx:from>
<a:city>Redwood Shore></a:city>
</bpelx: from>
<bpelx:to "addrVar" query="/a:usAddress/a:state" />
</bpelx:insertBefore>
</bpel:assign>

Example 6-35 shows the value of addrvar:

Example 6-35 addrVar Value

<a:usAddress>
<a:city>Redwood Shore</a:city>
<a:state>CA</a:state>
<a:zipcode>94065</a:zipcode>
</a:usAddress>

6.14.3 How to Use bpelx:insertAfter

Note: The bpelx:insertAfter extension works with SDO
variables, but the target must be the variable attribute into which the
copied data must go.

The bpelx:insertAfter extension in an assign activity enables a BPEL process
service component to insert the contents of one variable, expression, or XML fragment
after another variable’s contents. Example 6-36 provides an example.

Example 6-36 bpelx:insertAfter Extension

<bpel:assign>
<bpelx:insertAfter>
<bpelx:from ... />
<bpelx:to ... />
</bpelx:insertAfter>
</bpel:assign>

This operation is similar to the functionality described for Section 6.14.2, "How to Use
bpelx:insertBefore," except for the following;:
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s  If multiple L-Value nodes are returned by the to-spec query, the last node is
used as the reference node.

= Instead of inserting nodes before the reference node, the source nodes are inserted
after the reference node.

This operation can also be considered a macro of conditional-switch + (append
or insertBefore).

Example 6-37 shows the syntax before the execution of <insertAfter>. The value of
addrvar is:

Example 6-37 Presyntax Execution

<a:usAddress>
<a:addressLine>500 Oracle Parkway</a:addressLine>
<a:state>CA</a:state>
<a:zipcode>94065</a:zipcode>

</a:usAddress>

Example 6-38 shows the syntax after the execution:

Example 6-38 Postsyntax Execution

<bpel:assign>
<bpelx:insertAfter>
<bpelx: from>
<a:addressLine>Mailstop lopé6</a:addressLine>
</bpelx: from>
<bpelx:to "addrVar" query="/a:usAddress/a:addressLine[1]" />
</bpelx:insertAfter>
</bpel:assign>

Example 6-39 shows the value of addrVvar:

Example 6-39 addrVar Value

<a:usAddress>
<a:addressLine>500 Oracle Parkway</a:addressLine>
<a:addressLine>Mailstop lopé6</a:addressLine>
<a:state>CA</a:state>
<a:zipcode>94065</a: zipcode>

</a:usAddress>

The from-spec query within bpelx:insertAfter yields zero or more nodes. The
node list is appended as child nodes to the target node specified by the to-spec

query.

6.14.4 How to Use bpelx:remove

The bpelx: remove extension in an assign activity enables a BPEL process service
component to remove a variable. Example 640 provides an example.

Example 6—40 bpelx:remove Extension

<bpel:assign>
<bpelx:remove>
<bpelx:target variable="ncname" part="ncname"? query="xpath_str" />
</bpelx:append>
</bpel:assign>
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Node removal specified by the XPath expression is supported. Nodes specified by the
XPath expression can be multiple, but must be L-Values. Nodes being removed from
this parent can be text nodes, attribute nodes, and element nodes.

The XPath expression can return one or more nodes. If the XPath expression returns
zero nodes, then a bpel:selectionFailure fault is generated.

The syntax of bpelx:target is similar to and a subset of to-spec for the copy
operation.

Example 641 shows addrVar with the following value:

Example 6—41 addrVar

<a:usAddress>
<a:addressLine>500 Oracle Parkway</a:addressLine>
<a:addressLine>Mailstop lopé6</a:addressLine>
<a:state>CA</a:state>
<a:zipcode>94065</a: zipcode>

</a:usAddress>

After executing the syntax shown in Example 642 in the BPEL process service
component file, the second address line of Mailstop is removed:

Example 6-42 Removal of Second Address Line

<bpel:assign>
<bpelx:remove>
<target variable="addrVar"
query="/a:usAddress/a:addressLine[2]" />
</bpelx:remove>
</bpel:assign>

After executing the syntax shown in Example 643 in the BPEL process service
component file, both address lines are removed:

Example 6-43 Removal of Both Address Lines
<bpel:assign>
<bpelx:remove>
<target variable="addrVar"
query="/a:usAddress/a:addressLine" />
</bpelx:remove>
</bpel:assign>

6.14.5 How to Use bpelx:rename and XSD Type Casting

The bpelx: rename extension in an assign activity enables a BPEL process service
component to rename an element through use of XSD type casting. Example 6-44
provides an example.

Example 6-44 bpelx:rename Extension

<bpel:assign>
<bpelx:rename elementTo="QNamel"? typeCastTo="QName2"?>
<bpelx:target variable="ncname" part="ncname"? query="xpath_str" />
</bpelx:rename>
</bpel:assign>

The syntax of bpelx:target is similar to and a subset of to-spec for the copy
operation. The target must return a list of one more element nodes. Otherwise, a
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bpel:selectionFailure faultis generated. The element nodes specified in the
from-spec are renamed to the QName specified by the elementTo attribute. The
xs1i: type attribute is added to those element nodes to cast those elements to the
QName type specified by the typeCastTo attribute.

Assume you have the employee list shown in Example 6-45:

Example 6—-45 xsi:type Attribute

<e:empList>
<e:emp>
<e:firstName>John</e:firstName><e:lastName>Dole</e:lastName>
<e:emp>
<e:emp xsi:type="e:ManagerType">
<e:firstName>Jane</e:firstName><e:lastName>Dole</e:lastName>
<e:approvallLimit>3000</e:approvallimit>
<e:managing />
<e:emp>
<e:emp>
<e:firstName>Peter</e:firstName><e:lastName>Smith</e:lastName>
<e:emp>
<e:emp>
<e:firstName>Mary</e:firstName><e:lastName>Smith</e:lastName>
<e:emp>
</e:empList>

Promotion changes are now applied to Peter Smith in the employee list in
Example 6-46:

Example 6-46 Application of Promotion Changes

<bpel:assign>
<bpelx:rename typeCastTo="e:ManagerType">
<bpelx:target variable="empListVar"
query="/e:emplList/e:emp[./e:firstName="'Peter' and
./e:lastName='Smith'" />
</bpelx:rename>
</bpel:assign>

After executing the above casting (renaming), the data looks as shown in
Example 6-47 with xsi: type info added to Peter Smith:

Example 6-47 Data Output

<e:empList>
<e:emp>
<e:firstName>John</e: firstName><e:lastName>Dole</e:lastName>
<e:emp>
<e:emp xXsi:type="e:ManagerType">
<e:firstName>Jane</e:firstName><e:lastName>Dole</e:lastName>
<e:approvallLimit>3000</e:approvallimit>
<e:managing />
<e:emp>
<e:emp xsi:type="e:ManagerType">
<e:firstName>Peter</e:firstName><e:lastName>Smith</e:lastName>
<e:emp>
<e:emp>
<e:firstName>Mary</e:firstName><e:lastName>Smith</e:lastName>
<e:emp>
</e:empList>
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The employee data of Peter Smith is now invalid, because <approvalLimit> and
<managing> are missing. Therefore, <append> is used to add that information.
Example 648 provides an example.

Example 6—48 Use of append Extension to Add Information

<bpel:assign>
<bpelx:rename typeCastTo="e:ManagerType">
<bpelx:target variable="empListVar"
query="/e:empList/e:emp[./e:firstName="'Peter' and
./e:lastName="'Smith'" />
</bpelx:rename>
<bpelx:append>
<bpelx:from>
<e:approvallLimit>2500</e:approvallimit>
<e:managing />
</bpelx:from>
<bpelx:to variable="empListVar"
query="/e:empList/e:emp[./e:firstName="'Peter' and
./e:lastName='Smith'" />
</bpelx:append>
</bpel:assign>

With the execution of both rename and append, the corresponding data looks as
shown in Example 6—49:

Example 6-49 rename and append Execution

<e:emp xsi:type="e:ManagerType">
<e:firstName>Peter</e:firstName><e:lastName>Smith</e:lastName>
<e:approvalLimit>2500</e:approvallimit>
<e:managing />

<e:emp>

6.14.6 How to Use bpelx:copyList

The bpelx:copyList extension in an assign activity enables a BPEL process service
component to perform a copyList operation of the contents of one variable,
expression, or XML fragment to another variable. Example 6-50 provides an example.

Example 6-50 bpelx:copyList Extension
<bpel:assign>
<bpelx:copyList>
<bpelx:from ... />
<bpelx:to ... />
</bpelx:copyList>
</bpel:assign>

The from-spec query can yield a list of either all attribute nodes or all element nodes.
The to-spec query can yield a list of L-value nodes: either all attribute nodes or all
element nodes.

All the element nodes returned by the to-spec query must have the same parent
element. If the to-spec query returns a list of element nodes, all element nodes must
be contiguous.

If the from-spec query returns attribute nodes, then the to-spec query must return
attribute nodes. Likewise, if the from-spec query returns element nodes, then the
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to-spec query must return element nodes. Otherwise, a
bpws :mismatchedAssignmentFailure faultis thrown.

The from-spec query can return zero nodes, while the to-spec query must return
at least one node. If the from-spec query returns zero nodes, the effect of the
copyList operation is similar to the remove operation.

The copylist operation provides the following features:
= Removes all the nodes pointed to by the to-spec query.

» If the to-spec query returns a list of element nodes and there are leftover child
nodes after removal of those nodes, the nodes returned by the from-spec query
are inserted before the next sibling of the last element specified by the to-spec
query. If there are no leftover child nodes, an append operation is performed.

s If the to-spec query returns a list of attribute nodes, those attributes are removed
from the parent element. The attributes returned by the from-spec query are
then appended to the parent element.

For example, assume a schema is defined as shown in Example 6-51.

Example 6-51 Schema

<schema attributeFormDefault="unqualified"
elementFormDefault="qualified"
targetNamespace="http://xmlns.oracle.com/Event_jws/Event/EventTest"
xmlns="http://www.w3.0rg/2001/XMLSchema">
<element name="process">

<complexType>
<sequence>
<element name="payload" type="string"
maxOccurs="unbounded" />
</sequence>
</complexType>
</element>
<element name="processResponse">
<complexType>
<sequence>
<element name="payload" type="string"
maxOccurs="unbounded" />
</sequence>
</complexType>
</element>

</schema>

The from variable contains the content shown in Example 6-52.

Example 6-52 Variable Content

<nsl:process xmlns:nsl="http://xmlns.oracle.com/Event_jws/Event/EventTest">
<nsl: payload >a</nsl: payload >
<nsl: payload >b</nsl: payload >

</nsl:process>

The to variable contains the content shown in Example 6-53.

Example 6-53 Variable Content

<nsl:processResponse xmlns:nsl="http://xmlns.oracle.com/Event_
jws/Event/EventTest">
<nsl: payload >c</nsl: payload >

6-26 Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite



Manipulating XML Data Sequences That Resemble Arrays

</nsl:process>

The bpelx: copyList operation looks as shown in Example 6-54.

Example 6-54 bpelx:copyList

<assign>
<bpelx:copyList>
<bpelx:from variable="inputVariable" part="payload"
query="/client:process/client:payload"/>
<bpelx:to variable="outputVariable" part="payload"
query="/client:processResponse/client:payload" />
</bpelx:copyList>
</assign>

This makes the to variable as shown in Example 6-55.

Example 6-55 Variable Content

<nsl:processResponse xmlns:nsl="http://xmlns.oracle.com/Event_
jws/Event/EventTest">
<nsl: payload >a</nsl: payload >
<nsl: payload >b</nsl: payload >
</nsl:process>

6.15 Validating XML Data with bpelx:validate

The bpelx:validate function enables you to verify code and identify invalid XML
data.

6.15.1 How to Validate XML Data with bpelx:validate

Use this extension as follows:

= With the validate attribute in an assign activity:
<assign bpelx:validate:"yes|no">
</assign>

» In<bpelx:validate> as a standalone, extended activity that can be used
without an assign activity:

<bpelx:validate variables="NCNAMES" />

For example:

<bpelx:validate variables="myMsgVariable myPOElemVar" />

6.16 Manipulating XML Data Sequences That Resemble Arrays

Data sequences are one of the most basic data models used in XML. However,
manipulating them can be nontrivial. One of the most common data sequence patterns
used in BPEL process service components are arrays. Based on the XML schema, the
way you can identify a data sequence definition is by its attribute maxOccurs being
set to a value greater than one or marked as unbounded. See the XML Schema
Specification at http: / /www.w3 . org/TR for more information.

The examples in this section illustrate several basic ways of manipulating data
sequences in BPEL. However, there are other associated requirements, such as
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performing looping or dynamic referencing of endpoints. For additional code samples
and further information regarding real-world use cases for data sequence
manipulation in BPEL, see http://www.oracle.com/technology/sample_
code/products/bpel. The following sections describe a particular requirement for
data sequence manipulation.

6.16.1 How to Statically Index into an XML Data Sequence That Uses Arrays

The following two examples illustrate how to use XPath functionality to select a data
sequence element when the index of the element you want is known at design time. In
these cases, it is the first element.

In Example 6-56, addresses [1] selects the first element of the addresses data
sequence:

Example 6-56 Data Sequence Element Selection

<assign>
<!-- get the first address and assign to variable address -->
<copy>
<from variable="input" part="payload"
query="/tns:invalidLoanApplication/autoloan:application
/autoloan:customer/autoloan:addresses[1]"/>
<to variable="address"/>
</copy>
</assign>

In this query, addresses[1] is equivalent to addresses [position()=1], where
position is one of the core XPath functions (see sections 2.4 and 4.1 of the XML Path
Language (XPath) Specification). The query in Example 6-57 calls the position
function explicitly to select the first element of the addresses data sequence. It then
selects that address’s street element (which the activity assigns to the variable
streetl).

Example 6-57 position Function Use

<assign>
<!-- get the first address's street and assign to streetl -->
<copy>
<from variable="input" part="payload"
query="/tns:invalidLoanApplication/autoloan:application
/autoloan:customer/autoloan:addresses[position()=1]
/autoloan:street"/>
<to variable="streetl"/>
</copy>
</assign>

If you review the definition of the input variable and its payload part in the WSDL file,
you go several levels down before coming to the definition of the addresses field.
There you see the maxOccurs="unbounded" attribute. The two XPath indexing
methods are functionally identical; you can use whichever method you prefer.

6.16.2 How to Use SOAP-Encoded Arrays

Oracle SOA Suite provides support for SOAP RPC-encoded arrays. This support
enables Oracle BPEL Process Manager to operate as a client calling a SOAP web
service (RPC-encoded) that uses a SOAP 1.1 array:.

6-28 Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite



Manipulating XML Data Sequences That Resemble Arrays

Example 6-58 provides an example of a SOAP array payload named
myFavoriteNumbers.

Example 6-58 SOAP Array Payload

<myFavoriteNumbers SOAP-ENC:arrayType="xsd:int2">
<number>3</number>

<number>4</number>

</myFavoriteNumbers>

In addition, ensure that the schema element attributes at tributeFormDefault and
elementFormDefault are set to "unqualified" in your schema. Example 6-59
provides details:

Example 6-59 Schema Element Attributes

attributeFormDefault="unqualified" elementFormDefault="unqualified"
targetNamespace="java:services" xmlns:s0="http://schemas.xmlsoap.org/wsdl/"
xmlns:xs="http://www.w3.0rg/2001/XMLSchema">

The following features are not supported:

= A service published by BPEL that uses a SOAP array
»  Partially-transmitted arrays

m  Sparse arrays

= Multidimensional arrays

To use a SOAP-encoded array:

Example 6-60 shows how to prepare SOAP arrays with the bpelx:append tagin a
BPEL project.

1. Create a BPEL process in Oracle JDeveloper.

2. Prepare the payload for the invocation. Note that bpelx: append in Example 6-60
is used to add items into the SOAP array.

Example 6-60 SOAP Array

<bpws:assign>
<bpws : copy>
<bpws:from variable="input" part="payload" query="/tns:value"/>
<bpws:to variable="request" part="strArray"
query="/strArray/Javalangstring"/>
</bpws : copy>
</bpws:assign>
<bpws:assign>
<bpelx:append>
<bpelx:from variable="request" part="strArray"
query="/strArray/Javalangstringl"/>
<bpelx:to variable="request" part="strArray" query="/strArray"/>
</bpelx:append>
</bpws:assign>

3. Import the following namespace in your WSDL file. Oracle JDeveloper does not
understand the SOAP-ENC tag if the import statement is missing in the WSDL
schema element.

<xs:import namespace="http://schemas.xmlsoap.org/soap/encoding/" />
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6.16.3 How to Determine Sequence Size

If you must know the runtime size of a data sequence (that is, the number of nodes or
data items in the sequence), you can get it by using the combination of the XPath
built-in count () function and the BPEL built-in getVariableData () function.

The code in Example 6-61 calculates the number of elements in the item sequence and
assigns it to the integer variable 1ineItemSize.

Example 6-61 Sequence Size Determination
<assign>
<copy>
<from expression="count (bpws:getVariableData (’outpoint’, ’'payload’,
'/p:invoice/p:lineltems/p:item')"/>
<to variable="lineItemSize"/>
</copy>
</assign>

6.16.4 How to Dynamically Index by Applying a Trailing XPath to an Expression

Often a dynamic value is needed to index into a data sequence; that is, you must get
the nth node out of a sequence, where the value of n is defined at runtime. This
section covers the methods for dynamically indexing by applying a trailing XPath into
expressions.

6.16.4.1 Applying a Trailing XPath to the Result of getVariableData

The dynamic indexing method shown in Example 6-62 applies a trailing XPath to the
result of bwps : getVariableData (), instead of using an XPath as the last argument
of bpws : getVariableData (). The trailing XPath references to an integer-based
index variable within the position predicate (thatis, [...]).

Example 6-62 Dynamic Indexing
<variable name="idx" type="xsd:integer"/>
<assign>
<copy>
<from expression="bpws:getVariableData ('input', 'payload’
)/p:line-item[bpws:getVariableData('idx')]/p:line-total" />
<to variable="lineTotalVar" />

</copy>
</assign>

Assume at runtime that the idx integer variable holds 2 as its value. The preceding
expression within the £rom is equivalent to that shown in Example 6-63.

Example 6-63 Equivalent Format

<from expression="bpws:getVariableData ('input', 'payload’
)/p:line-item[2]/p:1line-total" />

There are some subtle XPath usage differences, when an XPath used trailing behind
the bwps :getVariableData () function is compared with the one used inside the
function.

Using the same example (where payload is the message part of element
"p:invoice"), if the XPath is used within the getVariableData () function, the
root element name (" /p:invoice") must be specified at the beginning of the XPath.
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Example 6-64 provides details.

Example 6—64 Root Element Name Specification

bpws:getVariableData('input', 'payload',
'/p:invoice/p:line-item[2]/p:line-total")

If the XPath is used trailing behind the bwps : getVariableData () function, the root
element name does not need to be specified in the XPath.

For example:

bpws:getVariableData('input', 'payload')/p:line-item[2]/p:line-total

This is because the node returned by the getvariableData () function is the root
element. Specifying the root element name again in the XPath is redundant and is
incorrect according to standard XPath semantics.

6.16.4.2 Using the bpelx:append Extension to Append New Items to a Sequence

The bpelx:append extension in an assign activity enables BPEL process service
components to append new elements to an existing parent element. Example 6-65
provides an example.

Example 6-65 bpelx:append Extension
<assign name="assign-3">

<copy>
<from expression="bpws:getVariableData('idx')+1" />
<to variable="idx"/>

</copy>

<bpelx:append>
<bpelx:from variable="partInfoResultVar" part="payload" />
<bpelx:to variable="output" part="payload" />

</bpelx:append>

</assign>

The bpelx:append logic in this example appends the payload element of the
partInfoResultVar variable as a child to the payload element of the output
variable. In other words, the payload element of output variable is used as the parent
element.

6.16.4.3 Merging Data Sequences

You can merge two sequences into a single data sequence. This pattern is common
when the data sequences are in an array (that is, the sequence of data items of
compatible types).

The two append operations shown in Example 6-66 under assign demonstrate how
to merge data sequences:

Example 6—66 Data Sequences Merges with append Operations

<assign>
<!-- initialize "mergedLineltems" variable
to an empty element -->
<copy>

<from> <p:lineltems /> </from>
<to variable="mergedLinelItems" />
</copy>
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<bpelx:append>
<bpelx:from variable="input" part="payload"
query="/p:invoice/p:lineltems/p:lineitem" />
<bpelx:to variable="mergedLineItems" />
</bpelx:append>
<bpelx:append>
<bpelx:from variable="literalLineItems"
query="/p:lineltems/p:lineitem" />
<bpelx:to variable="mergedLinelItems" />
</bpelx:append>
</assign>

6.16.4.4 Generating Functionality Equivalent to an Array of an Empty Element
The genEmptyElem function generates functionality equivalent to an array of an
empty element to an XML structure. This function takes the following arguments:

genEmptyElem('ElemQName', int?, 'TypeQName'?, boolean?)

Note the following issues:
»  The first argument specifies the QName of the empty elements.

= The optional second integer argument specifies the number of empty elements. If
missing, the default size is 1.

s The third optional argument specifies the OQName, which is the xsi : type of the
generated empty name. This xsi : type pattern matches the SOAPENC : Array. If
it is missing or is an empty string, the xsi : type attribute is not generated.

s The fourth optional boolean argument specifies whether the generated empty
elements are XSI - nil, provided the element is XSD-nillable. The default value
is false. If missing or false, xsi:nil is not generated.

Example 6-67 shows an append statement initializing a purchase order (PO)
document with 10 empty <lineItem> elements under po:

Example 6—67 append Statement
<bpelx:assign>
<bpelx:append>
<bpelx:from expression="ora:genEmptyElem('p:lineltem',10)" />
<bpelx:to variable="poVar" query="/p:po" />
</bpelx:append>
</bpelx:assign>

The genEmptyElem function in Example 6—67 can be replaced with an embedded
XQuery expression, as shown in Example 6-68.

Example 6-68 Embedded XQuery Expression

ora:genEmptyElem('p:lineltem',10)
== for $i in (1 to 10) return <p:lineltem />

The empty elements generated by this function are typically invalid XML data. You
perform further data initialization after the empty elements are created. Using the
same example above, you can perform the following:

= Add attribute and child elements to those empty 1ineItem elements.
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s Perform copy operations to replace the empty elements. For example, copy from a
web service result to an individual entry in this equivalent array under a flowN
activity.

6.16.5 What You May Need to Know About Using the Array Identifier

For processing in Native Format Builder array identifier environments, information is
required about the parent node of a node. Because the reportSAXEvents APl is
used, this information is typically not available for outbound message scenarios.
Setting nxsd:useArrayIdentifiers to true in the native schema enables
DOM-parsing to be used for outbound message scenarios. Use this setting cautiously,
as it can lead to slower performance for very large payloads. Example 6-69 provides
details.

Example 6-69 Array Identifier

<?xml version="1.0" ?>

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:nxsd="http://xmlns.oracle.com/pcbpel/nxsd"
targetNamespace="http://xmlns.oracle.com/pcbpel/demoSchema/csv"
xmlns:tns="http://xmlns.oracle.com/pcbpel/demoSchema/csv"
elementFormDefault="qualified"
attributeFormDefault="unqualified" nxsd:encoding="US-ASCII"
nxsd:stream="chars" nxsd:version="NXSD" nxsd:useArrayIdentifiers="true">
<xsd:element name="Root-Element">

</xsd:element>
</xsd:schema>

6.17 Converting from a String to an XML Element

Sometimes a service is defined to return a string, but the content of the string is
actually XML data. The problem is that, although BPEL provides support for
manipulating XML data (using XPath queries, expressions, and so on), this
functionality is not available if the variable or field is of type string. With Java, you use
DOM functions to convert the string to a structured XML object type. You can use the
BPEL XPath function parseEscapedXML to do the same thing.

6.17.1 How To Convert from a String to an XML Element

The parseEscapedXML function takes XML data, parses it through DOM, and
returns structured XML data that can be assigned to a typed BPEL variable.
Example 6-70 provides an example:

Example 6-70 String to XML Element Conversion

<!-- execute the XPath extension function
parseEscapedXML ('&1t;item&gt; ') and assign to a variable
-—>
<assign>

<copy>

<from expression="ora:parseEscapedXML (
'&1lt;item xmlns=&quot;http://samples.otn.com&quot;
sku=&quot; 006&quot; &gt ;
&1t;description&gt;sun ultra sparc VI server
&1t;/descriptioné&gt;
&lt;price&gt;1000
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&lt; /price&gt;
&lt;quantityé&gt;2
&1t; /quantity&gt;
&1t;lineTotal&gt;2000
&1t;/lineTotal&gt;
&lt;/item&gt; ') "/>
<to variable="escapedLineItem"/>
</copy>
</assign>

6.18 Understanding the Differences Between Document-Style and
RPC-Style WSDL Files

The examples shown up to this point have been for document-style WSDL files in
which a message is defined with an XML schema element, as shown in
Example 6-71:

Example 6-71 XML Schema element Definition

<message name="LoanFlowRequestMessage">
<part name="payload" element="sl:loanApplication"/>
</message>

This is in contrast to RPC-style WSDL files, in which the message is defined with an
XML schema type, as shown in Example 6-72:

Example 6-72 RPC-Style type Definition

<message name="LoanFlowRequestMessage">
<part name="payload" type="sl:LoanApplicationType"/>
</message>

6.18.1 How To Use RPC-Style Files

This impacts the material in this chapter because there is a difference in how XPath
queries are constructed for the two WSDL message styles. For an RPC-style message,
the top-level element (and therefore the first node in an XPath query string) is the part
name (payload in Example 6-72). In document-style, the top-level node is the
element name (for example, loanApplication).

Example 6-73 and Example 6-74 show what an XPath query string looks like if an
application named LoanServices were in RPC style.

Example 6-73 RPC-Style WSDL File

<message name="LoanServiceResultMessage">
<part name="payload" type="sl:LoanOfferType"/>
</message>

<complexType name="LoanOfferType">
<sequence>
<element name="providerName" type="string"/>
<element name="selected" type="boolean"/>
<element name="approved" type="boolean"/>
<element name="APR" type="double"/>
</sequence>
</complexType>
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Example 6-74 RPC-Style BPEL File

<variable name="output"
messageType="tns:LoanServiceResultMessage"/>
<assign>
<copy>
<from expression="9.9"/>
<to variable="output" part="payload" query="/payload/APR"/>

</copy>
</assign>

6.19 Manipulating SOAP Headers in BPEL

BPEL's communication activities (invoke, receive, reply, and onMessage) receive and
send messages through specified message variables. These default activities permit
one variable to operate in each direction. For example, the invoke activity has
inputVariable and outputVariable attributes. You can specify one variable for
each of the two attributes. This is enough if the particular operation involved uses only
one payload message in each direction.

However, WSDL supports multiple messages in an operation. In the case of SOAP,
multiple messages can be sent along the main payload message as SOAP headers.
However, BPEL's default communication activities cannot accommodate the
additional header messages.

Oracle BPEL Process Manager solves this problem by extending the default BPEL
communication activities with the bpelx:headerVariable extension. The extension
syntax is as shown in Example 6-75:

Example 6-75 bpelx:headerVariable Extension

<invoke bpelx:inputHeaderVariable="inHeaderl inHeader2 ..."
bpelx:outputHeaderVariable="outHeaderl outHeader2 ..."
oL />

<receive bpelx:headerVariable="inHeaderl inHeader2 ..." .../>
<onMessage bpelx:headerVariable="inHeaderl inHeader2 ..." .../>
<reply bpelx:headerVariable="inHeaderl inHeader2 ..." .../>

6.19.1 How to Receive SOAP Headers in BPEL

This section provides an example of how to create BPEL and WSDL files to receive
SOAP headers.

To receive SOAP headers in BPEL:

1. Create a WSDL file that declares header messages and the SOAP binding that
binds them to the SOAP request. Example 6-76 provides an example.

Example 6-76 WSDL File Contents

<!-- custom header -->
<message name="CustomHeaderMessage">
<part name="headerl" element="tns:headerl"/>
<part name="header2" element="tns:header2"/>
</message>

<binding name="HeaderServiceBinding" type="tns:HeaderService">
<soap:binding style="document"
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transport="http://schemas.xmlsoap.org/soap/http" />
<operation name="initiate">
<soap:operation style="document" soapAction="initiate"/>
<input>
<soap:header message="tns:CustomHeaderMessage"
part="headerl" use="literal"/>
<soap:header message="tns:CustomHeaderMessage"
part="header2" use="literal"/>
<soap:body use="literal"/>
</input>
</operation>
</binding>

2. Create a BPEL source file that declares the header message variables and uses
bpelx:headerVariable to receive the headers, as shown in Example 6-77.

Example 6-77 bpelx:headerVariable Use

<variables> <variable name="input"
messageType="tns:HeaderServiceRequestMessage" />
<variable name="event"
messageType="tns:HeaderServiceEventMessage" />
<variable name="output"
messageType="tns:HeaderServiceResultMessage"/>
<variable name="customHeader"
messageType="tns:CustomHeaderMessage"/>
</variables>

<sequence>
<!-- receive input from requester -->
<receive name="receiveInput" partnerLink="client"
portType="tns:HeaderService" operation="initiate"
variable="input"
bpelx:headerVariable="customHeader"
createlnstance="yes"/>

6.19.2 How to Send SOAP Headers in BPEL

This section provides an example of how to send SOAP headers.

To send SOAP headers in BPEL:
1. Define an SCA reference in the composite.xml to refer to the HeaderService.

2. Define the custom header variable, manipulate it, and send it using
bpelx:inputHeaderVariable, as shown in Example 6-78.

Example 6-78 bpelx:inputHeaderVariable Use

<variables>
<variable name="input" messageType="tns:HeaderTestRequestMessage"/>
<variable name="output" messageType="tns:HeaderTestResultMessage"/>
<variable name="request" messageType="services:HeaderServiceRequestMessage"/>
<variable name="response" messageType="services:HeaderServiceResultMessage"/>
<variable name="customHeader"messageType="services:CustomHeaderMessage"/>
</variables>

<!-- initiate the remote process -->
<invoke name="invokeAsyncService"
partnerLink="HeaderService"
portType="services:HeaderService"
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bpelx:inputHeaderVariable="customHeader"
operation="initiate"
inputVariable="request"/>

6.20 Using MIME/DIME SOAP Attachments

A BPEL process service component can receive SOAP attachments in an optimized
Message Transmission Optimization Mechanism (MTOM) format. However, the BPEL
process cannot internally process the attachments. Instead, the attachments are added
to the DOM as part of the XML file. Oracle recommends that you avoid using MTOM
attachments and instead use Multipurpose Internet Mail Extensions (MIME) and
Direct Internet Message Encapsulation (DIME) SOAP attachments.
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Invoking a Synchronous Web Service from a
BPEL Process

This chapter describes how to invoke a synchronous web service from a BPEL process.
This chapter demonstrates how to set up the components necessary to perform a
synchronous invocation. This chapter also examines how these components are coded.

This chapter includes the following sections:

= Section 7.1, "Introduction to Invoking a Synchronous Web Service"

= Section 7.2, "Invoking a Synchronous Web Service"

= Section 7.3, "Specifying Timeout Values"

= Section 7.4, "Calling a One-Way Mediator with a Synchronous BPEL Process"

For a simple Hello World sample (bpel-101-HelloWor1d) that takes an input
string, adds a prefix of "Hello " to the string, and returns it, visit the following URL:

http://www.oracle.com/technology/sample_code/products/bpel

7.1 Introduction to Invoking a Synchronous Web Service

Synchronous web services provide an immediate response to an invocation. BPEL can
connect to synchronous web services through a partner link, send data, and then
receive the reply in the same synchronous invocation.

A synchronous invocation requires the following components:
» Partner link

Defines the location and the role of the web services with which the BPEL process
service component connects to perform tasks, and the variables used to carry
information between the web service and the BPEL process service component. A
partner link is required for each web service that the BPEL process service
component calls. You can create partner links in either of two ways:

— In the SOA Composite Editor, when you drag a Web Service from the
Component Palette into the Exposed Services or External References
swimlane.

— In the Oracle BPEL Designer, when you drag a Partner Link (Web
Service/Adapter) from the Component Palette into the Partner Links
swimlane. This method is described in this chapter.

= Invoke activity

Opens a port in the BPEL process service component to send and receive data. It
uses this port to retrieve information verifying that the customer has acceptable
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credit using the CreditCard AuthorizationService. For synchronous callbacks,
only one port is needed for both the send and receive functions.

7.2 Invoking a Synchronous Web Service

This section examines a synchronous invocation operation using the
OrderProcessor .bpel file in the WebLogic Fusion Order Demo application as an
example.

7.2.1 How to Invoke a Synchronous Web Service

To invoke a synchronous web service:

1. In the Component Palette in Oracle BPEL Designer, drag the necessary partner
link, invoke activity, and assign activities into the designer.

2. Edit their dialogs.

Figure 7-1 shows the diagram for the Scope_AuthorizeCreditCard scope activity of
the OrderProcessor.bpel file, which defines a simple set of actions.

Figure 7-1 Diagram of OrderProcessor.bpel

Assign_CreditCheckInput

1 %
CreditCardauthori...

InvokeCheckCreditCard

RS
Switch_EwaluateCCResult

The following actions take place:

1. The Assign_CreditCheckInput assign activity packages the data from the client.
The assign activity provides a method for copying the contents of one variable to
another. In this case, it takes the credit card type, credit card number, and purchase
amount and assigns them to the input variable for the
CreditAuthorizationService service.

2. The InvokeCheckCreditCard activity calls the CreditCard Authorization service.
Figure 7-2 shows the CreditCard AuthorizationService web service, which is
defined as a partner link.
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Figure 7-2 CreditCardAuthorizationService Partner Link
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Figure 7-3 shows the InvokeCheckCreditCard invoke activity.

Figure 7-3 InvokeCheckCreditCard Invoke Activity
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3.

The Switch_EvaluateCCResult switch activity checks the results of the credit card

validation. For information about switch activities, see Section 10.2, "Creating a

Switch Activity to Define Conditional Branching."

7.2.2 What Happens When You Invoke a Synchronous Web Service

When you create a partner link and invoke activity, the necessary BPEL code for
invoking a synchronous web service is added to the appropriate BPEL and Web

Services Description Language (WSDL) files.

Invoking a Synchronous Web Service from a BPEL Process 7-3



Invoking a Synchronous Web Service

7.2.2.1 Partner Link in the BPEL Code

In the OrderProcessor.bpel code, the partner link defines the link name and type,
and the role of the BPEL process service component in interacting with the partner
service.

From the BPEL source code, the CreditCardAuthorizationService partner link
definition is shown in Example 7-1:

Example 7-1 Partner Link Definition

<partnerLink name="CreditCardAuthorizationService"
partnerRole="CreditAuthorizationPort"
partnerLinkType="ns2:CreditCardAuthorizationService"/>

Variable definitions that are accessible locally in the Scope_AuthorizeCreditCard
scope are shown in Example 7-2. The types for these variables are defined in the
WSDL for the process itself.

Example 7-2 Variable Definition

<variable name="1CreditCardInput"
messageType="ns2:CreditAuthorizationRequestMessage" />

<variable name="1CreditCardOutput"
messageType="ns2:CreditAuthorizationResponseMessage" />

The WSDL file defines the interface to your BPEL process service component: the
messages that it accepts and returns, the operations that are supported, and other
parameters.

7.2.2.2 Partner Link Type and Port Type in the BPEL Code

The web service’s CreditCardAuthorizationService.wsdl file contains two
sections that enable the web service to work with BPEL process service components:

s partnerLinkType:

Defines the following characteristics of the conversion between a BPEL process
service component and the credit card authorization web service:

— The role (operation) played by each

— The portType provided by each for receiving messages within the
conversation

m  portType:

A collection of related operations implemented by a participant in a conversation.
A port type defines which information is passed back and forth, the form of that
information, and so on. A synchronous invocation requires only one port type that
both initiates the synchronous process and calls back the client with the response.
An asynchronous callback (one in which the reply is not immediate) requires two
port types, one to send the request, and another to receive the reply when it
arrives.

In this example, the portType CreditAuthorizationPort receives the credit
card type, credit card number, and purchase amount, and returns the status
results.

Example 7-3 provides an example of partnerLinkType and portType.
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Example 7-3 partnerLinkType and portType Definitions

<plnk:partnerLinkType name="CreditCardAuthorizationService">
<plnk:role name="CreditAuthorizationPort">
<plnk:portType name="tns:CreditAuthorizationPort"/>
</plnk:role>
</plnk:partnerLinkType>

7.2.2.3 Invoke Activity for Performing a Request

The invoke activity includes the 1CreditCardInput local input variable. The credit
card authorization web service uses the 1CreditCardInput input variable. This
variable contains the customer’s credit card type, credit card number, and purchase
amount. The 1CreditCardoOutput variable returns status results from the
CreditAuthorizationService service. Example 7—4 provides an example.

Example 7-4 Invoke Activity

<invoke name="InvokeCheckCreditCard"
inputVariable="1CreditCardInput"
outputVariable="1CreditCardOutput"
partnerLink="CreditCardAuthorizationService"
portType="ns2:CreditAuthorizationPort"
operation="AuthorizeCredit"/>

7.2.2.4 Synchronous Invocation in BPEL Code
The BPEL code shown in Example 7-5 performs the synchronous invocation:

Example 7-5 Synchronous Invocation

<assign name="Assign_CreditCheckInput">
<copy>
<from variable="gOrderInfoVariable"
query="/nsd:orderInfovOSDO/ns4:0rderTotal" />
<to variable="1CreditCardInput" part="Authorization"
query="/ns8:AuthInformation/ns8:PurchaseAmount" />
</copy>
<copy>
<from variable="gOrderInfoVariable"
query="/nsd:orderInfovOSDO/ns4:CardTypeCode" />
<to variable="1CreditCardInput" part="Authorization"
query="/ns8:AuthInformation/ns8:CCType" />
</copy>
<copy>
<from variable="gOrderInfoVariable"
query="/nsd:orderInfov0OSDO/ns4 : AccountNumber" />
<to variable="1CreditCardInput" part="Authorization"
query="/ns8:AuthInformation/ns8:CCNumber" />
</copy>
</assign>
<invoke name="InvokeCheckCreditCard"
inputVariable="1CreditCardInput"
outputVariable="1CreditCardOutput"
partnerLink="CreditCardAuthorizationService"
portType="ns2:CreditAuthorizationPort"
operation="AuthorizeCredit"/>
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7.3 Specifying Timeout Values

You can specify timeout values with the property SyncMaxWaitTime in the System
MBean Browser of Oracle Enterprise Manager Fusion Middleware Control Console.
This property defines the maximum time a request and response operation takes
before timing out. If the BPEL process service component does not receive a reply
within the specified time, then the activity fails.

7.3.1 How To Specify Timeout Values

To specify timeout values:

1. From the SOA Infrastructure menu, select SOA Administration > BPEL
Properties.

2. At the bottom of the BPEL Service Engine Properties page, click More BPEL
Configuration Properties.

3. Click SyncMaxWaitTime.

4. In the Value field, specify a value in seconds.
5. Click Apply.

6. Click Return.

7.3.2 What You May Need to Know About SyncMaxWaitTime and Synchronous
Requests Not Timing Out

The SyncMaxWaitTime property applies to durable processes that are called in an
asynchronous manner.

Assume you have a BPEL process with the definition shown in Example 7-6. The
process is not durable because there are no breakpoint activities.

Example 7-6 Process with No Breakpoint Activities

<receive name="receiveInput" partnerLink="client" variable="input"
createInstance="yes" />

<assign>

</assign>

<reply name="replyOutput" partnerLink="client" variable="output" />

If a Java client or another BPEL process calls this process, the assign activity is
performed and the reply activity sets the output message into a HashMap for the client
(actually the delivery service) to retrieve. Since the reply is the last activity, the thread

returns to the client side and tries to pick up the reply message. Since the reply
message was previously inserted, the client does not wait and returns with the reply.

Assume you have a BPEL process with a breakpoint activity, as shown in Example 7-7.

Example 7-7 Process with Breakpoint Activities

<receive name="receivelnput" partnerLink="client" variable="input"
createInstance="yes" />
<assign>

</assign>
<wait for="'PT10S'" />
<reply name="replyOutput" partnerLink="client" variable="output" />
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While it is not recommended to have asynchronous activities inside a synchronous
process, BPEL does not prevent this type of design.

When the client (or another BPEL process) calls the process, the wait (breakpoint)
activity is executed. However, since the wait is processed after some time by an
asynchronous thread in the background, the executing thread returns to the client side.
The client (actually the delivery service) tries to pick up the reply message, but it is not
there since the reply activity in the process has not yet executed. Therefore, the client
thread waits for the SyncMaxWaitTime seconds value. If this time is exceeded, then
the client thread returns to the caller with a timeout exception.

If the wait is less than the SyncMaxWaitTime value, the asynchronous background
thread then resumes at the wait and executes the reply. The reply is placed in the
HashMap and the waiter (the client thread) is notified. The client thread picks up the
reply message and returns.

Therefore, SyncMaxWaitTime only applies to synchronous process invocations when
the process has a breakpoint in the middle. If there is no breakpoint, the entire process
is executed by the client thread and returns the reply message.

7.4 Calling a One-Way Mediator with a Synchronous BPEL Process

You can expose a synchronous interface in the front end while using an asynchronous
callback in the back end to simulate a synchronous reply. This is the default behavior

in BPEL processes with the automatic setting of the configuration. transaction
property to requiresNew in the composite.xml file. Example 7-8 provides details.

Example 7-8 configuration.transaction Property

<component name="BPELProcessl">

@ <implementation.bpel src="BPELProcessl.bpel"/>

@ <property name="configuration.transaction" type="xs:string"
@ many="false">requiresNew</property>

@ </component>

RequiresNew is the recommended value. If you want to participate in the client's

transaction, you must set the configuration. transaction property to
Required.
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Invoking an Asynchronous Web Service
from a BPEL Process

This chapter describes how to call an asynchronous web service. Asynchronous
messaging styles are useful for environments in which a service, such as a loan
processor, can take a long time to process a client request. Asynchronous services also
provide a more reliable fault-tolerant and scalable architecture than synchronous
services.

This chapter includes the following sections:

= Section 8.1, "Introduction to Invoking an Asynchronous Web Service"
= Section 8.2, "Invoking an Asynchronous Web Service"

= Section 8.3, "Using a Dynamic Partner Link at Runtime"

= Section 8.4, "Using WS-Addressing in an Asynchronous Service"

= Section 8.5, "Using Correlation Sets in an Asynchronous Service"

8.1 Introduction to Invoking an Asynchronous Web Service

This section introduces asynchronous web service invocation with a company called
United Loan. United Loan publishes an asynchronous web service that processes a
client’s loan application request and then returns a loan offer. This use case discusses
how to integrate a BPEL process service component with this asynchronous loan
application approver web service.

This use case illustrates the key design concepts for requesting information from an
asynchronous service, and then receiving the response. The asynchronous United Loan
service in this example is another BPEL process service component. However, the
same BPEL call can interact with any properly designed web service. The target web
service WSDL file contains the information necessary to request and receive the
necessary information.

For the asynchronous web service, the following actions take place (in order of
priority):
1. An assign activity prepares the loan application.

2. Aninvoke activity initiates the loan request. The contents of this request are put
into a request variable. This request variable is sent to the asynchronous loan
processor web service.

When the loan request is initiated, a correlation ID unique to the client and partner
link initiating the request is also sent to the loan processor web service. The
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4.

correlation ID ensures that the correct loan offer response is returned to the
corresponding loan application requester.

The loan processor web service then sends the correct response to the receive
activity, which has been tracked by the correlation ID.

An assign activity reads the loan application offer.

The remaining sections in this chapter provide specific details about the asynchronous
functionality.

8.2 Invoking an Asynchronous Web Service

This section provides an overview of the tasks for adding asynchronous functionality
to a BPEL process service component.

8.2.1 How to Invoke an Asynchronous Web Service

You perform the following steps to asynchronously invoke a web service:

Add a partner link
Add an invoke activity
Add a receive activity

Create assign activities

8.2.1.1 Adding a Partner Link for an Asynchronous Service

These instructions describe how to create a partner link in a BPEL process (for this
example, named LoanService) for the loan application approver web service.

To add a partner link for an asynchronous service:

1.

In the SOA Composite Editor, drag a BPEL process from the Service Components
section of the Component Palette into the designer.

The Create BPEL Process dialog appears.
Follow the instructions in the dialog to create a BPEL process service component.
Click OK when complete.

In the SOA composite application in the SOA Composite Editor, double-click the
BPEL process service component (for this example, the component is named
LoanBroker).

The Oracle BPEL Designer appears.
In the Component Palette, expand BPEL Services.

Drag a Partner Link (Web Service/Adapter) into the right Partner Links
swimlane.

The Create Partner Link dialog appears.

Enter the following details to create a partner link and select the loan application
approver web service:

= Name
Enter a name for the partner link (for this example, LoanService is entered).

s Process
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Displays the BPEL process service component name (for this example,
LoanBroker appears).

= WSDL URL

Enter the name of the Web Services Description Language (WSDL) file to use.
Click the SOA Resource Lookup icon above this field to locate the correct
WSDL.

s Partner Link Type

Refers to the external service with which the BPEL process service component
is to interface. Select from the list (for this example, LoanService is selected).

s Partner Role

Refers to the role of the external source, for example, provider. Select from the
list (for this example, LoanServiceProvider is selected).

= My Role

Refers to the role of the BPEL process service component in this interaction.
Select from the list (for this example, LoanServiceRequester is selected).

8. Click OK.

A new partner link for the loan application approver web service (United Loan)
appears in the swimlane of the designer.

8.2.1.2 Adding an Invoke Activity

Follow these instructions to create an invoke activity and a global input variable
named request. This activity initiates the asynchronous BPEL process service
component activity with the loan application approver web service (United Loan). The
loan application approver web service uses the request input variable to receive the
loan request from the client.

To add an invoke activity:
1. In the Component Palette, expand BPEL Activities and Components.

2. From the Component Palette, drag an invoke activity to beneath the receive
activity.

3. Go to the Structure window. Note that while this example describes variable
creation from the Structure window, you can also create variables by clicking the
Add icons to the right of the Input and Output fields of the Invoke dialog.

4. Right-click Variables and select Expand All Child Nodes.

5. In the second Variables folder in the tree, right-click and select Create Variable.
The Create Variable dialog appears.

6. Enter the variable name and select Message Type from the options provided:
= Simple Type

This option lets you select an XML schema simple type (for example, string,
boolean, and so on).

m  Message Type

This option enables you to select a WSDL message file definition of a partner
link or of the project WSDL file of the current BPEL process service component
(for example, a response message or a request message). You can specify
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variables associated with message types as input or output variables for
invoke, receive, or reply activities.

To display the message type, select the Message Type option, and then select
its Browse icon to display the Type Chooser dialog. From here, expand the
Message Types tree to make your selection. For this example, Message Types
> Partner Links > Loan Service > LoanService.wsdl > Message Types >
LoanServiceRequestMessage is selected.

s Element

This option lets you select an XML schema element of the project schema file
or project WSDL file of the current BPEL process service component, or of a
partner link.

Figure 8-1 shows the Create Variable dialog.

Figure 8-1 Create Variable Dialog
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7. Click OK.
8. Double-click the invoke activity to display the Invoke dialog.

9. In the Invoke dialog, select the partner link from the Partner Link list (for this
example, LoanService is selected) and initiate from the Operation list.

10. To the right of the Input Variable field, click the second icon and select the input
variable you created in Step 6.

The Variable Chooser dialog appears, where you can select the variable.

There is no output variable specified because the output variable is returned in the
receive operation. The invoke activity is created.

For more information about the invoke activity, see Section 8.2.2.5, "Invoke and
Receive Activities."

11. Click OK.

8.2.1.3 Adding a Receive Activity

Follow these steps to create a receive activity and a global output variable named
response. This activity waits for the loan application approver web service’s callback
operation. The loan application approver web service uses this output variable to send
the loan offer result to the client.
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To add a receive activity:

1. From the Component Palette, drag a receive activity to the location right after the
invoke activity you created in Section 8.2.1.2, "Adding an Invoke Activity."

2. Create a variable to hold the receive information by invoking the Create Variable
dialog, as you did in Step 3 through Step 7, starting on page 8-3.

Figure 8-2 shows the Create Variable dialog.

Figure 8-2 Create Variable Dialog
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3. Double-click the receive activity and change its name to receive_invoke.

4. From the Partner Link list, select the partner link (for this example, LoanService is
selected).

5. From the Operation list, select onResult. Do not select the Create Instance
checkbox.

6. Select the variable you created in Step 3 through Step 7, starting on page 8-3.
7. Click OK.

The receive activity and the output variable are created. Because the initial receive
activity in the BPEL file (for this example, LoanBroker.bpel) created the initial
BPEL process service component instance, a second instance does not need to be
created.

8.2.1.4 Performing Additional Activities
In addition to the asynchronous-specific tasks, you must perform the following tasks.

»  Create an initial assign activity for data manipulation in front of the invoke
activity that copies the client’s input variable loan application request document
payload into the loan application approver web service’s request variable
payload.

»  Create a second assign activity for data manipulation after the receive activity that
copies the loan application approver web service’s response variable loan
application results payload into the output variable for the client to receive.

8.2.2 What Happens When You Invoke an Asynchronous Web Service

This section describes what happens when you invoke an asynchronous web service.
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8.2.2.1 portType Section of the WSDL File

The portType section of the WSDL file (in this example, for LoanService) defines
the ports to be used for the asynchronous service.

Asynchronous services have two port types. Each port type performs a one-way
operation. In this example, one port type responds to the asynchronous process and
the other calls back the client with the asynchronous response. In the example shown
in Example 8-1, the portType LoanServiceCallback receives the client’s loan
application request and the portType LoanService asynchronously calls back the
client with the loan offer response.

Example 8—1 portType Definition

<!-- portType implemented by the LoanService BPEL process -->
<portType name="LoanService">
<operation name="initiate">
<input message="tns:LoanServiceRequestMessage"/>
</operation>
</portType>
<!-- portType implemented by the requester of LoanService BPEL process
for asynchronous callback purposes
-—>
<portType name="LoanServiceCallback">
<operation name="onResult">
<input message="tns:LoanServiceResultMessage"/>
</operation>
</portType>

8.2.2.2 partnerLinkType Section of the WSDL File

The partnerLinkType section of the WSDL file (in this example, for LoanService)
defines the following characteristics of the BPEL process service component:

s The role (operation) played
s The portType provided for receiving messages within the conversation

Partner link types in asynchronous services have two roles: one for the web service
provider and one for the client requester.

In the conversation shown in Example 8-2, the LoanServiceProvider role and
LoanService portType are used for client request messages and the
LoanServiceRequester role and LoanServiceCallback portType are used for
asynchronously returning (calling back) response messages to the client.

Example 8-2 partnerLinkType Definition

<plnk:partnerLinkType name="LoanService">
<plnk:role name="LoanServiceProvider">
<plnk:portType name="client:LoanService"/>
</plnk:role>
<plnk:role name="LoanServiceRequester">
<plnk:portType name="client:LoanServiceCallback"/>
</plnk:role>
</plnk:partnerLinkType>

Two port types are combined into this single asynchronous BPEL process service
component: portType="services:LoanService" of the invoke activity and
portType="services:LoanServiceCallback" of the receive activity. Port
types are essentially a collection of operations to be performed. For this BPEL process
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service component, there are two operations to perform: initiate in the invoke
activity and onResult in the receive activity.

8.2.2.3 Partner Links Section in the BPEL File

To call the service from BPEL, you use the BPEL file to define how the process
interfaces with the web service. View the partnerLinks section. The services with
which a process interacts are designed as partner links. Each partner link is
characterized by a partnerLinkType.

Each partner link is named. This name is used for all service interactions through that
partner link. This is critical in correlating responses to different partner links for
simultaneous requests of the same type.

Asynchronous processes use a second partner link for the callback to the client. In this
example, the second partner link, LoanService, is used by the loan application
approver web service. Example 8-3 provides an example.

Example 8-3 partnerLink Definition

<!-- This process invokes the asynchronous LoanService. -->

<partnerLink name="LoanService"
partnerLinkType="services:LoanService"
myRole="LoanServiceRequester"
partnerRole="LoanServiceProvider"/>
</partnerLinks>

The attribute myRole indicates the role of the client. The attribute partnerRole role
indicates the role of the partner in this conversation. Each partnerLinkType has a
myRole and partnerRole attribute in asynchronous processes.

8.2.2.4 Composite Application File

In the composite.xml file, the loan application approver web service appears, as
shown in Example 8—4.

Example 8-4 Loan Application Approver Web Service

<component name="LoanBroker">
<implementation.bpel process="LoanBroker.bpel"/>
</component>

For more information, see Section 8.2.1.1, "Adding a Partner Link for an Asynchronous
Service" for instructions on creating a partner link.

8.2.2.5 Invoke and Receive Activities

View the variables and sequence sections. Two areas of particular interest concern
the invoke and receive activities:

= An invoke activity invokes a synchronous web service (as discussed in Chapter 7,
"Invoking a Synchronous Web Service from a BPEL Process") or initiates an
asynchronous service.

The invoke activity includes the request global input variable defined in the
variables section. The request global input variable is used by the loan
application approver web service. This variable contains the contents of the initial
loan application request document.
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= A receive activity that waits for the asynchronous callback from the loan
application approver web service. The receive activity includes the response
global output variable defined in the variables section. This variable contains
the loan offer response. The receive activity asynchronously waits for a callback
message from a service. While the BPEL process service component is waiting, it is
dehydrated, or compressed and stored, until the callback message arrives.

Example 8-5 provides an example.

Example 8-5 Invoke and Receive Activities

<variables>

<variable name="request"
messageType="services:LoanServiceRequestMessage" />

<variable name="response"
messageType="services:LoanServiceResultMessage" />

</variables>
<sequence>
<!-- initialize the input of LoanService -->
<assign>
<!-- initiate the remote process -->

<invoke name="invoke" partnerLink="LoanService"
portType="services:LoanService"
operation="initiate" inputVariable="request"/>

<!-- receive the result of the remote process -->

<receive name="receive_invoke" partnerLink="LoanService"
portType="services:LoanServiceCallback"
operation="onResult" variable="response"/>

When an asynchronous service is initiated with the invoke activity, a correlation ID
unique to the client request is also sent, using Web Services Addressing
(WS-Addressing) (described in Section 8.4, "Using WS-Addressing in an
Asynchronous Service"). Because multiple processes may be waiting for service
callbacks, the server must know which BPEL process service component instance is
waiting for a callback message from the loan application approver web service. The
correlation ID enables the server to correlate the response with the appropriate
requesting instance.

8.2.2.6 createlnstance Attribute for Starting a New Instance

You may notice a createInstance attribute in the initial receive activity. In this
initial receive activity, the createInstance element is set to yes. This starts a new
instance of the BPEL process service component. At least one instance startup is
required for a conversation. For this reason, you set the createInstance variable to
no in the second receive activity.

Example 8-6 shows the source code for the createInstance attribute:

Example 8-6 createlnstance Attribute

<!-- receive input from requester -->

<receive name="receiveInput" partnerLink="client"
portType="tns:LoanBroker"
operation="initiate" variable="input"
createInstance="yes"/>
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8.2.2.7 Dehydration Points for Maintaining Long-Running Asynchronous
Processes

To automatically maintain long-running asynchronous processes and their current
state information in a database while they wait for asynchronous callbacks, you use a
database as a dehydration store. Storing the process in a database preserves the
process and prevents any loss of state or reliability if a system shuts down or a
network problem occurs. This feature increases both BPEL process service component
reliability and scalability. You can also use it to support clustering and failover.

You insert this point between the invoke activity and receive activity.

8.2.2.8 Multiple Runtime Endpoint Locations

Oracle SOA Suite provides support for specifying multiple partner link endpoint
locations. This capability is useful for failover purposes if the first endpoint is down.
To provide an alternate partner link endpoint location, add the 1ocation attribute to
the composite.xml file. Example 8-7 provides an example.

Example 8-7 Alternate Runtime Endpoint Location

<reference name="HeaderService ...>
<binding.ws port="http://services.otn.com/HelloWorldApp#wsdl.endpoint (client/
HelloWorldService_pt)"

location="http://server:port/soa-infra/services/default/
HelloWorldService!l.0/client?WSDL">

<property name="endpointURI">http://jsmith.us.oracle.com:80/a.jsp
@http://myhost.us.oracle.com:8888/soa-infra/services/HelloWorldApp/HelloWorld!
1.0*%2007-10-22_14-33-04_195/client

</property>

</binding.ws>

</reference>

8.3 Using a Dynamic Partner Link at Runtime

You can dynamically configure a partner link at runtime in BPEL. This is useful for
scenarios in which the target service that BPEL wants to invoke is not known until
runtime.

8.3.1 How To Add and Use a Dynamic Partner Link at Runtime

1. Create a WSDL file that contains multiple services that use the same portType.

2. Create a reference binding component entry in the composite.xml file that uses
the WSDL:

<reference name="loanService">

<interface.wsdl
interface="http://services.otn.com#wsdl.interface (LoanService)"
callbackInterface="http://services.otn.com#wsdl.interface (LoanServiceCallback)"
/>

<binding.ws port=
"http://services.otn.com#wsdl.endpoint (AmericanLoan/LoanService_pt)"/>
</reference>
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Notes:

= Adding thebinding.ws port setting is optional. This is
because the port is overridden at runtime by properties passed
from BPEL.

»  If there is no port setting, and there is no composite import of the
concrete WSDL associated with this reference, you must specify
the location of the concrete WSDL with a 1ocation attribute.

3. Inthe BPEL file, programmatically assign the partner link. For this example,
UnitedLoan is one of the services defined in the WSDL.

<copy>
<from>
<EndpointReference
xmlns="http://schemas.xmlsoap.org/ws/2003/03/addressing">
<Address>http://myhost.us.oracle.com:9700/orabpel /default/UnitedLoan</Address>
</EndpointReference>
</from>
<to partnerLink="LoanService"/>
</copy>

8.4 Using WS-Addressing in an Asynchronous Service

Because there can be many active instances at any time, the server must be able to
direct web service responses to the correct BPEL process service component instance.
You can use WS-Addressing to identify asynchronous messages to ensure that
asynchronous callbacks locate the appropriate client.

Figure 8-3 provides an overview of WS-Addressing. WS-Addressing uses Simple
Object Access Protocol (SOAP) headers for asynchronous message correlation.
Messages are independent of the transport or application used.
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Figure 8-3 Callback with WS-Addressing Headers
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Figure 8-3 shows how messages are passed along with WS headers so that the
response can be sent to the correct destination.

The example in this chapter uses WS-Addressing for correlation. To view the
messages, you can use TCP tunneling, which is described in Section 8.4.1.1, "Using
TCP Tunneling to See Messages Exchanged Between Programs."

WS-Addressing defines the following information typically provided by transport
protocols and messaging systems. This information is processed independently of the
transport or application:

Endpoint location (reply-to address)

The reply-to address specifies the location at which a BPEL client is listening for a
callback message.

Conversation ID

Use TCP tunneling to view SOAP messages exchanged between the BPEL process
service component flow and the web service (including those containing the
correlation ID). You can see the exact SOAP messages that are sent to, or received
from, services with which a BPEL process service component flow communicates.

You insert a software listener between your BPEL process service component flow
and the web service. Your BPEL process service component flow communicates
with the listener (called a TCP tunnel). The listener forwards your messages to the
web service, and also displays them. Responses from the web service are returned
to the tunnel, which displays and forwards them back to the BPEL process service
component.
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8.4.1 How to Use WS-Addressing in an Asynchronous Service

WS-Addressing is a public specification and is the default correlation method
supported by Oracle BPEL Process Manager. You do not need to edit the . bpel and
.wsdl files to use WS-Addressing.

8.4.1.1 Using TCP Tunneling to See Messages Exchanged Between Programs

The messages that are exchanged between programs and services can be seen through
TCP tunneling. This is particularly useful when you want to see the exact SOAP
messages exchanged between the BPEL process service component flow and web
services.

To monitor the SOAP messages, insert a software listener between your flow and the
service. Your flow communicates with the listener (called a TCP tunnel) and the
listener forwards your messages to the service, and displays them. Likewise, responses
from the service are returned to the tunnel, which displays them and then forwards
them back to the flow.

To see all the messages exchanged between the server and a web service, you need
only a single TCP tunnel for synchronous services because all the pertinent messages
are communicated in a single request and reply interaction with the service. For
asynchronous services, you must set up two tunnels, one for the invocation of the
service and another for the callback port of the flow.

8.4.1.1.1 Setting up a TCP Listener for Synchronous Services Follow these steps to set up a
TCP listener for synchronous services initiated by an Oracle BPEL Process Manager
process:

1. Visit the following URL for instructions on how to download and install Axis TCP
Monitor (tcpmon)

http://ws.apache.org/commons/tcpmon/

2. Visit the following URL for instructions on how to use tcpmon:

http://ws.apache.org/axis/java/user-guide.html

3. Place axis. jar in your class path.
4. Start tcpmon:

C:\...\> java org.apache.axis.utils.tcpmon localport remoteHost
port_on_which _remote server_1is_running

5. Inthe composite.xml file, add the endpointURI property under binding.ws
for your flow to override the endpoint of the service.

6. From the operating system command prompt, compile and deploy the process
with ant.

Note that the same technique can see the SOAP messages passed to invoke a BPEL
process service component as a web service from another tool kit such as Axis or
NET.

8.4.1.1.2 Setting up a TCP Listener for Asynchronous Services Follow these steps to set up a
TCP listener to display the SOAP messages for callbacks from asynchronous services:

1. Start a TCP listener to listen on a port and to send on the Oracle BPEL Process
Manager port.

a. Open Oracle Enterprise Manager Fusion Middleware Control Console.
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b. From the SOA Infrastructure menu, select SOA Administration > Common
Properties.

c. Specify the value for Callback Server URL. This URL is sent by the server as
part of the asynchronous callback address to the invoker.

From the SOA Infrastructure menu, select Administration > System MBean
Browser.

Expand Application Defined MBeans > oracle.soa.config > Server : soa_server >
SCAComposite.

where soa_server is the specific server instance name (for example, AdminServer).
All the SOA composite applications deployed on the server appear.

Follow these steps to set this property on a composite application. This action
enables it to apply to all bindings in the composite application.

Click your composite.

a
b. Ensure the Attributes tab is selected.

o

In the Name column, click Properties.

Click the Add icon.

e

e. Expand the newly added Element_number (appears at the end of the list).

where number is the next sequential number beyond the last property. For
example, if the property list contains twelve elements, adding a new property
causes Element_13 to be displayed.

f. In the name field, enter oracle.webservices.local.optimization.
g. Inthe value field, enter false.
h. In the many field, enter false.

Click Apply, and then click Return.
j- Inthe Name column on the Operations tab, click save.
k. Click Invoke to execute the operation.

I.  Click Return or click a node in the System MBean Browser pane.

Note: After adding, deleting, or updating a property, you can click
the Refresh cached tree data icon in the upper right corner of the
System MBean Browser page to see the new data.

Follow these steps to set this property on a specific binding.

a. Expand your composite application. and drill down to the specific
SCAComposite.SCAReference.SCABinding folder.

b. Click WSBinding.
c. Perform steps 4b through 41.

Initiate any flow that invokes asynchronous web services. You can combine this
with the synchronous TCP tunneling configuration to send a service initiation
request through your first TCP tunnel.

The callbacks from the asynchronous services are shown in the TCP listener.
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If you are an Oracle JDeveloper user, you can also use the built-in Packet Monitor to
see SOAP messages for both synchronous and asynchronous services.

8.5 Using Correlation Sets in an Asynchronous Service

Correlation sets provide another method for directing web service responses to the
correct BPEL process service component instance. You can use correlation sets to
identify asynchronous messages to ensure that asynchronous callbacks locate the
appropriate client.

Correlation sets are a BPEL mechanism that provides for the correlation of
asynchronous messages based on message body contents. To use this method, define
the correlation sets in your .bpel file. This method is designed for services that do not
support WS-Addressing or for certain sophisticated conversation patterns, for
example, when the conversation is in the form A > B > ¢ > AinsteadofaA > B >
A.

This section describes how to use correlation sets in an asynchronous service with
Oracle JDeveloper. Correlation sets enable you to correlate asynchronous messages
based on message body contents. You define correlation sets when interactions are not
simple invoke-receive activities. This example illustrates how to use correlation sets
for a process having three receive activities with no associated invoke activities.

For a sample (bpel-202-CorrelatedEvents) that shows how a BPEL process can
use correlations for two-way communication using events, visit the following URL:

http://www.oracle.com/technology/sample_code/products/bpel

8.5.1 How to Use Correlation Sets in an Asynchronous Service

This section describes the steps to perform to use correlation sets in an asynchronous
service.

8.5.1.1 Step 1: Creating a Project

To create a project:
1. Start Oracle JDeveloper.

2. From the File main menu, select New > Applications.

3. Select SOA Application, and click OK.

The Create SOA Application Wizard appears.

In the Application Name field, enter MyCorrelationSetApp.
Accept the default values for all remaining settings, and click Next.
In the Project Name field, enter MyCorrelationSetComposite.

Accept the default values for all remaining settings, and click Next.

® N o o &

In the Composite Template section, select Composite With BPEL, and click
Finish.

The Create BPEL Process dialog appears.

9. Enter the following values:
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Table 8—1 Create BPEL Process Dialog Fields and Values

Field Value
Name Enter MyCorrelationSet.
Template Select Asynchronous BPEL Process.

Expose as a SOAP Service  Select the checkbox. After process creation, note the SOAP
service that appears in the Exposed Services swimlane. This
service provides the entry point to the composite application
from the outside world.

10. Accept the default values for all remaining settings, and click Finish.

8.5.1.2 Step 2: Configuring Partner Links and File Adapter Services

You now create three partner links that use the SOAP service.
This section contains these topics:

= You create an initial partner link with an adapter service for reading a loan
application.

= You create a second partner link with an adapter service for reading an application
response.

= You create a third partner link with an adapter service for reading a customer

response.

8.5.1.2.1 Creating an Initial Partner Link and File Adapter Service

To create an initial partner link and file adapter service:
1. Double-click the MyCorrelationSet BPEL process.

2. In the Component Palette, expand BPEL Services.
3. Drag an initial Partner Link activity into the right swimlane of the designer.

4. Click the third icon at the top (the Define Service icon). This starts the Adapter
Configuration Wizard, as shown in Figure 8—4.

Figure 8—4 Adapter Configuration Wizard Startup

WSDL Settings
Q@ 7@

WSOL LURL: m::,I'JDeveloper,l'mywork‘l'RulesRUs,l'Credq Define Service

5. In the Configure Service or Adapter dialog, select File Adapter and click Next.
6. In the Welcome dialog, click Next.

7. Inthe Service Name field of the Service Name dialog, enter FirstReceive and
click Next.

8. In the Operation dialog, select Read File as the Operation Type and click Next.
The Operation Name field is automatically filled in with Read.

9. Select Directory Names are Specified as Physical Path.
10. Above the Directory for Incoming Files (physical path) field, click Browse.

11. Select a directory from which to read files (for this example,
C:\files\receiveprocess\FirstInputDir is selected).
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12. Click Select.

13. Click Next.

14. In the File Filtering dialog, enter appropriate file filtering parameters.
15. Click Next.

16. In the File Polling dialog, enter appropriate file polling parameters.
17. Click Next.

18. In the Messages dialog, click Browse next to the Schema Location field to display
the Type Chooser dialog.

19. Select an appropriate XSD schema file. For this example, Book1_4.xsd is the
schema and LoanAppl is the schema element selected.

20. Click OK.

The Schema Location field (Book1_4.xsd for this example) and the Schema
Element field (LoanAppl for this example) are filled in.

21. Click Next.
22. Click Finish.
You are returned to the Partner Link dialog. All other fields are automatically

completed. The dialog looks as shown in Table 8-2:

Table 8-2 Partner Link Dialog Fields and Values

Field Value
Name FirstReceive
WSDL URL file:/C:/JDeveloper/mywork/Application_Name/SOA_Project_

Name/FirstReceive.wsdl

where C:/JDeveloper represents the Oracle JDeveloper home
directory for this example.

Partner Link Type Read_plt

Partner Role Leave unspecified.
My Role Read_role

23. Click OK.

8.5.1.2.2 Creating a Second Partner Link and File Adapter Service

To create a second partner link and file adapter service:

1. Drag a second PartnerLink activity beneath the FirstReceivePL partner link
activity.

At the top, click the third icon (the Define Service icon).
In the Welcome dialog, click Next.
In the Adapter Type dialog, select File Adapter and click Next.

a & 0N

In the Service Name field of the Service Name dialog, enter SecondFileRead
and click Next. This name must be unique from the one you entered in Step 7 on
page 8-15.

6. In the Operation dialog, select Read File as the Operation Type.
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10.
11.

12.
13.
14.
15.
16.
17.
18.

19.

20.

21.
22,

In the Operation Name field, change the name to Readl.

Click Next.

Select Directory Names are Specified as Physical Path.

Above the Directory for Incoming Files (physical path) field, click Browse.

Select a directory from which to read files (for this example,
C:\files\receiveprocess\SecondInputDir is entered).

Click Select.

Click Next.

Enter appropriate file filtering parameters in the File Filtering dialog.
Click Next.

Enter appropriate file polling parameters in the File Polling dialog.
Click Next.

Next to the Schema Location field in the Messages dialog, click Browse to display
the Type Chooser dialog.

Select an appropriate XSD schema file. For this example, Book1_5.xsd is the
schema and LoanAppResponse is the schema element selected.

Click OK.

The Schema Location field (Book1_5.xsd for this example) and the Schema
Element field (LoanAppResponse for this example) are filled in.

Click Next.
Click Finish.

You are returned to the Partner Link dialog. All other fields are automatically
completed. The dialog looks as shown in Table 8-3:

Table 8-3 Partner Link Dialog Fields and Values

Field Value
Name SecondReceive
WSDL URL file:/C:/JDeveloper/mywork/Application_Name/SOA_Project_

Namel/SecondFileRead.wsdl

where C:/JDeveloper represents the Oracle JDeveloper home
directory for this example.

Partner Link Type Read1_plt
Partner Role Leave unspecified.
My Role Readl_role

23. Click OK.

8.5.1.2.3 Creating a Third Partner Link and File Adapter Service

To create a third partner link and file adapter service:

1.

2.

Drag a third PartnerLink activity beneath the SecondReceivePL partner link
activity.

At the top, click the third icon (the Define Service icon).
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10.
11.

12.
13.
14.
15.
16.
17.
18.

19.

20.

21.
22,

In the Welcome dialog, click Next.
In the Adapter Type dialog, select File Adapter and click Next.

In the Service Name field of the Service Name dialog, enter ThirdFileRead and
click Next. This name must be unique from the one you entered in Step 7 on
page 8-15 and Step 5 on page 8-16.

In the Operation dialog, select Read File as the Operation Type.

In the Operation Name field, change the name to Read2. This name must be
unique.

Click Next.
Select Directory Names are Specified as Physical Path.
Above the Directory for Incoming Files (physical path) field, click Browse.

Select a directory from which to read files (for this example,
C:\files\receiveprocess\ThirdInputDir is entered).

Click Select.

Click Next.

Enter appropriate file filtering parameters in the File Filtering dialog.
Click Next.

Enter appropriate file polling parameters in the File Polling dialog.
Click Next.

Next to the Schema Location field in the Messages dialog, click Browse to display
the Type Chooser dialog.

Select an appropriate XSD schema file. For this example, Book1_6.xsd is the
schema and CustResponse is the schema element selected.

Click OK.

The Schema Location field (Book1_6.xsd for this example) and the Schema
Element field (CustResponse for this example) are filled in.

Click Next.
Click Finish.

You are returned to the Partner Link dialog. All other fields are automatically
completed. The dialog looks as shown in Table 8—4:

Table 8—4 Partner Link Dialog Fields and Values

Field Value
Name ThirdReceive
WSDL URL file:/C:/JDeveloper/mywork/Application_Name/SOA_Project_

Name/ThirdFileRead.wsdl

where C:/JDeveloper represents the Oracle JDeveloper home
directory for this example.

Partner Link Type Read2_plt
Partner Role Leave unspecified.
My Role Read2_role
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23. Click OK.

When complete, the designer looks as shown in Figure 8-5:

Figure 8-5 BPEL Process Design

i)

]
FirstReceivePL

srd
SecondReceivePL

ThirdReceivePL

8.5.1.3 Step 3: Creating Three Receive Activities

You now create three receive activities; one for each partner link. The receive activities
specify the partner link from which to receive information.

8.5.1.3.1 Creating an Initial Receive Activity

To create an initial receive activity:
1. Expand BPEL Activities in the Component Palette.

2. From the BPEL Activities and Components list of the Component Palette section,
drag a Receive activity beneath the receivelnput receive activity in the designer.

3. Double-click the receive icon to display the Receive dialog.
4. Enter the details described in Table 8-5 to associate the first partner link

(FirstReceive) with the first receive activity:

Table 8-5 Receive Dialog Fields and Values

Field Value

Name receiveFirst
Partner Link FirstReceive

Create Instance Select this checkbox.

The Operation (Read) field is automatically filled in.

5. To the right of the Variable field, click the first icon. This is the automatic variable
creation icon.

6. In the Create Variable dialog, click OK.

A variable named receiveFirst_Read_InputVariable is automatically created in
the Variable field.

7. Ensure that you selected the Create Instance checkbox, as mentioned in Step 4.

8. Click OK.
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8.5.1.3.2 Creating a Second Receive Activity

To create a second receive activity:

1. From the Component Palette, drag a second Receive activity beneath the
receiveFirst receive activity.

2. Double-click the receive icon to display the Receive dialog.
3. Enter the details described in Table 8-6 to associate the second partner link

(SecondReceivePL) with the second receive activity:

Table 8-6 Receive Dialog Fields and Values

Field Value

Name receiveSecond

Partner Link SecondFileRead

Create Instance Do not select this checkbox.

The Operation (Read1) field is automatically filled in.
4. To the right of the Variable field, click the first icon.
5. In the Create Variable dialog, click OK.

A variable named receiveSecond_Read1_InputVariable is automatically created
in the Variable field.

6. Click OK.

8.5.1.3.3 Creating a Third Receive Activity

To create a third receive activity:

1. From the Component Palette, drag a third Receive activity beneath the
receiveSecond receive activity.

2. Double-click the receive icon to display the Receive dialog.
3. Enter the details described in Table 8-7 to associate the third partner link
(ThirdReceivePL) with the third receive activity:

Table 8-7 Receive Dialog Fields and Values

Field Value

Name receiveThird

Partner Link ThirdFileRead

Create Instance Do not select this checkbox.

The Operation (Read2) field is automatically filled in.
4. To the right of the Variable field, click the first icon.
5. In the Create Variable dialog, click OK.

A variable named receiveThird_Read2_InputVariable is automatically created in
the Variable field.

6. Click OK.

Each receive activity is now associated with a specific partner link.
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